
Bio-Botanical Extraction

System Guide

715004757
Revision D

Copyright © Waters Corporation 2018
All rights reserved



General information

Copyright notice
© 2015 – 2018 WATERS CORPORATION. PRINTED IN THE UNITED STATES OF AMERICA
AND IN IRELAND. ALL RIGHTS RESERVED. THIS DOCUMENT OR PARTS THEREOF MAY
NOT BE REPRODUCED IN ANY FORM WITHOUT THE WRITTEN PERMISSION OF THE
PUBLISHER.

The information in this document is subject to change without notice and should not be construed
as a commitment by Waters Corporation. Waters Corporation assumes no responsibility for any
errors that may appear in this document. This document is believed to be complete and accurate
at the time of publication. In no event shall Waters Corporation be liable for incidental or
consequential damages in connection with, or arising from, its use. For the most recent revision
of this document, consult the Waters website (waters.com).

Trademarks

ChromScopeTM is a trademark of Waters Corporation.

Microsoft® is a registered trademark of Microsoft Corporation in the US and/or other countries.

THE SCIENCE OF WHAT'S POSSIBLE® is a registered trademark of Waters Corporation.

ValcoTM is a trademark of Valco Instruments Company Inc.

Waters® is a registered trademark of Waters Corporation.

Windows® is a registered trademark of Microsoft Corporation in the US and/or other countries.

Windows ® 10 is a registered trademark of Microsoft Corporation in the US and/or other
countries.

All other trademarks are property of their respective owners.

Customer comments
Waters’ Technical Communications organization invites you to report any errors that you
encounter in this document or to suggest ideas for otherwise improving it. Help us better
understand what you expect from our documentation so that we can continuously improve its
accuracy and usability.
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We seriously consider every customer comment we receive. You can reach us at
tech_comm@waters.com.

Contacting Waters
Contact Waters with enhancement requests or technical questions regarding the use,
transportation, removal, or disposal of any Waters product. You can reach us via the Internet,
telephone, fax, or conventional mail.

Waters contact information

Contacting medium Information

Internet The Waters Web site includes contact information for Waters locations
worldwide.
Visit www.waters.com

Telephone and fax From the USA or Canada, phone 800-252-4752, or fax 508-872-1990.
For other locations worldwide, phone and fax numbers appear in the
Waters Web site.

Conventional mail Waters Corporation
Global Support Services
34 Maple Street
Milford, MA 01757
USA

Documentation conventions
Instructions in this documentation adhere to the following conventions.

> Denotes the path for selecting menu commands, for moving from one menu to another, or
for performing a task.

Example: Click File > Open.

< > Indicates that you must enter variable information, such as a path or filename.

Example: Type open <filename>

Safety considerations
Some reagents and samples used with Waters instruments and devices can pose chemical,
biological, or radiological hazards (or any combination thereof). You must know the potentially
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hazardous effects of all substances you work with. Always follow Good Laboratory Practice
(GLP), and consult your organization’s standard operating procedures as well as your local
requirements for safety.

Safety hazard symbol notice

Documentation needs to be consulted in all cases where the  symbol is used to find out the
nature of the potential hazard and any actions which have to be taken.

High voltage hazard

Warning: To avoid electric shock, do not remove protective panels from system
modules. The components within are not user-serviceable.

Power cord replacement hazard

Warning: To avoid electric shock, use SVT-type power cords in the United States and
HAR-type (or better) cords in Europe. The power cords must be replaced only with ones
of adequate rating. For information regarding which cord to use in other countries,
contact your local Waters distributor.

CO2 hazards to humans

Carbon dioxide exhibits three primary hazards for humans:

• Toxicity, at levels above 10,000 ppm (PEL 5000 ppm)

• Frostbite, from uncontrolled release of pressurized CO2 to atmosphere, or contact with
accumulated dry ice at a leak site

• Asphyxiation, caused by displacement of oxygen

For locations in which CO2 is used and stored, the United States Occupational Safety and Health
Administration (OSHA) has established the permissible exposure limit (PEL). Installing an
ambient-air sensor and alarm capable of detecting CO2 levels to 10,000 ppm and triggering an
alarm at 5000 ppm (instead of, or in addition to, installing an oxygen monitor) complies with the
PEL. When another asphyxiant, such as N2, is used or stored in the same room as CO2, Waters
recommends installing an oxygen monitor with both audible and visual alarms in addition to the
ambient-air sensor.

Before proceeding with any monitoring safety configuration, consult your environmental health
and safety manager regarding applicable local, federal, and international safety regulations and
requirements.
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High temperature hazard
During system operation, the extraction vessels, cyclone separators, and tubing at the outlet of
the heat exchanger can become heated to high temperatures. These components remain heated
for several minutes after the heating devices are powered-off.

Warning: To avoid burn injuries, exercise care when handling the extraction vessels,
separation cyclones, heat exchanger outlet tubing, or other components heated to high
temperatures or cooled to low temperatures. Wait until the hot components have
sufficiently cooled or the cold components have sufficiently warmed before you handle
them.

Operating the system
When operating the system, follow standard quality-control (QC) procedures and the guidelines
presented in this section.

Applicable symbols
The following symbols can be present on the device, system, or packaging.

Symbol Definition

Manufacturer

Date of manufacture

Authorized representative of the European Community

Confirms that a manufactured product complies with all applicable
European Community directives

 or 

Australia EMC compliant

Confirms that a manufactured product complies with all applicable United
States and Canadian safety requirements

Consult instructions for use

Alternating current
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Symbol Definition

Electrical and electronic equipment with this symbol may contain
hazardous substances and should not be disposed of as general waste.
For compliance with the Waste Electrical and Electronic Equipment
Directive (WEEE) 2012/19/EU, contact Waters Corporation for the correct
disposal and recycling instructions.

Serial number

REF
Part number, catalog number

Audience and purpose
This guide is intended for personnel who install, operate, and maintain the Bio-Botanical
Extraction System. It provides much of the information required to set up, operate, and maintain
the system's hardware and software components. For additional operational and maintenance
details, consult the operator's guides for the individual modules that comprise the Bio-Botanical
Extraction System.

Intended use of the Bio-Botanical Extraction System
Waters designed the Bio-Botanical Extraction System to function as a bulk scale, high-pressure
separator for collecting extracted compounds to support a wide variety of applications, including
quantitative recovery of botanicals and natural products, or for research. It is not intended for use
in diagnostic or biologically hazardous applications.

ISM classification: ISM group 1 class A
This classification has been assigned in accordance with CISPR 11 Industrial Scientific and
Medical (ISM) instruments requirements.

Group 1 products apply to intentionally generated and/or used conductively coupled radio-
frequency energy that is necessary for the internal functioning of the equipment.

Class A products are suitable for use in all establishments other than residential locations and
those directly connected to a low voltage power supply network supplying a building for domestic
purposes.

There may be potential difficulties in ensuring electromagnetic compatibility in other environments
due to conducted as well as radiated disturbances.
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1 Getting started with the Bio-Botanical
Extraction System

1.1 Extracting compounds using carbon dioxide
Historically, supercritical fluid extraction (SFE) refers to a technique for extracting compounds
from solid or semi-solid substances using a supercritical fluid as the primary component of the
extraction solvent. A supercritical fluid results when a substance is heated and pressurized above
its critical temperature and pressure. For carbon dioxide (CO2), this corresponds to 31 °C (88 °F)
and 7398 kPa (74 bar, 1073 psi ). Under this supercritical state, the solvent takes on
advantageous properties that are in between those of liquids and gasses such as high diffusivity,
low surface tension and viscosity, and tunable solvating power. Today, however, SFE is used
most commonly to describe the use of CO2 as the extracting solvent, regardless of its physical
state. For example, a single extraction using CO2 could start in the gas phase, transition to liquid,
and then supercritical, and end up back in the gas phase at the end. In addition to CO2, a co-
solvent (usually methanol or food-grade ethanol) can serve as a modifier. CO2 modifiers increase
the polarity of the solvent and change the selectivity of the extraction. The Bio-Botanical
Extraction System (BBES) takes advantage of the unique properties of CO2 to extract
compounds of interest from complex and convoluted matrices.

The BBES extracts and separates (fractionates) compounds by altering the solvent strength of
the CO2 solvent. As you increase temperature and pressure, CO2 becomes a stronger solvent,
capable of dissolving a wider range of compounds. SFE can still be compared to liquid extraction
by comparing corresponding Log (P) data (the ratio of concentrations of a compound in two
immiscible phases of solvents at equilibrium) and molecular weight. These principles render SFE
predictable and scalable from analytical to process applications. With the BBES, the user can
manipulate the pressure and temperature of the CO2 solvent to selectively extract and collect the
desired material, leaving a clean, concentrated extract with minimal processing steps in between.
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Figure 1–1: Solvating strength of CO2 is tunable by changing the pressure and
temperature

During extraction, raising the pressure of CO2 in the system allows for the extraction of more
polar compounds. Adding a co-solvent such as food-grade ethanol additionally increases this
capability to extract even more polar compounds. During collection, decreasing the pressure of
the CO2 in the system causes extracted compounds to precipitate and fall out of solution in the
collection vessels. The first compounds to precipitate tend to be the most polar compounds with
the highest molecular weight. This is followed by the least polar, light, volatile compounds.

1.1.1 Bio-Botanical Extraction System flow
The Bio-Botanical Extraction System (BBES) functions as a high-pressure separator for
extracting compounds from solid or semi-solid substances. By manipulating the pressure and
temperature, CO2 can selectively extract the desired material. On a system configured for
purification and collection of extracted compounds, the sample is placed in an extraction vessel
and pressurized with CO2 and, depending on the application, a small percentage of co-solvent, to
extract the compounds of interest. These dissolved compounds are then transferred from the
extraction vessel to one or more cyclone separators by flowing CO2, depending on the system's
configuration. The automated back-pressure regulator (ABPR), located between the extraction
vessel and cyclone separators, allows for controlled depressurization of the CO2. After the ABPR,
the system pressure is reduced, causing the CO2 to lose its solvating power. When the manual
back-pressure regulators (MBPR) are properly set, the extracted material precipitates out of the
solution into the cyclone separators, which can be operated as a series of cascading pressure
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steps to isolate the collected compounds into fractions. The CO2 is vented or diverted to a CO2

recycler. The diagram below shows the key components comprising the system flow for a BBES
configured with a co-solvent pump, two extraction vessels, and three cyclone separators.

Figure 1–2: Bio-Botanical Extraction System flow path
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Note: The connection locations for V2 are representations only. The true inlet of the extraction
vessel (from the CO2 pump) is on the top, and the actual outlet (to the ABPR) is on the bottom.
Refer to the V1 connections.

The following diagrams show the flow path in more detail.
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Figure 1–3: CO2 pump and extraction vessel flow path
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Figure 1–4: Cyclone separators flow path
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Figure 1–5: CO2 recycler flow path
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1.2 System components
The Waters SFE systems include skid-mounted, modular components. The specific components
and options comprising a system depend on its configuration. Configurations vary to
accommodate small-scale to large-scale extractions based on the size and number of extraction
and collection vessels. The largest systems, Waters Bio-Botanical Extraction Systems (BBES),
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serve as bulk-scale, high-pressure separators for collecting extracted compounds from botanical
samples. Below is an example of a BBES configured with a CO2 recycler, one 5-L extraction
vessel, and three cyclone separators.

See also: For information about proper component layout, refer to the Bio-Botanical Extraction
System Site Preparation Guide (part number 715004529).

Figure 1–6: Example Bio-Botanical Extraction System components

ChromScope workstation – Runs ChromScope software, which enables fully automated
instrument control and facilitates the process of developing SFE methods and purifying
samples.

Extraction vessel – Stainless steel extraction vessel of 5-L volume (shown), equipped with a
finger-tight cap, for simple opening and closing. The cap's seal is a polymide "C" cup fitted
with a spring that is energized under pressure, forcing the seal's inner lip to contact the
threaded cap. The seal's outer lip contacts the inner-vessel wall, forming a pressure seal. A
cap at each end of the vessel, along with a seal, has a frit assembly, to provide even
distribution of fluid during introduction. The vessel has a pressure gauge used for
monitoring the internal pressure within the vessel's chamber. An electric heater-jacket
encases the vessel and maintains the supercritical temperature of the extracting solvent
within the sample matrix. A 10-L extraction vessel is also available, and a BBES can be
configured with up to two extraction vessels, but both extraction vessels must be of the
same volume. One is filled with bio-botanical material and extracted, while the other is
emptied of extracted bio-botanical material and refilled with fresh bio-botanical material to
prepare for the next extraction.
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MV1 outlet valve – A 2-stem manual shutoff valve for systems equipped with manual
switching valves and dual extraction vessels. During a run, the MV1 outlet valve is open
from the extraction vessel to the ABPR, or closed, during periods of static soaking
durations. The stem positions of the MV1 outlet valve and MV2 inlet valve control which
extraction vessel is open or closed to the system flow. Additionally, after a run, with the
system pumps shut off, the MV1 and MV2 valves allow siphoning of the remaining CO2 flow
from the pressurized vessel into the unpressurized vessel loaded with sample, to equalize
the pressure between vessels and to reclaim CO2 for the next run.

Tip: For systems configured with dual extraction vessels, to achieve the specified flow and
pressure conditions uniformly within the sample matrix, perform runs using one vessel at a
time. An exception to this case applies when the vessels are plumbed in series.

Note: Systems configured with a single vessel can be equipped with a single-stem MV1
valve that controls vessel outflow.

Automation module (optional) – Facilitates automatic switching between extraction vessels
and allows unattended operation for two full extractions until collection (pulling) of the
samples.

Automated back-pressure regulator – Uses an electronically controlled needle valve to
pressurize the extraction vessel. The regulator is plumbed downstream from the extraction
vessels, to maintain all components in the extraction flow path at the correct pressure. The
outlet of the automated back-pressure regulator (ABPR) flows to the inlet of the first cyclone
separator.

Inline collection heater – Heats the sample flowing from cyclone separator 2 (CS2) to
cyclone separator 3 (CS3), which keeps the sample in a gas phase and ensures that there
is no carryover to the CO2 recycler.

Manual back-pressure regulator – Controls the working pressure in the cyclone separators,
to prevent product loss during collection due to overly rapid expansion of CO2. The system
is configured with one manual back-pressure regulator (MBPR) per separator. On a system
fitted with three cyclone separators, the manual back-pressure regulator of the first
separator is set to the highest pressure. The second and third regulator valves are then set
to create decreasing pressure steps that reduce the CS3 pressure to near atmospheric
conditions. If using the optional CO2 recycler, the CS3 pressure is set to approximately
5516 kPa (55 bar, 800 psi).

Cyclone separators – 2-L volume capacity fraction collectors that are plumbed in a serial
flow. When the MBPRs are properly set, the cyclone separators collect, from the bottom of
the vessels, compounds that precipitate from solution as the pressure across the three
separators drops, and the CO2 loses its solvating power. The flow path from the final
separator exits to vent or an optional CO2 recycler. The cyclone separators include an
integrated splash guard and drain valves for collecting extracted compounds.
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CO2 recycler – Provides a continuous source of liquid CO2 for the extraction system. During
operation, the recycler reclaims the gaseous CO2 that remains after the liquid or solid
compounds collected from the extraction process are precipitated out in the cyclone
separators. The recycler system consists of a storage vessel and a level sensor for carbon
dioxide storage, a level-sensor module to display level, a condensing heat exchanger, a
condensing cooling bath, and valves. The system also features a pressure relief valve that
vents pressure in case of overpressurization or overfill conditions. Fill conditions in a system
are dictated by operating conditions. Responding to the information appearing in the level-
sensor module's display, the operator can switch the carbon dioxide supply to the system
from the CO2 source, or to the storage vessel in recycling mode. If the recycler is the
automated model, the ChromScope software performs this function. For details and
operating instructions, refer to the CO2 Recycler Overview and Maintenance Guide that
accompanies the system.

CO2 tank – Supply cylinder for the CO2 used in the system.

CO2 recycler chiller – Condenses the CO2 that flows to the CO2 recycler. For product details
and operating instructions, refer to the operator's guide that ships with the chiller unit.

Mass flow meter – Measures the liquefied carbon dioxide mass input to the high-pressure
CO2 pump. The feedback from the mass flow meter controls the pump and maintains an
accurate and consistent CO2 flow rate. For additional product details and operating
instructions, refer to the mass flow meter's operator's guide.

System chiller – Provides a continuous supply of fluid at a constant temperature and
volume. The unit consists of an air-cooled chiller unit, recirculating pump, coolant reservoir,
and a microprocessor controller. Its primary function is to circulate temperature-controlled
coolant through HE1 and the high-pressure CO2 pump heads, and to cool and maintain the
liquid state of the inlet CO2, removing the heat of compression caused by pump operation.
For product details and operating instructions, refer to the chiller unit's operator's guide.

P50 pump (optional) – Also referred to as the co-solvent pump. Used to pump co-solvent
that acts as a modifier agent into the static mixing tee that combines the co-solvent with the
CO2 stream before it flows through the extracting solvent heat exchanger (HE2).

Note: When the P-50 pump is installed, the system also includes the static mixing tee and
pump-priming valve (MV4).

Extracting solvent heat exchanger (HE2) – Heats the extracting solvent to a method-
specified temperature before the flow enters the high-pressure extraction vessel.
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P200 pump – Also referred to as the CO2 pump. Pumps the liquefied carbon dioxide to the
system. Its key features are as follows:

• Dual pump heads with cooling chambers for removing the heat of compression, to keep
the CO2 from converting to a gas as it is drawn into the pump

• A rupture-disc safety device, to prevent high-pressure damage to pump components

• A CO2shutoff valve, which controls the flow of liquid CO2 exiting the pump

• Control and monitoring of pump from the ChromScope workstation

MV2 inlet valve – A 2-stem, manual shutoff valve for dual extraction-vessel configurations. It
serves to direct the extracting solvent flow to the designated extraction vessel for the run.

Temperature controller modules – Two 6-zone modules that control and monitor the
temperatures of the mobile-phase heat exchanger and the electric heater-jackets that
encase the extraction vessels and cyclone separators. The temperature set points and
readings are controlled and monitored by the ChromScope software. Each controller can
support as many as six independent control zones using standard J-type thermocouple
inputs. Each zone requires its own thermocouple and control relay.

1.3 Safety practices and warnings
Observe Good Laboratory Practice when using the system. Always keep in mind these safety
practices:

• Familiarize yourself with proper handling, storage, and disposal of all chemicals used with
your SFE system. Refer to the Material Safety Data Sheet (MSDS) for each solvent you use,
and know its chemical properties.

• Wear the appropriate personal protective equipment when working with any type of
hazardous chemical.

• Wear eye protection while near the instrument to protect eyes from possible failure of valves
or fittings.

• Wear hearing protection while venting the system to protect ears from loud noise owing to a
high-pressure release of solvent.

• Ensure that the system is depressurized before loosening any fittings in the CO2 flow path.

• Use care when loosening and opening the extraction and collection vessel caps. Loosening
an in-line vessel's fitting with CO2 in the system can cause a high-pressure release of sample
and solvent.
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Warning: To avoid explosion, do not use a highly flammable solvent as a cleaning
agent for heated components. Leaks of flammable cleaning agents onto the heated
vessel surfaces could cause flammable or explosive mixtures to form. The heated
components can achieve temperatures as high as 90 °C. These temperature levels
exceed the flash point of many flammable vapors. Avoid using any solvent for which the
ignition temperature is in this range. Always inspect the system for leaks before
operating it unattended.

Warning: Observe Good Laboratory Practice (GLP) at all times, particularly when
working with hazardous materials. Consult the Material Safety Data Sheets regarding
the solvents you use. Additionally, consult the safety representative for your
organization regarding its protocols for handling such materials.

Warning: To avoid burn injuries, exercise care when handling the extraction vessels,
separation cyclones, heat exchanger outlet tubing, or other components heated to high
temperatures or cooled to low temperatures. Wait until the hot components have
sufficiently cooled or the cold components have sufficiently warmed before you handle
them.

Warning: The system could potentially pose a rapid decompression hazard. Exposure
to rapidly expanding fluids can cause injuries, including frostbite. To avoid this hazard,
take the following precautions:

• Always depressurize the system before changing or working on the bulk CO2

supply.

• Use only bulk CO2 supply lines constructed of appropriate materials.

• To avoid a high-pressure release of sample and solvent, or damage to the vessel's
cap, never use a wrench to force open a vessel cap. If the vessel's pressure-escape
vent becomes plugged, the vessel can remain under pressure indefinitely. If you
cannot easily remove the vessel's cap, allow the vessel to depressurize for at least
15 minutes, and then try again.

• To avoid the risk of a high-pressure release of solvent and extracted compounds,
always use containers made of materials other than glass for collecting extracted
compounds and waste.

Warning: To avoid injury when moving a system component, ensure that no objects
are in the path of the cart wheels.

Warning: To avoid eye injury, always wear eye protection when working with
components under pressure.

1.4 Typical system workflow
A typical workflow involves setting up the system and extracting and collecting compounds of
interest. It comprises these tasks:
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• Configuring settings for system modules, including their shutdown conditions

• Creating and loading extraction methods

• Preparing the sample and filling the extraction vessel

• Equilibrating the system

• Starting and monitoring the run

• Setting the manual back-pressure regulators to prepare for collection

• Collecting fractions

• Repeating the run with the second extraction vessel (if used)

You perform these tasks using ChromScope software and following the instructions in the online
Help and system guide. Always observe Good Laboratory Practice (GLP) guidelines and your
laboratory's standard operating procedures.
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2 Component connections

2.1 Installation and operation requirements
You must plan well before moving the system to a different area, replacing its modules, or
modifying your laboratory facility.

The topics in this section explain installation and operation requirements for the system. Refer to
the "Specifications" section for additional system and component details.

Warning: To avoid spinal and muscular injury, do not attempt to lift a system module
without assistance.

Warning: To avoid injury when moving a system component, ensure that no objects
are in the path of the cart wheels.

2.2 Gas supply (liquid CO₂) requirements
The CO2 must be industrial grade or better (depending on the application requirements) and
supplied without the use of a regulator. CO2 can be supplied from one of these sources:

• A pressurized cylinder equipped with a dip (eductor) tube, to pull liquid CO2 from the bottom
of a cylinder

• A BDS 500 gas delivery system

• An in-house supply of liquid CO2 supplied at an ambient temperature of 18 to 24 °C and a
minimum pressure of 5500 kPa (55 bar, 798 psi)

Depending on its configuration, a system can also include an optional CO2 recycler system.

Warning: To avoid frostbite and other injuries associated with the sudden release of
rapidly expanding fluids, observe these precautions:

• Depressurize the system before attempting to change or work with the bulk fluid
supply.

• Exercise caution when opening fittings, to avoid being sprayed by rapidly expanding
solvents.

• Fit supply lines made only of materials that can suitably withstand the highest
pressure that the system can generate.
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Table 2–1: Minimum requirements for CO2 and its supply system

Item Minimum requirement

Purity Industrial grade

Supply cylinder Dip-tube cylinder

Pressure 5500 kPa (55 bar, 798 psi)

Storage temperature Ambient (above 15 °C)

2.3 Solvent requirements
Secondary solvents mixed with the primary solvent are called co-solvents and must be HPLC-
grade or reagent-grade. Waters recommends using clean, high-purity, sub-micron-filtered
solvents.

Many different organic solvents can be used in the system as long as they are miscible with
supercritical CO2 and compatible with the materials in the system's flow path. Those materials
include types 316, 17-4, and 304 stainless steel, GFPM, Polyimide, Nitronic 60, Fluoropolymer,
sapphire, ruby, and UHMWPE (optional).

Warning: Observe Good Laboratory Practice (GLP) at all times, particularly when
working with hazardous materials. Consult the Material Safety Data Sheets regarding
the solvents you use. Additionally, consult the safety representative for your
organization regarding its protocols for handling such materials.

Notice: To avoid clogging the system, do not use water as a solvent in the mobile
phase. At certain concentrations, water becomes immiscible with organic solvents and
can separate and freeze.

Notice: To avoid damaging components in the system's flow path, do not use acidic
solvents, particularly those containing any amount of hydrochloric acid.

Recommendation: When extracting compounds for edibles, Waters recommends using food-
grade ethanol as the co-solvent.

2.4 Power requirements
Consider these power requirements when preparing your laboratory:

• All system modules require a dedicated, grounded power source, the receptacles of which
must share a common ground and be accessible to all modules.
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Warning: To avoid nonlethal electric shock caused by high current leakage, when
installing or replacing the P-200 high-pressure pump, connect a secondary earth
ground, or earth, to the rear of the pump chassis.

• The circulating bath requires a dedicated circuit.

• The individual modules, except for the circulating bath, relays, optional recycler system, heat
exchanger between CS2 and CS3, and PC workstation, are connected to the system's
attached power strip.

• Use a line conditioner or an uninterruptible power supply (UPS), for optimum long-term input-
voltage stability.

For additional information about power requirements, refer to the Bio-Botanical Extraction System
Site Preparation Guide (715004529).

2.5 Environmental requirements

2.5.1 General environmental requirements
Refer to these general environmental requirements when preparing the laboratory:

• Install the system in an environmentally controlled laboratory, in a draft-free location away
from excessive amounts of dust.

• Do not locate the system directly beneath air-conditioning or heating ventilation.

• Do not locate the system in direct sunlight.

• The ambient relative humidity must be in the range of 20% to 80%, non-condensing.

• The system is intended for use in a well-ventilated area designed to accommodate the use of
flammable solvents. The equipment must not be used in an environment capable of
containing an explosive atmosphere.

• The ventilation system must provide an air exchange rate of four rooms per hour.

2.5.2 Temperature requirements
Refer to these temperature requirements and considerations when preparing your laboratory:

• The ambient temperature in the laboratory must be 18–24 °C.

• The optimum temperature range of the laboratory is 19–22 °C.

• Short-term thermal variations must not exceed 2 °C per 1.5 hours.

Important: Thermal variations in excess of 2 °C per 1.5 hours can adversely affect system
performance.
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Recommendation: To avoid significant thermal variations, do not locate the Bio-Botanical
Extraction System in direct sunlight.

2.5.3 Vibration considerations
Do not locate the system close to heavy machines, such as compressors or generators, that can
create excessive floor vibration.

2.5.4 Magnetic field considerations
Locate the system away from strong magnetic fields, such as those generated by NMR systems
or magnetic-sector mass spectrometers.

2.5.5 Radio emission considerations
Locate the system in an environment where radio frequency (RF) emission from surrounding
sources is minimal.

2.6 Safety considerations
Waters recommends the use of carbon dioxide monitors in laboratories in which the system is
located. The monitors must be able to detect CO2 levels to 10,000 ppm, and trigger an alarm at
5000 ppm.

Warning: To avoid serious injury or death from CO2 vapors, ensure that the room
containing the system is well ventilated. The ventilation system must provide an air
exchange rate of four rooms per hour.

2.7 Venting and waste
CO2 is toxic at levels above 10,000 ppm (PEL 5000 ppm). Additionally, it can displace air in a
confined space, such as a laboratory. Ventilation for the system is therefore required. Plumb the
exhaust tubing (not included with the system) to the laboratory's exhaust system, to properly vent
gaseous CO2 and the residue of solvent waste.

The system includes provisions for venting to a fume hood through a 6.4-mm O.D. compression
fitting. Exhaust tubing connected to the fitting must be stainless steel and sized to allow
unrestricted venting of the vapor. The system also includes provisions to vent the rupture discs to
a hood or to the outside by 3/8-inch compression fittings attached to each rupture disc outlet.
Tubing connected to each fitting should be of sufficient strength to withstand the pressures.
Exhaust tubing is not included with the system.
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Warning: To avoid explosion, do not use a highly flammable solvent as a cleaning
agent for heated components. Leaks of flammable cleaning agents onto the heated
vessel surfaces could cause flammable or explosive mixtures to form. The heated
components can achieve temperatures as high as 90 °C. These temperature levels
exceed the flash point of many flammable vapors. Avoid using any solvent for which the
ignition temperature is in this range. Always inspect the system for leaks before
operating it unattended.

Warning: To prevent death or injury in locations where CO2 is used or stored install a
CO2 ambient-air sensor and alarm unit to comply with the permissible exposure limit for
CO2 prescribed by the US Occupational Safety and Health Administration. Install the
CO2 air sensor and alarm unit instead of, or in addition to, an oxygen monitor. The unit
must be capable of detecting CO2 levels to 10,000 ppm and issuing an alarm at 5000
ppm CO2.

Warning: To avoid injuries caused by shattering glass fragments, do not use
laboratory glassware to collect fractions or waste components. When opening drain
valves, a high-pressure release of solvent or extracted compounds can knock a glass
container out of your hand and cause it to shatter.

Notice: To avoid electrical damage to components from static charge build-up, ensure
that the exhaust tubing is grounded.

2.8 Plumbing connections
A Waters technician equips and plumbs a system as part of its setup. All tubing connections
between components are pre-fitted for their intended use. Extra fittings can be purchased in an
accessories kit. If you need additional tubing or fittings, contact your Waters service
representative for assistance.

Warning: To avoid injury from fittings that burst under high pressure, do not
interchange ferrules and gland nuts between fitting types. Many fittings appear identical
or similar. Use only the specified ferrule and gland nut for a fitting. If you are unsure
about the nature of a particular type of fitting, contact your Waters service
representative for assistance.

Warning: To avoid injuries from flailing tubing, ensure that tubing is secured at both
ends before pressurizing the system.

Warning: To avoid injury from tubing that bursts under high pressure, use only tubing
that can suitably withstand the highest pressure the system can generate. If you are
unsure about the pressure rating of a particular type of tubing, contact your Waters
service representative for assistance.

February 21, 2018, 715004757 Rev. D
Page 31



Notice: To avoid leaks caused by improper tightening of fittings, when making tubing
connections or tightening their fittings, follow the fittings manufacturer's tightening
instructions. Replace the tubing or fittings when proper tightening fails to stop the
connection from leaking.

2.9 Electrical considerations
The system's operating voltage is configured at the factory to operate at on the standard line
voltage for your location. If you move the system to an area where the line voltage differs from
that of the original location, refer to the system's site preparation guide for the specific
requirements for your location.

Before powering-on the system modules, ensure that all power cords are connected to
appropriate sources of power. Insert the power cords only into socket outlets provided with a
protective ground (earth) contact. Any interruption of the protective grounding conductor can
result in a fault condition that can cause personal injury or death. All wiring constituting the ac
supply must meet local electrical codes.

Warning: To avoid a fault condition that can result in personal injury or death from
electric shock, do not disconnect or otherwise interrupt the continuity of an electrical
socket's protective grounding conductor or the power cord's grounding conductor.

Warning: To avoid electric shock, observe these precautions:

• Use SVT-type power cords in the United States and HAR-type power cords, or
better, in Europe. For requirements elsewhere, contact your local Waters distributor.

• Inspect the power cords for damage, and replace them if necessary.

• Power-off and unplug each module before performing any maintenance operation
on it.

• Connect each module to a common ground.

Warning: To avoid electric shock, always disconnect the system from its source of
electrical power before connecting or disconnecting external cables.

2.10 Connecting to the ac power source
Each module contains its own internal power supply. Connect the system power connections to
an appropriate ac power source. For modules with On/Off switches, the switch is located on the
rear panel of each module. To start the system operating, power-on each of its modules
individually.

Requirement: You must wait at least 30 seconds after you power-on the last module before
you start the ChromScope software. This waiting period is necessary for the modules to
communicate with the software during start-up.
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3 Getting started with ChromScope
software

3.1 Starting ChromScope software
To start and log on to the ChromScope software, you must be a registered user, and you must
provide your user name and password.

Exception: If the administrator disables the Secure System function, the ChromScope Login
window is bypassed, allowing anyone, not only registered ChromScope users, to start and run the
software.

Important: To enable communication between the software and system modules, ensure that
the pumps and other hardware components are powered-on for at least 30 seconds before you
start the software.

To start ChromScope software:

1. From the Windows desktop, double-click the ChromScope shortcut .

Alternative: From the Windows Start menu, click All Programs, and click 
ChromScope.

2. Enter a valid user name and password.

Requirement: Both are case-sensitive. If you do not know your user name and
password, inform your system administrator.

Requirement: When the software initially opens, you must provide these default settings:

• Login: Administrator

• Password: waters

3.2 Exiting from ChromScope software

To exit from the ChromScope software:

1. From the File menu, click Exit.

February 21, 2018, 715004757 Rev. D
Page 33



3.3 ChromScope software interface
The default ChromScope main window shows projects, the system's status, and the configured
modules. The window includes a system-status panel for monitoring system modules and a
status-control panel from which you manage modules and manually control the application. From
the Status Control panel's options menu, you can click Configure to change a module's device
settings. You can customize the main window to display or hide individual panels, or to change
their display format, according to user preferences.

Figure 3–1: ChromScope main window

Nodes in folder view provide controls and options for the files within it

Menu bar

Toolbar

Acquisition Control panel

Tabbed panels open in this area from the Folder View or File View panels to be viewed or
edited.
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System Status panel shows each module's status, at a glance

Acquisition Status panel

Status Control panel provides both running status and set-point boxes that you can use to
monitor and manually control individual modules

Queue of pending methods

System Messages box lists system messages and shows the status of individual modules
when you move the pointer over the module's representation in the System Status or Status
Control panels

Run Status panel showing current run information

File-list view area displays the files listed in the selected project's subfolder node

The ChromScope software provides simple workflows for developing sample lists and running
extractions. It also provides instrument control and automation and reporting. The software
includes the key components and functions shown in the following table.

Table 3–1: ChromScope key components and functions

Component or
function

Purpose

Account manager Adds user accounts, as needed, so that all changes and generated data
are digitally signed by the user performing the work.

Project manager Groups data-log files, sample files, templates, and reports (PDF files) into
logical categories under the project's name.

Navigation tree Quickly accesses frequently chosen functions and software files that
appear in the Folder View and File View panels.

Menu and toolbar Provides logical access to most ChromScope functions.

Custom viewing
and file opening
options

Specify these user preferences:

• Change the size of different display panels in the application window
by dragging the split bar between different display panels (areas).

• Change the ChromScope main window layout to enhance the visibility
of desired elements, such as the current run status information. For
details, see Customizing your ChromScope window layout.

• Open data-log files in a new tab, current tab (replace), or overlay.

• Open active plots in a separate window that offers an expanded view.
You can also view all graphs of a file in a separate window.
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Table 3–1: ChromScope key components and functions (continued)

Component or
function

Purpose

Method editor Specify and save the parameter settings of temperature, flow, pressure,
and timing (static and dynamic). Later, you can edit or modify the
methods, as needed, load the methods into a queue, and then run them to
perform extractions or purify sample.

System Status, 
Current Run, and 
Status Control
panels

Monitor performance, configure settings, perform diagnostic tests, and
maintain the system and its modules. In the Current Run panel, you view
real-time plots for temperature, flow, and pressure activities.

Reporting Prints custom or quick reports to a PDF file or an installed printer.

Batch process Prints reports of groups of data-log files in batch mode.

Exporting Exports raw data from the data-log files to MS Excel and CSV formats.

Copy and Save Copy plot images to the clipboard or save plots to a file.

3.4 Customizing your ChromScope window layout
You can customize the ChromScope main window layout according to your preferences to
display or hide individual panels or to change their format. For example, you can reposition or
hide individual panels within the ChromScope main window, as needed, to maximize the space
available for display of the plots or chromatograms from the current run.

From an individual panel's options menu, you can change its layout by selecting
any of the following options:

• Float – Allows you to move and resize the panel in various locations of the ChromScope main
window.

• Dock – Opens the panel according to its last layout.

• Dock as Document – Opens the panel in the tabbed area.

Tip: When a panel is docked as a document in the tabbed area, you can right-click on it to
select additional display characteristics, including having it open in a new horizontal or vertical
tab group.

• Auto Hide – Closes the panel from view and allows you to quickly redisplay it by clicking on
the panel's name, which appears along the margin of the ChromScope main window.

• Close (X) – Closes the panel or tab from view. To redisplay the panel or tab, from the View
menu, click Show, and then click the name of the panel or tab that you want to redisplay.

Alternative: To redisplay a closed panel or tab, from the navigation tree in the Folder View
panel, click the panel's node or the tab's folder, respectively.
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Tip: You cannot close any panels or tabs that you cannot open from the Folder View panel.

Important: To reset the panels to their default layouts, from the View menu, click Load Views > 
Default Views > DefaultUI.

Additional customization features:

• Enlarge or shrink the subpanels that make up the Status Control panel to maximize the space
available for display of the subpanels in a particular layout or view. You can also reposition
them within the panel individually, or as a group, according to your preferences.

• Edit and save customizations to the user-interface layout as individual views, which you can
later select and load, as needed, to change the user-interface layout.

• Lock or unlock the main window to prevent or allow customizations to the user-interface
layout.

• Lock or unlock the Status Control panel to prevent or allow customizations to the Status
Control panel's user-interface layout.

3.4.1 Repositioning a panel or tabbed component within the
ChromScope main window
You can customize the ChromScope window layout, or view, according to your preferences by
moving any of the individual panels or tabbed components that make up the ChromScope main
window to a new "docked" location. When you do so, the new layout persists until it is changed
again or is overridden by loading a different view.

Exception: Except for reports and report templates, components that open from the File View
panel, including methods, sample lists (for SFC and LC systems), data-log files, and history
records, are intended to open as tabbed components within the "editor panel", which in the
ChromScope default layout view, is in the center area of the main window. Although you can
reposition any of the opened files or tabbed components out of the editor panel to another
location in the ChromScope main window, after closing these files, any files that you
subsequently open, do so in the editor panel, instead of the new location. Accordingly, use care
when repositioning or resizing the editor panel so that it can fully display these files for viewing or
editing.

Requirement: The lock/unlock control for the ChromScope main window must be set to unlock.

To reposition a panel or tabbed component, do as follows:

1. From the individual panel's or tabbed component's options menu, select Float.

Result: The panel or component s temporarily resized so that you can easily move it over
a repositioning guide that indicates its new location.

2. Click within the panel's title bar and drag it slightly to reveal the repositioning guides on the
ChromScope main window.
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Alternative: In place of steps 1 and 2, click on the panel's title bar or component's tab
and drag it slightly to reveal the repositioning guides on the ChromScope main window.

Figure 3–2: Acquisition Control panel set to Float, showing the repositioning guides
on the ChromScope main window

3. Continue dragging the panel or tabbed component onto the repositioning guide that
indicates its new location, and then release it.

Note: The repositioning guide becomes active when you drag the panel or component
onto it.

4. Resize the repositioned panel or component, as needed.

Tip: To prevent unintended changes to the newly customized layout, lock the
ChromScope main window layout by clicking View > Lock Main UI Control.

3.4.2 Resizing and repositioning the subpanels within the Status
Control panel
You can enlarge or shrink the subpanels that make up the Status Control panel to maximize the
space available for display of the subpanels in a particular layout or view. You can also reposition
them within the panel individually, or as a group.

Requirement: You must set the lock/unlock controls for the Status Control panel and the
ChromScope main window to unlock.

To resize the Status Control subpanels, do as follows:

1. Open the Status Control panel and, if necessary, reposition it within the ChromScope main
window.
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See also: Repositioning a panel within the ChromScope main window.

2. At the top of the Status Control panel, use either of these techniques, according to your
preference, to resize the subpanels:

• Click the box next to the Resize Bar and select Small, Medium, or Large.

• In the Resize Bar, click and drag the slide control to shrink or enlarge the subpanels.

Result: Each of the subpanels adopts the new size characteristic, which persists until
they are resized again.

3. Reposition the subpanels within the Status Control panel using these techniques:

• To align the subpanels along a vertical or horizontal grid, right-click in the Status
Control panel and select Align Vertical or Align Horizontal.

• To reposition the subpanels individually, click and drag each subpanel to its new
location.

Tip: To display a grid for repositioning the individual panels, select the Show Grid Lines
check box.

Result: The subpanels retain their new positioning, which persists until they are
repositioned again.

Tip: To prevent unintended changes to the newly customized Status Control panel, at the

top of the Status Control panel, click Lock  to lock the panel.

3.4.3 Saving a view
You can save the current layout of the ChromScope main window as a new view, or as an update
to a previously saved view.

To save the current ChromScope user-interface layout, do as follows:

1. From the View menu, click Save View.

2. In the Save View dialog box, type the name of the new view, or select an existing view that
you want to update with the current main window layout characteristics.

3. Click OK to save the view.

3.4.4 Loading a view
You can load a previously saved view to change the layout of the ChromScope main window.

To load a view, do as follows:

1. From the View menu, click Load Views.

2. In the Load Views dialog box, select an existing view that you want to load.
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3. Click OK to load the view.

4. Click Yes to accept the new ChromScope layout.

3.4.5 Locking the ChromScope window or Status Control panel layout
You can prevent users from unintentionally modifying the ChromScope main window or Status
Control panel layouts by locking the controls for these layouts. Doing so prevents customization
of the window or the panel until you unlock the layout controls.

3.4.5.1 Locking the ChromScope main window layout

To lock the ChromScope main window layout, do as follows:

1. From the View menu, click Lock Main UI Control.

Result: Changes to the ChromScope main window layout (including the Status Control
panel) are prevented until you unlock the control by clicking View > Unlock Main UI
Control.

3.4.5.2 Locking the Status Control panel layout

Requirement: To lock or unlock the Status Control panel layout, the ChromScope main window
layout control must be unlocked.

To lock the Status Control panel layout, do as follows:

1. From the View menu, click Lock Status Control.

Result: Changes to the ChromScope Status Control panel layout are prevented until you
unlock the control by clicking View > Unlock Status Control. You can still make other
changes to the ChromScope main window layout.

Alternative: At the top of the Status Control panel, click the Lock/Unlock  or  icon
to lock or unlock the Status Control panel layout.

3.5 Project management
In the ChromScope Folder View panel, the Project Folders node provides access to all defined
projects and their associated files. Within the node, a sub-node structure for each project stores
methods, data-log files, report templates, reports, and history records.

You can create a new project or choose to work with existing projects. When you create a new
project in the system, a project folder with the project name appears under the Project Folders
root node. Inside the project folder, ChromScope software creates a subfolder structure to
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organize each file type that exists in the project. Click any of these sub-nodes to display the files
of that type in the file-list view, or right-click a sub-node for more options.

The table "ChromScope project subfolder structure" describes each of the project's subfolders
and the files they contain.

Table 3–2: ChromScope project subfolder structure

Subfolder Description

Method Files Contains the methods used to define run conditions.

Data Files Contains the data-log files that store data, plots, and associated method
information from previous runs. It can have a subfolder for organizing the
data-log files.

Report Templates Contains the Quick Report template and any custom report templates.

Reports Contains the reports saved as PDF files.

History Folders Contains the history records for each session that ChromScope
automatically logs. These records, organized by date, provide a running log
of system activities.

These are the options for setting up a new project:

• Define a subfolder-naming convention that organizes all of a project's data-log files by date,
sample name, or user name.

• Import files from another project.
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4 Administration

4.1 User management
As a ChromScope system administrator, you can use the Account Management function to
accomplish these tasks:

• Control access to the ChromScope software functions by establishing and maintaining user
accounts.

• Enforce limits on what ChromScope components a user can see and control by assigning the
user specific component rights.

• Choose whether the ChromScope software runs in a secured or open environment.

If you elect to run the software in a secured environment, the system security and audit trail
functionality provide these features:

• You prevent users from operating the system until they successfully log in using a registered
user account.

• After a user logs into the system, the user-name entered becomes attached to all data-log
files generated by the system during that session. In addition, reports generated from data
recorded during the session include user name information for both the user who generated
the data file and the user who created the report.

Rule: Users who are not also system administrators, can use the Account Management Current
User Information window only to view their personal user account information and change their
passwords.

Restriction: Only an administrative user can set the Secure System preference and create,
modify, or delete a user account.

4.1.1 Specifying security preferences
1. From the Configure menu, click Account Management > Secure System or User

Manager.

2. Specify whether the software will operate in a secured or unsecured environment by
selecting or clearing the Secure System check box.

Important: When you clear the check box, the log-in screen is hidden, and audit trail
functionality for generated logs or reports is disabled.
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4.1.2 Creating a user account
1. From the Configure menu, click Account Management > User Manager.

2. In the User List area of the User Manager window, right-click, and then click Add User.

3. If you want to assign the new user administrator privileges, select the Administrator check
box.

4. Enter the new user's authentication information, and then click OK.

4.1.3 Configuring a user account
1. From the Configure menu, click Account Management > User Manager.

2. In the User Manager window, select the user from the user list, and click View
Components.

3. In the User Information window, click the Component Type list to add, modify, or remove
component rights for the user.

4. To change the user's login password, click Change Password.

4.1.4 Removing a user account
1. From the Configure menu, click Account Management > User Manager.

2. In the User Manager window, right-click the user name in the user list, and then click 
Delete User.
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5 System configuration and methods

5.1 Viewing or modifying the system configuration
From the System Configuration panel, you can view all of the system's configured devices and,
when necessary, update them to mirror the addition or removal of optional devices you installed
on, or removed from, the system.

For example, with a Prep SFE system, you could add the vessel switcher with CO2 recycler or
change the number of collection vessels the system uses for the product you are extracting.

To view or modify system devices:

1. From the Configure menu, click System Configuration.

2. In the upper box, view the present configuration, which lists serial numbers and firmware
versions for devices with these features.

3. To update the devices in the System Configuration panel to mirror the addition, or removal,
of optional devices you installed on, or removed from, the system, click Add or Remove,
as needed, to change the optional devices that appear in the Attached Optional Devices
box.

4. If you modified your system configuration:

a. Click Apply to save your changes.

b. Close and then reopen the ChromScope software to validate the update process.

5. If you made no changes to your system configuration, click Close.

5.2 System and module settings
In the System Settings and Device Configuration panels, you define your preferences for shutting
down the system in response to certain operating conditions and for configuring the individual
module's alert thresholds and usage settings. You can also view a module's real-time device
status for maintenance or diagnostic purposes.
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5.2.1 Specifying the system shut-down and equilibration conditions
1. In the Folder View panel, click the System Settings node to open the System Settings

panel.

2. Click the Start/Shutdown Options subpanel to display the system start-up and shut-down
settings.

3. In the Start/Shutdown subpanel, configure the system referring to the following tables.

Table 5–1: System shut-down options

Setting or control Purpose

Stop system when a
device returns a
warning

Initiates a system shutdown when a module issues a warning.
Clear the check box to allow the system to continue operating
when a module issues a warning.

Stop system when a
device becomes
unequilibrated

Initiates a system shutdown when events, like an empty solvent
bottle or CO2 supply tank, prevent the system from maintaining a
specified set point. For example, if this option is enabled and the
CO2 flow becomes restricted, the system fails to maintain the
specified pressure set point and initiates a system shutdown. Clear
the check box to allow the system to continue operating whenever
it fails to maintain a user-specified set point.

Stop system if the
vessel pressure drop
exceeds x bar

Initiates a system shutdown whenever the system detects a
pressure drop exceeding the level specified by this option. Before
specifying a value for pressure drop, consider the consistency of
the sample material you are extracting and the run's flow rate. For
example, separations of viscous sample material or those that run
at very low flow rates tend to exhibit more pressure fluctuation than
those unaffected by such conditions. This is a required entry, and
the maximum pressure drop you can specify is 60,000 kPa (600
bar, 8702 psi).

Recommendation: Waters recommends a "stop system" vessel
pressure drop level of 15,000–20,000 kPa (150–200 bar, 2176–
2901 psi).
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Table 5–1: System shut-down options (continued)

Setting or control Purpose

Depressurize system
to end pressure x
bar over a duration
of x min

Depressurizes the system, according to specified conditions, after
the last run ends and the sample list queue clears. Before
specifying the pressure according to which the system
depressurizes, consider the effects of temperature change on the
sample material and specify appropriate values for end-pressure
and time duration. Alternatively, clear the check box if you do not
want to set the conditions for depressurizing the system after a run
ends.

Important: 

• During depressurization, the system pressure does not always
achieve the specified end-pressure setting because the ABPR
cannot reduce the system pressure below the level established
by the MBPR1. In this situation, specifying an end-pressure
below that set by the MBPR1 has no effect.

• Generally, the shorter the duration you specify for
depressurization, the more quickly you allow the liquid CO2 to
convert to gas, which increases the temperature drop to which
the sample is exposed. Accordingly, due to the increased
volume of CO2, allow more time to depressurize larger
extraction vessels.

Tip: If you use this option to set the end pressure, you can also
depressurize the system at any time to these conditions by clicking 
Depressurize System from the Tools menu.

Leave devices
running at the end of
a run

Select this check box to enable modules to continue running at
sample list conditions at the end of a run. Alternatively, clear this
check box to allow modules to go to a Standby state ("Off") at the
end of a run.

Recommendation: Waters recommends selecting this check
box to keep the inline collection heaters running until you power
them down.

Leave extraction
vessel heaters
running at the end of
a run

Select this check box to maintain the temperature in the vessel
heaters at the specified set points in the run.
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Table 5–2: System equilibration options

Setting or
control

Purpose

Pressure
Equilibration
Band (+/-)

For all system modules with system pressure set points, specifies the
amount of variation, in bar, that the actual pressure reading can
deviate from its specified set point before the module attains
equilibration and maintains its ready state (indicated by green in the
ChromScope software).

Temperature
Equilibration
Band (+/-)

For all system modules with temperature set points, specifies the
amount of variation, in degrees Celsius, that the actual temperature
reading can deviate from its specified set point before the module
attains equilibration and maintains its ready state (indicated by green
in the ChromScope software).

System
Equilibration
Timeout

For all system modules, specifies the maximum time duration, in
minutes, that is allowed for a module to equilibrate to its set points
and attain its ready state before the software triggers an alarm and
initiates a system shutdown.

Note: When specifying the System Equilibration Timeout, consider
the size vessels you are heating. Larger vessels generally require
more time to equilibrate than smaller ones.

4. Click Apply to save your system shut-down and equilibration settings.

5.2.2 Specifying settings or viewing device status for the CO2 recycler

For systems that include an automated vessel switcher and CO2 recycler, you can specify device
settings and view device status for the CO2 recycler in the Vessel Switcher configuration
subpanel under the Device Configuration node. For details, see "Specifying settings or viewing
device status for the vessel switcher".

5.2.3 Specifying settings or viewing device status for the CO2 pump

In the Device Configuration panel, you can specify device settings, such as the high-pressure
alarm or view the pump status.

To specify settings and view device status for the CO2 pump:

1. In the Folder View panel, click the Device Configuration node to open the Device
Configuration panel.

2. Click CO2 Pump to open the CO2 Pump configuration subpanel.
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Alternative: In place of steps 1 and 2, in the Status Control CO2 Pump subpanel's
options menu, click Configure to open the CO2 Pump configuration subpanel.

3. In the CO2 Pump configuration subpanel, view the device or pump status and configure
device settings referring to the tables "CO2 pump: device status" and "CO2 pump: device
settings".

Table 5–3: CO2 pump: device status

Status
item

Indicates

Device
Status

The operating mode of the pump. During normal operation, and during the
period prescribed by the Dynamic Duration sample list setting, the device
status indicates that the pump is operating in the flow-control mode. When
the pump is running during the period prescribed by the Static Duration
sample list setting, the device status indicates that the pump is operating in
the pressure control mode.

See also: "Mode" under Device Settings below.

Flow The flow rate of the pump in g/min.

Pressure The pump's current pressure in bar.

RPM The operating rate of the pump.

Tips: 

• A high pump RPM can mean that the CO2 supply in the CO2 recycler is
below the minimum required for operation. Check and fill the recycler with
fresh CO2.

• If the pump RPM is high and you have confirmed that the CO2 recycler
still contains CO2, check the mass flow sensor density. If the density is
below -.88, add more CO2 to the system from the recycler source.

• When a pump's check valve fails, the pump's outflow decreases, causing
it to run faster in order to maintain the specified flow rate. If the flow rate
is significantly lower than the pump RPM, one or more check valves may
need to be replaced. Other possible problems include restriction on the
inlet, leaking piston seals, and a low supply of CO2.

• If the cooling heat exchanger or chiller are not performing properly, the
pump will require a higher RPM to deliver the specified mass flow. If you
suspect a low CO2 supply is causing this, based on the pumping rate,
check the mass flow sensor temperature and density. If the mass flow
sensor temperature is normal (below 12 °C) and its density is low, the
CO2 supply may be low. If the mass flow sensor temperature is high
(above 12 °C), the chiller or cooling heat exchanger may require service.
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Table 5–4: CO2 pump: device settings

Setting or control Purpose

Mode If you are not running a sample list and are manually
controlling the CO2 pump from the Status Control panel,
you can select either Flow Mode or Pressure Mode.

Important: The flow mode is the pump's normal mode,
used when pumping CO2 through the system at a
designated flow rate. The pressure mode is an alternative
mode that enables the pump to maintain the user-specified
pressure, instead of a specified flow rate. Under manual
control of the system, you typically select, via the CO2
Pump configuration panel, the pressure mode only during
the Static Duration period, when the extraction vessel's
outlet valve is closed and the pump maintains a set
pressure within the vessel. Under sample list control of the
system, the ChromScope software automatically makes the
selection from the flow mode to the pressure mode, and
vice versa.

Maximum Set Flow Specifies the flow-rate threshold above which the software's
flow-rate control function issues an alarm and shuts down
the pump.

Maximum Set Pressure Specifies a limit for the maximum-pressure set point
specifiable for the pump.

High Pressure Alarm Specifies the pressure threshold above which the software's
pump-pressure control function issues an alarm and shuts
down the pump.

Recommendation: Set the alarm pressure threshold at
5000 kPa (50 bar, 725 psi) above the maximum extraction
pressure.

Notice: To avoid the risk of a high-pressure burst
of the pump's rupture disc, set the alarm pressure
threshold below 40,000 kPa (400 bar, 5802 psi).

Flow Control Settings For use by Waters service technicians only.

Pressure Control Settings For use by Waters service technicians only.

Apply Saves all new device settings for the CO2 pump.
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5.2.4 Specifying settings or viewing device status for the co-solvent
pump
In the Device Configuration panel, you can configure co-solvent threshold and usage settings and
view the pump's device status.

To specify settings or view device status for the co-solvent pump:

1. In the Folder View panel, click the Device Configuration node to open the Device
Configuration panel.

2. Click Co-Solvent Pump to display the pump's device status and level settings.

Alternative: In place of steps 1 and 2, in the Status Control Co-Solvent Level subpanel's
options menu, click Configure to open the Co-Solvent Pump configuration subpanel.

3. In the Co-solvent Pump configuration subpanel, view the pump status and specify settings
as follows.

Table 5–5: P-50 co-solvent pump: device status

Status item Indicates

Operating
mode device
status

The operating mode of the pump. During normal operation, and during the
period prescribed by the Dynamic Duration sample list setting, the device
status indicates that the pump is operating in the flow-control mode. When
the pump is running during the period prescribed by the Static Duration
sample list setting, the device status indicates that the pump is operating in
the pressure-control mode.

See also: "Mode", under Device Settings, below.

Flow The flow rate of the pump, in mL/min.

Pressure The pump's current pressure, in bar.

RPM The operating rate of the pump.

Tip: When a pump's check valve fails, the pump's outflow decreases,
causing it to run faster, to maintain the specified flow rate. A typical pump's
flow rate (mL/min) is slightly under or equal to the pump RPM, depending
on the output pressure. If the flow rate varies significantly from the pump
RPM, you may need to replace one or more check valves. Other possible
problems include leaking piston seals and a low supply of co-solvent.
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Table 5–6: P-50 co-solvent pump: device settings

Setting or control Purpose

Mode If you are not running a sample list and are manually
controlling the co-solvent pump from the Status Control
panel, you can select either the Flow Mode or Pressure
Mode.

Important: The flow mode is the pump's normal mode,
used when pumping co-solvent through the system at a
designated flow rate. The pressure mode is an alternative
mode that enables the pump to maintain the user-specified
pressure, instead of a specified flow rate. When you
manually control the system, you typically select the
pressure mode, via the Co-Solvent Pump configuration
panel, only during the Static Duration period, when the
extraction vessel's outlet valve is closed and the pump
maintains a set pressure within the vessel. When the
sample list controls the system, the ChromScope software
automatically makes the selection from the flow mode to the
pressure mode, and vice versa.

Maximum Set Flow Specifies the flow-rate threshold above which the software's
flow-rate control function issues an alarm and shuts down
the pump.

Maximum Set Pressure Specifies a limit for the maximum-pressure set point
specifiable for the pump.

High Pressure Alarm Specifies the front-end pressure threshold above which the
software's pump-pressure control function issues an alarm
and shuts down the pump.

Flow Control Settings For use by Waters service technicians only.

Pressure Control Settings For use by Waters service technicians only.

Apply Saves all new device settings for the co-solvent pump.

5.2.5 Specifying settings or viewing device status for the heater
controller modules
Depending on a system's configuration, it can include as many as two 6-zone heater controller
(CN6) modules. When two modules are provided, you configure and view device status for the
second heater-controller module on the Heater Controller 2 configuration subpanel. Each panel
presents settings and device status for zones 1 through 6 that correspond to input/output-paired
connections on the module's rear panel. Typical assignments for these zones include the
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electrical vessel heaters and in-line heat exchanger. Zones that are not assigned a heating role
have the Enabled check box cleared.

Tip: Unassigned zones may have additional temperature-related equipment connected and be
activated for diagnostic purposes.

To specify settings or view device status for the heater controller:

1. In the Folder View panel, click the Device Configuration node to open the Device
Configuration panel.

2. Click Heater Controller or Heater Controller 2 to open the configuration subpanel.

Alternative: In place of steps 1 and 2, in any of the Status Control Heaters' subpanel's
options menu, click Configure to open the Heater controller or Heater Controller 2
configuration subpanel.

3. In the Heater Controller configuration subpanel, identify the zones used to control and
monitor the heat exchanger or electric heaters for the system.

4. For each assigned zone, verify that it is enabled, view its current temperature, and verify its
maximum temperature limit and alarm set point referring to this table:

Table 5–7: Example heater controller settings - Zone 1

Setting or
control

Purpose

Zone Name Specifies the name given to the zone (for example, Zone 1). Zone 1
could also be identified by a name that indicates the controller and the
heater device it controls or monitors (for example, "Vessel Heater 1").

See also: Role

Rationale: Zone 1 of heater controller 1 controls the temperature of
the electrical vessel heater for extraction vessel 1. Also, zones can be
configured for monitoring only (associated with a connection having no
output control cable), such as the zones used for monitoring the
temperature of the fluid inside the extraction vessels.

Max. Temp. Specifies the upper limit for specifying the temperature set point for the
zone.

Alarm Set Point Specifies the temperature threshold above which the software's
overtemperature control function issues an alarm and shuts down the
heater.

Cycle Time For use by Waters service technicians only.

Dead Band For use by Waters service technicians only.

Proportional For use by Waters service technicians only.

Integral For use by Waters service technicians only.
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Table 5–7: Example heater controller settings - Zone 1 (continued)

Setting or
control

Purpose

Derivative For use by Waters service technicians only.

Upper Integral B For use by Waters service technicians only.

Lower Integral B For use by Waters service technicians only.

TC Type Identifies the type of connector used to control and monitor the
temperature of the heater device. For Waters heater devices, specify
the TC type as J, to enable control and monitoring. Alternatively,
specify None, to indicate that no connector is used.

Role Assigns this zone to a particular device.

Important: Usually, an administrator uses this setting for
troubleshooting or adding a new heating device to the system. If you
change the role setting, you must also reconfigure the thermocouple
and control cabling between the heater controller module and the
heater device identified in the changed role.

Warning: To avoid electric shock, always disconnect the
system from the AC power supply before connecting or
disconnecting external cables.

5. Click Apply to save the heater controller settings.

5.2.6 Specifying settings or viewing device status for the ABPR
In the Device Configuration panel, you can specify settings or view device status for the
automated back-pressure regulator (ABPR).

To specify settings or view device status for the ABPR:

1. In the Folder View panel, click the Device Configuration node to open the Device
Configuration panel.

2. Click ABPR to open the ABPR configuration subpanel.

Alternative: In place of steps 1 and 2, in the Status Control ABPR subpanel's options
menu, click Configure to open the ABPR configuration subpanel.

3. In the ABPR configuration subpanel, view the status of the automated back-pressure
regulator and configure its control and needle position settings referring to the tables
below.
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Table 5–8: ABPR status

Status item Indicates

Valve temperature The temperature of the pressure-regulator valve.

External heater
temperature

The temperature reading of the optional external heater, when
connected. (If an external heater is not connected, the temperature
reading is 0 °C.)

Valve needle
position (units)

The extent of the valve's open position. The software can
automatically open the valve to a maximum needle count of 3000.
To fully open the valve and depressurize the system, you can
manually set a needle count of 6000. A needle count of 0 fully
closes the valve.

Table 5–9: ABPR threshold and usage settings

Setting or control Purpose

Valve heater set point For use by Waters service technicians only.

External heater set
point

For use by Waters service technicians only.

External temperature
alarm

For use by Waters service technicians only.

High-pressure alarm For use by Waters service technicians only.

Attenuation Factor For use by Waters service technicians only.

Proportional Constant For use by Waters service technicians only.

Integral Constant For use by Waters service technicians only.

Output Max For use by Waters service technicians only.

Derivative Constant For use by Waters service technicians only.
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Table 5–9: ABPR threshold and usage settings (continued)

Setting or control Purpose

Desired needle count
value/Set Needle
Count

Opens the pressure valve to depressurize the system, or closes
the valve if it is open. The software can automatically open the
valve to a maximum needle count of 3000. To fully open the valve
and depressurize the system, you can manually set a needle
count of 6000. A needle count of 0 fully closes the valve. The
ABPR can be either in the "on" or "off" position. "On" indicates
that the ABPR is controlling the set pressure, and "off" indicates
that the ABPR is not automatically controlling the set pressure.
Change the needle position when the ABPR is not automatically
controlling the back pressure.

Rationale: The system uses this value to calculate the position
of the needle valve.

Rule: The ABPR must be idle before you can use this control to
open or close the needle valve.

Apply Saves all new control settings and needle count value changes.

5.2.7 Specifying settings or viewing device status for the vessel
switcher
For systems equipped with the automation module, the Vessel Switcher configuration subpanel
provides four additional heater zones for controlling or monitoring auxiliary heating devices. It also
includes controls for specifying the duration of the extraction vessels' equilibration, and if the
system includes a CO2 recycler, the extended vessel fill time and max pressure of the automated
CO2 recycler.

Notes: 

• While using the automated vessel switcher, when a method is extracting from one vessel and
about to switch to the next vessel, ensure that the cap is on the next vessel. Do not open the
cap of a vessel while the system is extracting from that vessel or about to switch to that
vessel.

• Lower the pressure on a system equipped with an automation module to 10,000 kPa (100 bar,
1450 psi), so that when equilibration occurs, the pressure is not exceptionally high and the frit
on the extraction vessel cap is not damaged.

To specify settings or to view device status for the vessel switcher:

1. In the Folder View panel, click the Device Configuration node to open the Device
Configuration panel.

2. Click Vessel Switcher to open the Vessel Switcher configuration subpanel.
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Alternative: In place of steps 1 and 2, in the Status Control Vessel Switcher subpanel's
options menu, click Configure to open the Vessel Switcher configuration subpanel.

3. Identify the zones used to control and monitor any auxiliary heating devices configured for
the system.

4. For each assigned zone, verify that it is enabled, view its current temperature, and verify its
maximum temperature and alarm set point referring to this table:

Table 5–10: Example Vessel Switcher heater controller settings - Zone 1

Setting or
control

Purpose

Enabled Select the Enabled check box to use the zone's settings to control
and monitor the specified heating device, or clear the check box to
disable the zone.

Zone Name Specifies the name given to the zone (for example, Zone 1). Zone 1
could also identify a name that indicates the controller and the heater
device it controls or monitors.

See also: Role

Max Temperature Specifies the maximum temperature set point a user can specify for
the zone.

Max Temperature
Alarm

Specifies the temperature threshold above which the software's
overtemperature control function issues an alarm and shuts down the
heater.

Proportional
Constant

For use by Waters service technicians only.

Integral Constant For use by Waters service technicians only.

Derivative
Constant

For use by Waters service technicians only.

Role Assigns the zone to a particular device.

Important: Usually, an administrator uses this setting for
troubleshooting or adding a new heating device to the system. If you
change the role setting, you must also reconfigure the thermocouple
and control cabling between the heater controller module and the
heater device identified in the changed role.

Warning: To avoid electric shock, always disconnect the
system from the ac power supply before connecting or
disconnecting external cables.
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Table 5–10: Example Vessel Switcher heater controller settings - Zone 1 (continued)

Setting or
control

Purpose

Set Max
Pressure (bar)

If the system is configured with a CO2 recycler, specify the pressure
set point at which the CO2 recycler starts venting.

Note: High CO2 recycler pressure increases the risk of sample
carryover to the recycler. Setting the pressure to 6000 kPa (60 bar,
870 psi) releases pressure on the recycler if the room temperature
gets too hot, reducing the risk of sample carryover.

Current Pressure
(bar)

Displays the current pressure of the CO2 recycler.

5. For Set Vessel Equilibration Time, specify the duration in minutes for the pressure to
equalize between extraction vessels during a run when the equilibration setting is specified
as the method's Extraction Vessel parameter.

Tips: 

• For larger-volume vessels, specify a duration of three minutes to allow sufficient time
for the CO2 to siphon into the alternative, unpressurized extraction vessel.

• When the automation module is set to equilibration mode in the method, both vessels
are disconnected from the system and connected in a series in order to empty one
vessel into another.

6. If the system is configured with a CO2 recycler for Set Extended Fill Time, optionally
specify the duration in minutes for the automated recycler to continue filling after the
second-level switch is triggered. The filling stops when this duration expires.

7. Click Apply to save the vessel-switcher settings.

5.3 Methods for controlling system functions
In the method, you specify and save the settings that control the rate and composition of the
extracting solvent, system pressure, vessel temperatures, extraction durations, and other
important run conditions. Later, you can edit the method, as needed, load it into a queue, and run
it to perform extractions, maintenance, or troubleshooting tasks.

Observe these guidelines when creating and managing your project's methods:

• You create, view, and edit methods using the method editor.

• You can create and save methods for controlling system functions used for maintenance or
troubleshooting. For example, you can create methods for cleaning the system and for
powering it down.
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• While observing a run, from the Status Control panel, you can override the settings for the
method currently in progress. You can also save the new settings by renaming the method
and clicking Save.

• Use the method settings in concert with those specified in the System Settings panel to
protect system components from unsafe conditions, such as excessive pressure drop or
vessel overtemperature.

Tips for working with methods:

• You can hide and later redisplay optional columns in the method table as needed for your
application. For Prep SFE systems, these optional columns include:

• Sample Name

• Extraction Vessel 2 Temperature

• Co-Solvent Flow

• Dynamic Duration 2

• Static Duration

• Collection Vessel Temperature 2

• Cycles To Execute

• Report Template and Report Print Options

Note: If you hide a column that contains settings, and then add the method to the queue, a
message appears stating that these settings are ignored during the run. Later, if you edit the
method and redisplay the column, the settings for the column reappear and are available
when the method is next run.

• When creating multiple step extractions, you can use the first row in the method to
automatically fill multiple rows. You can also use a particular cell to "fill down" the column in
multiple rows.

When following the instructions in this section, always observe Good Laboratory Practice (GLP)
guidelines and your laboratory's standard operating procedures.

5.3.1 Viewing or editing a method
You view or edit a method using the method editor.

To view or edit a method:

1. In the Folder View panel for the project, click the Method Files node to display the
currently stored methods in the File View panel.

2. From the list of available methods, click the method file to open it in the method editor.

3. If you are modifying the method, make any necessary changes, and click Save.
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Result: The method file is saved to a new version, and the previous version of the
method is archived.

5.3.2 Creating a method for running extractions
You can create and save as many methods as necessary for controlling the conditions used to
operate single-step or multi-step extraction runs. Once saved, the methods are stored in your 
Project folder under the Method Files node.

To create a new method and configure its parameters:

1. In the Folder View panel for the project, right-click the Method Files node and select Add
new method.

Alternative: From the File menu, click Create new project files > project name > 
Create Method File.

2. On the New Method tab, type a name for the method.

3. Specify the name of the data-log file created when the extraction step runs. You can
specify a data-file name or select one from a list of available naming options.

Result: After each step in the running method, a data-log file is created in the Data
Files subfolder.

4. Specify the required settings for the first row or Step 1 of the method, referring to the table
below.

5. Click the next row and specify the required settings for the next step of the method.

6. Repeat step 5, as necessary, for any additional, required steps.

Tip: When creating multiple step extractions, you can use an existing row or cell in the
method to automatically fill additional rows or cells with the same settings. To create
duplicate rows, right-click on the first column in the row that you want duplicated and use
the Copy Row(s) or Insert Row(s) functions to fill the new rows with the previously
specified settings. You can also right-click in a particular cell and use the Set Fill Value
function to "fill down" the column for a specified number of rows.

7. After you specify the settings for each step or row that you require, click Save to save your
method.

Tip: You can view the total amount of time, in minutes, for the running method in the Total
Duration box.
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Table 5–11: Method settings

Setting Purpose

Co-Solvent Flow1 The flow rate for co-solvent flow, in mL/min

Range: For the P-50 pump: 1 to 50 mL/min is allowed, 5 to 50
mL/min is recommended for proper pump function. For no flow, type
0.00.

CO2 Flow The flow rate for CO2 flow, in g/min

Ranges: For the P-200 pump: 3 to 200 g/min is allowed, 20 to 200
g/min is recommended for proper pump function. For no flow, type
0.00.

Extraction Vessel For systems equipped with manual extraction-vessel switching
valves, provides these selections:

• Extraction 1 – Specifies manually setting the MV2 and MV1
valves to extraction vessel 1 for this method step.

• Extraction 2 – Specifies manually setting the MV2 and MV1
valves to extraction vessel 2 for this method step.

For systems equipped with automation, provides these selections:

• Extraction 1 – Sets the valves to extraction vessel 1.

• Extraction 2 – Sets the valves to extraction vessel 2.

• Equilibration – Equalizes the pressures between extraction
vessel 1 and extraction vessel 2. Typically, you use this setting
as a transitional step to reclaim CO2 and increase throughput by
directing the system to siphon the CO2 from the pressurized
vessel into the unpressurized alternative vessel before it
switches to the alternative vessel in the next step.

Note: You specify the duration for equilibration on the Vessel
Switcher configuration subpanel located under the Device
Configuration node.

• Series 1 to 2 – Connects the outflow of extraction vessel 1 to the
inflow of extraction vessel 2.

• Series 2 to 1 – Connects the outflow of extraction vessel 2 to the
inflow of extraction vessel 1.

Note: Series configurations are limited to configurations with 5-L
extraction vessels equipped with the series configuration kit.
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Table 5–11: Method settings (continued)

Setting Purpose

Extraction Vessel 1
Temperature and
Extraction Vessel 2
Temperature1

The temperature set points for the first and second extraction
vessels.

Note: If the system configuration does not include a second
extraction vessel, the temperature setting for extraction vessel 2 is
inactive.

Range: Ambient to 90 °C: a setting of 0 affords no temperature
control.

Cyclone Vessel 1
Temperature,
Cyclone Vessel 2
Temperature1, and
Cyclone Vessel 3
Temperature1

The temperature set points for the first, second, and third cyclone
separators (CS1, CS2, and CS3).

Note: If the system configuration does not include a second or third
cyclone separator, the temperature settings for CS2 and CS3 are
inactive.

Range: Ambient to 90 °C: a setting of 0 affords no temperature
control.

Tip: Cyclone Vessel 2 Temperature and Cyclone Vessel 3
Temperature are optional columns you can hide by right-clicking the
header and selecting Hide. To redisplay the column, right-click in
any column's field and select Show and the title of the hidden
column.

Inline Heater
Temperature

The temperature set point for the heat exchanger, which heats the
extracting solvent to the temperature specified in the sample list.
The extracting solvent comprises the combined CO2 and co-solvent
flows.

Important: This setting is critical for maintaining the temperature
of the extracting solvent. It is typically set approximately 5 to 10 °C
warmer than the desired extraction temperature.

Inline Collection
Heater
Temperature

The temperature set point for the heat exchanger, which heats the
sample flowing from cyclone separator 2 (CS2) to cyclone separator
3 (CS3), to keep the sample in a gas phase and ensure that there is
no carryover to the CO 2 recycler.
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Table 5–11: Method settings (continued)

Setting Purpose

Extraction Pressure The system-pressure set point.

Range: 0 to 40,000 kPa (0 to 400 bar, 0 to 5802 psi): a setting of 0
affords no pressure control beyond the inlet CO2 pressure.

Tips: 

• The Extraction Pressure setting is critical for maintaining the
system pressure throughout the extraction flow path.

• Pressure is the primary factor affecting extractions and is a
useful technique for fine-tuning them. It changes the solvating
power of the supercritical CO2.

• Use care when specifying depressurization settings. Reduce
pressure in a controlled manner. If the depressurization step is
too steep, temperature-sensitive sample can be cold-stressed
and valuable analyte lost.

• In the Start/Shutdown subpanel under System Settings, specify
the maximum allowed pressure drop to control the amount of
pressure an extraction vessel can sustain before the system
shuts down automatically.

Dynamic Duration 1 The duration, in minutes, for exposing the sample to the flow and
pressure conditions defined for this extraction run. Specify this
value in concert with values assigned the Static Duration and
Cycles to Execute parameters.

Static Duration1 The duration, in minutes, for restricting the flow from the vessel,
exposing the sample to the pressure condition defined only for this
extraction step. Specify this value in concert with values assigned
the Dynamic Duration and Cycles to Execute parameters.

Recommendation: Static duration is not recommended when
performing bio-botanical extractions.

Note: When the static duration is in effect, the reported device
status for the CO2 pump is Running in pressure control.
When the static duration expires, the pump status reverts to 
Running in flow control.

Important: For systems equipped with manual extraction-valve
switching, during the run, at the start of the static duration period,
ChromScope prompts you to close the MV1 outlet valve stem for
the extraction vessel undergoing static duration. Likewise, when the
static-duration timer expires, it prompts you to reopen the valve.
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Table 5–11: Method settings (continued)

Setting Purpose

Dynamic Duration
21

The second duration, in minutes, for exposing the sample to the
flow and pressure conditions defined for this extraction step. Specify
this value in concert with the Static Duration and Cycles to Execute
parameters.

Cycles to Execute1 The number of cycles for dynamic and static durations for this
extraction step.

Sample Name1 Specifies a name to record for the sample.

Report Template
and Report
Template Print
Options1

Provides information for reporting.

Export Data File
To1

Provides information for exporting the data-log file.

User Notes1 Provides your comments for the method.
1 This is an optional column you can hide by right-clicking the header and selecting Hide.
To redisplay the column, right-click in any table row and select Show and the title of the
hidden column.

5.3.3 Exporting a method
You can export a method from one project to another.

To export a method:

1. In the Folder View panel for the source project, right-click the Method Files node and
select Export To.

2. Select the destination project from the list.

Result: The method appears in the new project location.
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6 Extraction runs and fraction
collection

6.1 System startup and extraction workflow
To start the system, perform an extraction run, and collect fractions, use these procedures in
conjunction with Good Laboratory Practice (GLP) guidelines and your laboratory's standard
operating procedures:

• Start the chillers for the CO2 pump and recycler, and ensure that the cooling flows are
circulating.

• Verify that the CO2 and co-solvent supply sources are ready.

• Apply power to the system components, including the heaters, chillers, pumps, and the
automated back-pressure regulator.

• Prime the co-solvent pump.

• Start ChromScope software and log in.

• Prepare the extraction vessels and sample.

• Load the extraction vessels with sample.

• Load an extraction sample list for the run and start the method.

• Set the manual back-pressure regulators to the method conditions.

• Monitor the system and module status for the extraction run.

• Collect fractions, starting with the cyclone separator having the highest pressure, and then
proceed sequentially with the next highest-pressure separator.

6.2 Starting the chillers for the CO₂ pump and recycler
The chillers, and their associated cooling baths for the optional CO2 pump and recycler, are
required to cool and liquefy the CO2 before it enters the recycling vessel, and also during
pumping.

Requirement: Before operating the chillers, inspect the level of coolant in the cooling bath, to
ensure that it is adequate. Refer to the chiller's operation manual for an explanation about how to
set up the chiller.
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Important: For best performance, and in order to maintain the chiller manufacturer's factory
warranty, use the coolant fluid recommended by the chiller manufacturer.

Warning: To avoid serious injury or death, do not ingest ethylene glycol, which is toxic
even in small amounts. Instead of ethylene glycol, use propylene glycol/water 1:1 as the
coolant in cooling baths. For specific warnings, consult the operator's manual for the
chiller or the Material Safety and Data sheet for the coolant.

Notice: To avoid damaging the chiller, do not use automotive antifreeze as the cooling
agent.

To start the chillers and verify their operation:

1. Power-on each of the chillers and set their operating temperatures as follows:

• Pump chiller: 3 °C

• Recycler chiller: 11 °C

2. Verify that the coolant is flowing through each of the chiller's associated cooling baths.

3. Inspect the cooling-tubing connections for leaks.

4. Monitor the chillers via their front-panel display to ensure that they reach the temperature
set point and stabilize for at least 30 minutes before starting a run.

6.3 Verifying that the CO₂ supply is ready
Before you start the system for running an extraction, verify that the CO2 supply is sufficient for
system equilibration and run-time operation.

Recommendation: To ensure that the system is performing properly, maintain a log of the
inlet CO2 temperature and pressure, along with the pump RPMs for a given flow rate.

Tips: 

• A standard CO2 tank filled to capacity contains approximately 33 lbs (15 kg) of usable CO2.

• A system with dual, 5-L extraction vessels, without a CO2 recycler, uses approximately one
full CO2 tank every 90 minutes of operation.

• A system with 5-L extraction vessels, with a CO2 recycler, uses approximately one full CO2

tank every 630 minutes of operation.

Warning: To avoid serious injury, including asphyxiation, that can result from
disconnecting a pressurized CO2 line, before disconnecting the line from the CO2

source, stop the flow of CO2 from the system, and shut the valve at the CO2 supply.
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To verify that the CO2 supply is ready:

1. If you are using CO2 tanks without a CO2 recycler, ensure that at least two additional full
tanks are available for use, to ensure sufficient capacity for system equilibration and run-
time operation.

2. If you are using the optional CO2 recycler, ensure that the level sensor is powered-on, and
that the recycler pressure and temperature readings are normal.

3. If you are using a manual recycler, and if the recycler CO2 level is below the low-level
indicator, open the CO2 supply valve to add CO2 to the level of the low-level indicator.

Important: For manual recycler systems, do not fill the recycler level above the low-level
indicator.

See also: The CO2 Recycler Overview and Maintenance Guide.

6.4 Starting system modules and components
Ensure that the heater controllers, pumps, ABPR, and all other modules and components are
powered-on before you start the ChromScope software.

To start system modules and components:

1. Power-on the individual units by actuating the power switch on the rear panel of each.

2. Power-on the PC workstation.

6.4.1 Configuring the in-line collection heater
Version 2.0 and later Bio-Botanical Extraction Systems are shipped with the in-line collection
heater enabled. For earlier versions, configure the heater system as described below.

To configure the in-line collection heater:

1. In the Folder View panel, click Device Configuration > Heater Controller 2.

2. Click the Zone 5 tab (or the Zone configured for the Inline Heater role) .

3. Select the Enabled check box.

4. Click Apply.

6.4.2 Configuring the automated back-pressure regulator
The automated back-pressure regulator (ABPR) is a needle valve that creates the pressure for
supercritical CO2.
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To configure the automated back-pressure regulator:

1. In the Folder View panel, click Device Configuration > ABPR.

2. Set the Control Settings Valve Heater Set Point to 45 °C.

3. Click Apply.

Notes: 

• The current needle position displays whenever the ABPR is pressurizing the extraction
vessel or releasing material to the collection vessels.

• When the needle count is 0, the ABPR is closed and pressurizing the extraction vessel.

• When the needle count is between 300 and 1000, the ABPR is releasing material to the
cyclone separators.

• The software can automatically open the valve to a maximum needle count of 3000.

• To fully open the valve and depressurize the system, you can manually set a needle
count of 6000.

6.4.3 Configuring the extraction vessel switcher
Note: Vessel switcher configuration is only required for systems with an automation module, with
or without the automated CO2 recycler.

To configure the extraction vessel switcher:

1. In the Folder View panel, click Device Configuration > Vessel Switcher.

2. Ensure that the Set Vessel Equilibration Time is 3 minutes.

3. For systems with the automated CO2 recycler, change the Set Max Pressure from 7000
kPa (70 bar, 1015 psi) to 6000 kPa (60 bar, 870 psi).

Note: High CO2 recycler pressure increases the risk of sample carryover to the recycler.
Setting the pressure to 6000 kPa (60 bar, 870 psi) releases pressure on the recycler if the
room temperature gets too hot, reducing the risk of sample carryover.

4. Click Apply.

6.5 Priming the high-pressure, co-solvent pump
To properly operate a system equipped with the optional co-solvent pump, you must prime the
pump during initial system start-up, and whenever you change solvents or replace a solvent
reservoir.
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To prime the pump:

1. In the software, stop the operation of the co-solvent pump.

2. Place the solvent reservoir from which you are drawing solvent at the same level as the
pump or higher.

3. Ensure that the weighted solvent-filter inlet line is fully submerged in the solvent reservoir.

4. Place a waste receptacle beneath the priming-valve outlet to collect the solvent.

Figure 6–1: Location of MV4 valve on module cart

Location of MV4 valve

Figure 6–2: Priming the co-solvent pump using the MV4 valve

MV4

PRIM
E

5. Close the MV4 system valve (located on the right-hand side of the valve in the figure
above), which directs flow to the system.

6. Slowly open the MV4 Prime valve, which directs flow to the priming outlet.

Tip: Open the priming valve slowly. Any pressure remaining in the system escapes
through the valve.
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7. Start solvent flowing, observe the flow until a steady stream exits the outlet of the priming
valve, and then stop the pump operation.

Notice: To avoid the risk of a high-pressure burst of the co-solvent pump's
rupture disc, always leave one side open on the MV4 valve. Operating the pump
with both sides of the MV4 valve closed will cause the rupture disc to immediately
burst.

8. To complete the priming operation, close the MV4 Prime valve, which closes the flow path
to the priming valve, and open the MV4 system valve, which opens the flow path to the
system.

6.6 Starting the ChromScope software and setting initial
conditions
After all of the system modules and components are powered-on, you can start ChromScope,
and log on to set initial conditions and monitor components.

Requirement: You must wait at least 30 seconds after powering-on all of the system modules
and components before you start the ChromScope software. Doing so is necessary for the
components to communicate properly with the software during startup.

6.7 Preparing for a botanical extraction in a system with
manual valves
Setting up for a botanical extraction in a system with manual valves involves these steps:

1. Verifying the room conditions.

2. Verifying the CO2 tank conditions.

3. Verifying the CO2 recycler level and settings.

4. Preparing the extraction vessel.

5. Preparing the sample.

6. Loading the sample.

7. Setting the extraction valves in the proper position.

8. Verifying that the cyclone separator valves are closed.

6.7.1 Verifying the system operating environment
To ensure that the system functions properly, you must first verify the environmental conditions of
the room where the system is operating.
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To verify the system operating environment:

1. Ensure that the room temperature is between 18 and 24 °C.

Important: Thermal variations in excess of 2 °C per 1.5 hours can adversely affect
system performance.

2. Inspect the CO2 monitor and ensure that it displays <1000 ppm.

Notes: 

• The typical concentration of CO2 in occupied indoor spaces is 350 to 1000 ppm.

• CO2 concentrations in occupied indoor spaces in the range of 1000 to 2000 ppm will
cause drowsiness and elicit complaints of poor air quality.

Warning: To avoid serious injury or death from CO2 vapors, ensure that the
room containing the system is well ventilated. The ventilation system must
provide an air exchange rate of four rooms per hour.

3. Ensure that the ventilation system is functioning.

4. Ensure that each system module is powered on.

6.7.2 Verifying the CO₂ tank conditions

To verify the CO2 tank conditions:

1. Ensure that the CO2 tank pressure is greater than 5861 kPa (59 bar, 850 psi).

2. Ensure that the CO2 tank is equipped with a dip tube.

3. Ensure that the CO2 tank is equilibrated at room temperature for approximately 8 hours.

4. If the CO2 tank was stored outdoors in cool weather, wrap a gas cylinder heater to raise
the tank pressure to greater than 5861 kPa (59 bar, 850 psi).

Tip: Tanks stored in sunlight will have high pressure and may not deliver adequate liquid
CO2 to the CO2 recycler.

6.7.3 Verifying the manual CO₂ recycler level and settings

To verify the manual CO2 recycler level and settings:

1. Partially open the manual CO2 supply valve to refill CO2 to the recycler.

Tip: To prevent freezing, do not completely open the CO2 supply valve.
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Figure 6–3: Manual CO2 supply valve

1

Manual CO2 supply valve handle

2. Check the level-sensor module. If the "Low-Low" LED is illuminated, add CO2 to the
recycler.

Figure 6–4: Level-sensor module

"Low-Low" LED

3. Ensure that the "Low" LED on the level-sensor module is illuminated.

Tip: If the "High" or "High-High" LED on the level-sensor module is illuminated, use the
recycler's manual drain valve to vent CO2 until the "Low" LED is illuminated.
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Figure 6–5: CO2 recycler manual drain valve

1

Drain valve handle

Drain port

4. Set the CO2 recycler recirculation valve to the operate (horizontal) position.

Figure 6–6: Manual CO2 recycler recirculation valve handle

Recirculation valve handle (vertical position shown)

5. Verify that the pressure gauge on the CO2 recycler displays 4826 to 4999 kPa (48 to 50
bar, 700 to 725 psi). If the pressure is not in this range, do one of the following:
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• If the pressure is less than 4826 kPa (48 bar, 700 psi), increase the CO2 recycler chiller
temperature.

• If the pressure is greater than 4999 kPa (50 bar, 725 psi), decrease the CO2 recycler
chiller temperature.

Tip: Adjust the CO2 recycler chiller temperature in 0.5 °C increments, waiting 15 minutes
between adjustments.

6.7.4 Preparing the extraction vessel

Required tools and materials

• Food-grade ethanol

• Shop vacuum

• Steel-toed shoes

• Ultrasonic bath

To prepare the extraction vessel:

1. Ensure that the extraction vessel being loaded has cooled to a safe handling temperature.

2. If the vessel is connected to the system, ensure that the pumps and ABPR are switched
off, and that the vessel is switched out of the system flow path.

3. Depressurize the extraction vessel to at least the pressure of cyclone separator 1 (CS1).

4. Gradually open the MV6 exhaust valve to drain the CO2 from the extraction vessel.

Tip: The MV6 exhaust valve is located on the left, backside of the extraction vessel.

Important: For safety, this valve must be exhausted to an outside vent.

Figure 6–7: Location of MV6 valve on back side of extraction vessel

Location of MV6 valve
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5. After draining the CO2 from the extraction vessel, close the MV6 valve.

6. Confirm that the extraction vessel's pressure gauge displays 0 kPa, (0 bar, 0 psi) to ensure
that all CO2 has been drained from it.

7. Use the quick-disconnect fitting to disconnect the MV1–V1 tubing from the extraction
vessel's cap.

Figure 6–8: Quick-disconnect fitting on extraction vessel

Quick-disconnect fitting

Warning: To avoid a high-pressure release of sample and solvent, or damage
to the vessel's cap, never attempt to force open a vessel cap using a wrench. In
the event that the vessel's pressure-escape vent becomes plugged, the vessel
can remain under pressure indefinitely. If you cannot easily open the vessel's
cap, allow the vessel to depressurize for at least fifteen minutes, and then try
again to remove its cap.

Warning: To avoid hand or foot injury caused by accidently dropping a vessel's
cap, wear steel-toed shoes and use care when handling the cap. Depending on
its size, the cap can weigh as much as 5 kg.

8. Loosen and remove the extraction vessel's cap by turning it counterclockwise.

9. Use the shop vacuum to remove any dry waste from the extraction vessel.

10. If you observe any sludge under the cap, do the following:

a. Remove the frit from the cap by turning it clockwise.
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Figure 6–9: Extraction vessel cap with frit

Frit

Extraction vessel cap

b. Inspect the frit and clean it with 95% food-grade ethanol, if needed.

c. If the frit is damaged, replace it.

d. Inspect the spring in the seal and sonicate it with 95% food-grade ethanol, if
clogged.

Figure 6–10: Extraction vessel cap with frit removed

Spring in seal

Extraction vessel cap

e. If the spring is damaged, replace it.

f. Reinstall the frit on the cap.

11. Repeat the steps above to prepare a second extraction vessel.
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6.7.5 Preparing the sample for extraction

Required tools and materials

• Suitable container for sample material

• Sample material to be extracted

To prepare the sample for extraction:

1. Grind the sample to at least a coffee ground consistency.

2. Dry the sample to a moisture content of 5% to 8% wt/wt.

3. Place the sample material in the container and mix well.

6.7.6 Loading the sample into the extraction vessel

Warning: To avoid burn injuries, exercise care when handling the extraction vessels,
separation cyclones, heat exchanger outlet tubing, or other components heated to high
temperatures or cooled to low temperatures. Wait until the hot components have
sufficiently cooled or the cold components have sufficiently warmed before you handle
them.

Required tools and materials

• Funnel

• Glass marbles

• Plastic or wooden tamping device

• PTFE spray

• Sample material to be extracted

• Soft bristle brush

• Steel-toed shoes

To load the sample into the extraction vessel:

1. Use a funnel to begin loading the extraction vessel with the sample material.

Tip: Load about 1/2 pound (220 grams) of sample material at a time into the extraction
vessel.

2. Use a plastic or wooden tamping device to pack the material firmly into the vessel.

Tip: Pack the material uniformly to prevent channels from forming in the extractor.

When the vessel is full, the packed sample material must reach the level of the fill line
inscribed on the vessel's interior wall.
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Figure 6–11: Extraction vessel fill line

1

Vessel's fill line

Requirement: To achieve proper extraction conditions, the extraction vessels must be
filled to capacity. If you lack sufficient sample material to fill the vessel, you can add an
inert filler, such as glass marbles, to bring the combined volume of sample and filler to the
level of the vessel's fill line.

3. Use a soft bristle brush to clean any sample material from the vessel threads.

4. Place the extraction vessel's cap on the extraction chamber without screwing in the
threads.

5. Lightly lubricate the extraction vessel's cap threads using a PTFE spray lubricant, taking
care not to contact the sample material with the lubricant.

Requirement: Be sure to spray all of the cap threads.

Warning: To avoid hand or foot injury caused by accidently dropping a vessel's
cap, wear steel-toed shoes and use care when handling the cap. Depending on
its size, the cap can weigh as much as 5 kg.

6. Hand-tighten the cap by rotating it clockwise onto the vessel.

7. Use the quick-disconnect fitting to reconnect the MV1–V1 tubing to the cap.

6.7.7 Setting the extraction valves in the correct position

To set the extraction valves in the correct position:

1. Completely open the MV2-V1 valve, and then close the MV2-V2 valve.

Tip: The MV2-V1 and MV2-V2 valves are located on the middle shelf.
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Figure 6–12: Location of MV1 and MV2 valves on module cart

Location of MV1-V1 and MV1-V2 valves

Location of MV2-V1 and MV2-V2 valves

2. Completely open the MV1-V1 valve, and then close the MV1-V2 valve.

Tip: The MV1-V1 and MV1-V2 valves are located on the top shelf.

6.7.8 Verifying that the cyclone separator drain valves are closed

To verify that the cyclone separator drain valves are closed:

1. Locate the cyclone separator drain valves at the bottom of each cyclone separator vessel.

Figure 6–13: Cyclone separator drain valves
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CS1 drain valve

CS2 drain valve

CS3 drain valve

2. Ensure that the cyclone separator drain valve handles (MV8, MV9, and MV10) are closed.

6.8 Preparing for a botanical extraction in a system with an
automation module
Setting up for a botanical extraction in a system with an automation module involves these steps:

1. Verifying the room conditions.

2. Verifying the CO2 tank conditions.

3. Verifying the CO2 recycler level and settings.

4. Preparing the extraction vessel.

5. Preparing the sample.

6. Loading the sample.

7. Verifying that the cyclone separator valves are closed.

6.8.1 Verifying the system operating environment
To ensure that the system functions properly, you must first verify the environmental conditions of
the room where the system is operating.

To verify the system operating environment:

1. Ensure that the room temperature is between 18 and 24 °C.

Important: Thermal variations in excess of 2 °C per 1.5 hours can adversely affect
system performance.

2. Inspect the CO2 monitor and ensure that it displays <1000 ppm.

Notes: 

• The typical concentration of CO2 in occupied indoor spaces is 350 to 1000 ppm.

• CO2 concentrations in occupied indoor spaces in the range of 1000 to 2000 ppm will
cause drowsiness and elicit complaints of poor air quality.
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Warning: To avoid serious injury or death from CO2 vapors, ensure that the
room containing the system is well ventilated. The ventilation system must
provide an air exchange rate of four rooms per hour.

3. Ensure that the ventilation system is functioning.

4. Ensure that each system module is powered on.

6.8.2 Verifying the CO₂ tank conditions

To verify the CO2 tank conditions:

1. Ensure that the CO2 tank pressure is greater than 5861 kPa (59 bar, 850 psi).

2. Ensure that the CO2 tank is equipped with a dip tube.

3. Ensure that the CO2 tank is equilibrated at room temperature for approximately 8 hours.

4. If the CO2 tank was stored outdoors in cool weather, wrap a gas cylinder heater to raise
the tank pressure to greater than 5861 kPa (59 bar, 850 psi).

Tip: Tanks stored in sunlight will have high pressure and may not deliver adequate liquid
CO2 to the CO2 recycler.

6.8.3 Verifying the automated CO₂ recycler level and settings

To verify the automated CO2 recycler level and settings:

1. Ensure that the CO2 recycler indicator displays "Low".

Figure 6–14: Automated CO2 recycler indicator

"Low" LED

2. Set the CO2 recycler recirculation valve to the operate (horizontal) position.
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Figure 6–15: Automated CO2 recycler recirculation valve handle

Recirculation valve handle (vertical position shown)

3. Verify that the pressure gauge on the CO2 recycler displays 4826 to 4999 kPa (48 to 50
bar, 700 to 725 psi). If the pressure is not in this range, do one of the following:

• If the pressure is less than 4826 kPa (48 bar, 700 psi), increase the CO2 recycler chiller
temperature.

• If the pressure is greater than 4999 kPa (50 bar, 725 psi), decrease the CO2 recycler
chiller temperature.

Tip: Adjust the CO2 recycler chiller temperature in 0.5 °C increments, waiting 15 minutes
between adjustments.

6.8.4 Preparing the extraction vessel

Required tools and materials

• Food-grade ethanol

• Shop vacuum

• Steel-toed shoes

• Ultrasonic bath

To prepare the extraction vessel:

1. Ensure that the extraction vessel being loaded has cooled to a safe handling temperature.

2. If the vessel is connected to the system, ensure that the pumps and ABPR are switched
off, and that the vessel is switched out of the system flow path.

3. Depressurize the extraction vessel to at least the pressure of cyclone separator 1 (CS1).

4. Gradually open the MV6 exhaust valve to drain the CO2 from the extraction vessel.
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Tip: The MV6 exhaust valve is located on the left, backside of the extraction vessel.

Important: For safety, this valve must be exhausted to an outside vent.

Figure 6–16: Location of MV6 valve on back side of extraction vessel

Location of MV6 valve

5. After draining the CO2 from the extraction vessel, close the MV6 valve.

6. Confirm that the extraction vessel's pressure gauge displays 0 kPa, (0 bar, 0 psi) to ensure
that all CO2 has been drained from it.

7. Use the quick-disconnect fitting to disconnect the MV1–V1 tubing from the extraction
vessel's cap.

Figure 6–17: Quick-disconnect fitting on extraction vessel

Quick-disconnect fitting
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Warning: To avoid a high-pressure release of sample and solvent, or damage
to the vessel's cap, never attempt to force open a vessel cap using a wrench. In
the event that the vessel's pressure-escape vent becomes plugged, the vessel
can remain under pressure indefinitely. If you cannot easily open the vessel's
cap, allow the vessel to depressurize for at least fifteen minutes, and then try
again to remove its cap.

Warning: To avoid hand or foot injury caused by accidently dropping a vessel's
cap, wear steel-toed shoes and use care when handling the cap. Depending on
its size, the cap can weigh as much as 5 kg.

8. Loosen and remove the extraction vessel's cap by turning it counterclockwise.

9. Use the shop vacuum to remove any dry waste from the extraction vessel.

10. If you observe any sludge under the cap, do the following:

a. Remove the frit from the cap by turning it clockwise.

Figure 6–18: Extraction vessel cap with frit

Frit

Extraction vessel cap

b. Inspect the frit and clean it with 95% food-grade ethanol, if needed.

c. If the frit is damaged, replace it.

d. Inspect the spring in the seal and sonicate it with 95% food-grade ethanol, if
clogged.
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Figure 6–19: Extraction vessel cap with frit removed

Spring in seal

Extraction vessel cap

e. If the spring is damaged, replace it.

f. Reinstall the frit on the cap.

11. Repeat the steps above to prepare a second extraction vessel.

6.8.5 Preparing the sample for extraction

Required tools and materials

• Suitable container for sample material

• Sample material to be extracted

To prepare the sample for extraction:

1. Grind the sample to at least a coffee ground consistency.

2. Dry the sample to a moisture content of 5% to 8% wt/wt.

3. Place the sample material in the container and mix well.

6.8.6 Loading the sample into the extraction vessel

Warning: To avoid burn injuries, exercise care when handling the extraction vessels,
separation cyclones, heat exchanger outlet tubing, or other components heated to high
temperatures or cooled to low temperatures. Wait until the hot components have
sufficiently cooled or the cold components have sufficiently warmed before you handle
them.
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Required tools and materials

• Funnel

• Glass marbles

• Plastic or wooden tamping device

• PTFE spray

• Sample material to be extracted

• Soft bristle brush

• Steel-toed shoes

To load the sample into the extraction vessel:

1. Use a funnel to begin loading the extraction vessel with the sample material.

Tip: Load about 1/2 pound (220 grams) of sample material at a time into the extraction
vessel.

2. Use a plastic or wooden tamping device to pack the material firmly into the vessel.

Tip: Pack the material uniformly to prevent channels from forming in the extractor.

When the vessel is full, the packed sample material must reach the level of the fill line
inscribed on the vessel's interior wall.

Figure 6–20: Extraction vessel fill line

1

Vessel's fill line

Requirement: To achieve proper extraction conditions, the extraction vessels must be
filled to capacity. If you lack sufficient sample material to fill the vessel, you can add an
inert filler, such as glass marbles, to bring the combined volume of sample and filler to the
level of the vessel's fill line.

3. Use a soft bristle brush to clean any sample material from the vessel threads.
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4. Place the extraction vessel's cap on the extraction chamber without screwing in the
threads.

5. Lightly lubricate the extraction vessel's cap threads using a PTFE spray lubricant, taking
care not to contact the sample material with the lubricant.

Requirement: Be sure to spray all of the cap threads.

Warning: To avoid hand or foot injury caused by accidently dropping a vessel's
cap, wear steel-toed shoes and use care when handling the cap. Depending on
its size, the cap can weigh as much as 5 kg.

6. Hand-tighten the cap by rotating it clockwise onto the vessel.

7. Use the quick-disconnect fitting to reconnect the MV1–V1 tubing to the cap.

6.8.7 Verifying that the cyclone separator drain valves are closed

To verify that the cyclone separator drain valves are closed:

1. Locate the cyclone separator drain valves at the bottom of each cyclone separator vessel.

Figure 6–21: Cyclone separator drain valves

CS1 drain valve

CS2 drain valve

CS3 drain valve

2. Ensure that the cyclone separator drain valve handles (MV8, MV9, and MV10) are closed.
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6.9 Setting the system's manual valve positions for a run
The primary manual valves a system uses to direct flow and manipulate pressure vary according
to the system's configuration. The following diagram identifies all of the manual valves (MV) and
manual back-pressure regulator (MBPR) valves for a fully configured system. Before starting a
run, verify the locations of the system's valves that you must manually operate. Ensure that the
valves are positioned properly, referring to the table "MV and MBPR valve positions".

Note: For systems equipped with automated extraction-valve switching, the valves directing flow
to and from extraction vessels are switched by the software according to which extraction vessel
you select from the Status Control panel, or via a running sample list. These systems have no
MV1 and MV2 valves to adjust.

Figure 6–22: Manual valves and manual back-pressure regulator valves in a fully
configured system

Co-solvent 
pump

CO2 
Pump

Extraction vessel 1

Extraction vessel 2 ABPR

MV1

MBPR3

MBPR2

MBPR1

MV4

MV6

MV7

MV8

MV9

MV10

To vent or 
recycler

Cyclone vessels (1 – 3)

MV2 Note: For system 
configurations with 
extraction vessel 1 
only, MV1 can be a 
single-stem valve.
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Legend:

Main flow path

Alternate main flow path for other system configurations

Configuration-dependent components

Follow these guidelines for operating the system valves:

• All of the system's manual valves open and close in similar fashion. When facing the valve
handle, rotate the handle counterclockwise to open the valve, or clockwise to close the valve.

• For systems with manual extraction-valve switching, the MV2 and MV1 valves direct flow to
and from the extraction vessel used in the run. After loading the vessel with sample, verify
that the MV2 and MV1 valves are positioned properly for the extraction vessel you intend to
use for the run.

• For systems with manual extraction-valve switching that are equipped with the optional kit to
plumb the extraction vessels in series, depending on which vessel is connected as inlet or
outlet to the system, verify that the MV2 and MV1 valves are positioned accordingly.

• If the system is configured with an optional co-solvent pump, the MV4 valve is open to the
system when pumping co-solvent, or closed when no co-solvent is being pumped.

• Each extraction and collection vessel is equipped with a valve at its base to enable draining of
liquids and for depressurizing the vessel. During a run, the drain or pressure-relief valves
(MV6, MV7, MV8, MV9, and MV10) are closed.

• The MBPR valves, (for example MBPR1, MBPR2, and MBPR3) serve to adjust the pressure
in the cyclone separators (CS1, CS2, and CS3). You can adjust them only when the system is
pressurized, as normal, during a run. If the MBPRs are not pre-adjusted to method conditions
before you start a run, open them and adjust them to the prescribed method pressures when
the system pressure has stabilized.

Notice: To avoid bursting the rupture-disc safety device for a cyclone separator, if
the MBPR is not pre-adjusted to method conditions, before starting a run, fully open
the MBPR by rotating its handle counterclockwise.

Table 6–1: MV and MBPR valve positions

Valve Position at start of run Operation during run

MV2 To open inflow to vessel 1: open
MV2–V1; close MV2–V2
To open inflow to vessel 2: open
MV2–V2; close MV2–V1

Remains open in initial position for duration of
run with the designated extraction vessel.
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Table 6–1: MV and MBPR valve positions (continued)

Valve Position at start of run Operation during run

MV1 To open outflow from extraction
vessel 1, open MV1–V1; close MV1–
V2
To open outflow from extraction
vessel 2, open MV1–V2; close MV1–
V1

Remains open in initial position, except for
periods of static duration when you must
close the outflow.
To close outflow from vessel 1 for static
duration: close MV1–V1; leaving MV1–V2
closed.
To close outflow from vessel 2: close MV1–
V2, leaving MV1–V1 closed.
To return to dynamic duration, return the MV1
valve stems to their initial positions.

MV4 Open the right-hand (system) side of
the valve if using the co-solvent
pump to pump co-solvent; otherwise
close the right-hand side of the valve.

Note: If you must prime the co-
solvent pump, see the instructions in
the maintenance section.

Remains in initial system position for duration
of run.

MV6 and
MV7

Close the pressure relief valves for
the extraction vessels designated for
the run

Remains closed for duration of run.

MBPRs Open fully, or leave set to the pre-
adjusted positions for the run's
method conditions

Adjust as needed during the run.

See also: Adjusting the manual back-
pressure regulator valves

Notice: To avoid bursting the
rupture-disc safety device on
cyclone separators, if the system is
fitted with three such vessels, do
not adjust the MBPR1 and MBPR2
valves so that pressure exceeds
34,474 kPa (345 bar, 5000 psi). In
this configuration, both vessels'
rupture disc is rated to burst at
41,369 kPa (414 bar, 6000 psi). You
cannot adjust the MBPR for the last
vessel above 13,790 kPa (138 bar,
2000 psi).

MV8,
MV9, and
MV10

Close the cyclone separator drain
valves

Leave closed until you collect fractions.
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6.10 Setting conditions for system operation
To set extraction-run conditions for flow, temperature, and pressure, and other run parameters, it
is best to save the system settings in a method, and then run the method. For details explaining
how to view and create methods, see the section "Methods for controlling system functions".

Alternatives: 

• With the method queue empty, click Start  to place the powered-on modules in their
running state and to adopt the system default method parameters for flow, pressure, and
temperature.

Tips: 

• The settings for the system default method parameters are those that were changed via
the Status Control panel or those that were in effect when you last used ChromScope.

• This feature is useful for setting the systems's initial running conditions for verification,
equilibration, or performing a basic extraction run with no run-time counter. A data-log file
for the session is generated and stored under the Default Project node.

• From the Status Control panel, manually specify flow, pressure, and temperature settings.

Tips: 

• The practice of manually operating the system is typically reserved for system
equilibration or diagnostic testing.

• When you do this to alter the observed conditions of a currently running method, the
modified settings immediately take effect for the remainder of the run time in the method's
current step.

• During the time when the modified settings are in effect, you can optionally save the new
settings by renaming the method and clicking Save.

• Conversely, if you manually specify flow, pressure, or temperature settings when a
method is not operating the system, upon exiting from ChromScope, the changes are
automatically saved as the new settings for the system default method parameters.

Guidelines: 

• When you click the Current Method under the Current Run panel, if no method is running, a
message stating so appears, prompting you to load a method into the method queue.

• When operating the system via the default method parameters, you can proceed directly to

method control without stopping the system by loading a method and clicking Start  to
run the method. When you do so, a new data-log file is initiated under the method's project
node.

• If no method is running, after you load one or more methods into the queue, to run them, you

must click Start .
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• Before the last method ends and the queue empties, any additional methods that you load
into the queue are automatically run in the order in which they are queued.

• If you add a method to the emptied queue while the system is in a pending-shutdown state

(that is, before the specified period of inactivity expires), you must click Start  to run the
method.

To load a method:

1. In the Folder View panel for your project, click the Method Files node to display the
method files in the File View panel that you want to load in preparation for operating the
system.

2. For each method that you want to load, right-click the method and click Open.

3. In the method editor, click Add to Queue.

Result: The methods appear in the method queue in the order in which you add them,
and they can run sequentially in that order.

Tip: You can use the Up  and Down  buttons in the method queue to reorder the
methods in the queue. To remove a method from the queue, select it and click Remove

.

6.11 Starting and stopping a run
You can start a run or stop one before its specified end. You can also move forward and
backward among functions within the list or method queue and view information about the system
and a current run.

Table 6–2: Acquisition Control panel

Control Function

Start 
Start a currently loaded method, which appears at the top of the
method queue. If the queue is empty, start the system default
method parameters.

Result: The modules are placed in their running state and adopt
the method or system default parameters. A new data-log file is
created.

Pause 
Temporarily halt a running method.

Result: The current method's run-time counter stops. Yet the
current settings for temperature, pressure, and CO2 and co-solvent
flows remain unaltered.
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Table 6–2: Acquisition Control panel (continued)

Control Function

Stop 
Stop the run and immediately halt all system functions.

Result: A currently running method stops. All system functions,
including pumps, heat exchanger, and pressure regulator, are
placed in the idle state.

Restart from beginning Click to restart the current method from the beginning.

Restart the current step Click to restart the current step, or run, in the method.

Skip to the next step Click to skip to the next step, or run, in the method.

Skip to the next method Click to skip to the next method in the queue.

Notes: 

• You can also perform the Acquisition Control panel functions from the toolbar.

• If the icon for the acquisition control function is unavailable, the represented function is
unavailable because of the run state.

The system status indicator in the ChromScope Acquisition Status panel shows the system's
operating state.

Table 6–3: System operation statuses

Indicator System's operating state

Initializing system

Equilibrating devices

Current run is paused

Running

Idle

Stopped
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6.12 Verifying that the system run conditions are equilibrated
You must allow the system flow, pressure, and temperature readings to stabilize, and the system
to equilibrate to these conditions, before you set the manual back-pressure regulators to their
operating positions. The system flow, pressure, and temperature readings are stabilized, and the
system equilibrated, when these events occur:

• The specified CO2 flow, pressure, and temperature set points are achieved.

• The trend plots for flow, pressure, and temperature in the ChromScope Current Run tabbed
view are stable.

• The pressure readings indicated by the extraction vessel's pressure gauge and the ABPR's
pressure-regulator display in the ChromScope System Panel are approximately the same.

See also: Monitoring system and module status

6.13 Adjusting the manual back-pressure regulator valves
While monitoring a run's initial conditions, when the flow, temperature, and pressure of a system
are equilibrated, you must adjust the manual back-pressure regulator (MBPR) valves to begin
precipitating the extracted compounds out of solution and into the cyclone separators.

Notice: To avoid bursting the rupture-disc safety device for the cyclone separators,
before adjusting the MBPR valves, ensure that the system flow, temperature, and
pressure conditions have equilibrated at their specified set points.

Figure 6–23: Adjusting the MBPR valves
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MBPR1 for CS1

MBPR2 for CS2

MBPR3 for CS3

To adjust the MBPR valves:

Notice: To avoid bursting the rupture-disc safety device on cyclone separators,
if the system is fitted with three such vessels, do not adjust the MBPR1 and
MBPR2 valves so that pressure exceeds 34,474 kPa (345 bar, 5000 psi). In this
configuration, both vessels' rupture disc is rated to burst at 41,369 kPa (414 bar,
6000 psi). You cannot adjust the MBPR for the last vessel above 13,790 kPa
(138 bar, 2000 psi).

1. For MBPR1, associated with the first cyclone separator (CS1), adjust the pressure until the
vessel's gauge reads between 7584 to 30,337 kPa (76 to 303 bar, 1100 to 4400 psi),
according to the application.

Tips: 

• When adjusting an MBPR valve, do so by incrementally turning the valve and waiting
for the pressure to respond to the adjustment before turning the valve again. The valve-
adjustment process requires approximately 20 seconds to complete.

• The final adjustment should be in the positive pressure direction.

• For general reference, the valve is fully open, or fully closed, in nine complete rotations.

• If bleeding pressure from the vessel is necessary, do so by slowly opening the vessel's
drain valve (MV8, MV9, or MV10) until sufficient pressure is relieved.

2. Referring to the table below, repeat the MBPR valve adjustment process for all cycles.

See also: For more information on setting pressures, see the "Best practices" appendix.

Table 6–4: Adjusting the MBPR valves

Cyclone separator MBPR valve Pressure adjustment

CS1 MBPR1 7584 to 15,858 kPa (76 to 159 bar, 1100
to 2300 psi)

CS2 MBPR2 6895 to 12,411 kPa (69 to 124 bar, 1000
to 1800 psi)

CS3 (without CO2 recycler) MBPR3 207 to 689 kPa (2 to 7 bar, 30 to 100 psi)

CS3 (with CO2 recycler) MBPR3 4964 to 5171 kPa (50 to 52 bar, 720 to
750 psi)1
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Table 6–4: Adjusting the MBPR valves (continued)

Cyclone separator MBPR valve Pressure adjustment

1If material carries over into the recycler storage tank, you must then drain the tank and
refill it with fresh CO2.

See also: The CO2 Recycler Overview and Maintenance Guide.

6.14 Monitoring system and module status
When the system is equilibrating or running a method, you can, via the ChromScope Acquisition
Status panel, determine system run status and monitor system performance. Additionally, both
the System Status and Status Control panels provide indicators to monitor and report the real-
time status of components like the CO2 and co-solvent pump's flow rate. The status indicator
within each module icon in the System Status panel shows the represented module's operating
state. The status is "On" when the module is operating during a run, and "Idle" when the module
is powered-on and in the ready state.

These are the system's other operational modes, as indicated by the run status color in the
Acquisition Status panel:

• Green indicates that the loaded method is running.

• Black indicates that a method is not currently running.

• Red (Alarm) indicates that a system module is in an error state, requiring a reset.

• Yellow indicates that a system module is equilibrating or not ready.

The System Messages box in the ChromScope main window provides a running summary of
system events, including system warnings and alarms.

Tips: 

• When you move the pointer over each of the module representations in the System Status
and Status Control panels, the System Messages box displays additional, module-specific
status and parameter details.

• To scroll upward or downward through the status and system messages in the System
Messages box, use the mouse's wheel.

• To halt the auto-scroll of system messages, click inside the System Messages box. You can
then use the mouse's wheel to scroll upward to view earlier messages.

During a run, open the Current Run panel to view real-time plots for temperature, flow, and
pressure.
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6.14.1 Determining the operational status of the co-solvent and the
CO2 pump modules

Status or
control

Indicator location

Power The Power LED is on the lower left-hand side of the module's front panel. When
the module is powered-on and working properly, the Power LED glows steady
green. When the module is powered-off, the Power LED is dark (unlit).

Operating
state

The Enabled LED is on the lower left-hand side of the module's front panel, above
the Power LED. When the module is operating properly, it glows steady green.
The Enabled LED's other operational modes are as follows:

• Flashing green during operation indicates that the module is in an error state
and requires a reset.

• Unlit (black) indicates that the module is idle.

Flow rate
set point

In the Status Control's CO2 and Co-Solvent Pump subpanels, the value of the
setting in the box next to Flow shows the current CO2 and co-solvent flow set
points in mL/min.

Important: From the Status Control panel, you can directly control the pump's
flow rate by changing the value for the Flow set point. If you do this while a
method is controlling the system, and the method has not fully run, any manual
changes you initiate remain in effect only until the method's next step, when the
conditions specified in the method are reinstated.

Current
flow rate

In the System Status Pump icons and Status Control's CO2 Pump and Co-
Solvent Pump subpanels, the Flow indicators report the current CO2 and co-
solvent flow rates, in g/min and mL/min, respectively, in the system.

Flow plot The Current Run Flow plot shows the real-time flow plot for the current run.

Tip: To display the data-point coordinates in an area of a plot, in the toolbar, click 
Data Cursor, and then move the pointer over the plot area to view the data
coordinates. Click Data Cursor again to disable the function.

RPM The RPM indicator in the System Status Pump icon and Status Control's CO2
Pump and Co-Solvent Pump subpanels, report the pump's current operating rate.

Important: When a pump's check valve fails, the pump's efficiency declines,
causing it to run faster to maintain a specified flow rate. A typical flow rate slightly
exceeds a pump's RPM multiplied by a factor of four. If the RPM is significantly
greater than four times the flow reading, than one or more check valves are likely
defective. Other problems possibly responsible for this condition include improper
cooling or circulation of coolant on the inlet, leaking piston seals, and low supply
source.
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Status or
control

Indicator location

Pressure The pump's pressure gauge, on the right-hand side of the module's front panel,
shows the pressure, in bar and PSI units, of the co-solvent or CO2 flow in the
system. Also, in the System Status Pump icon and Status Control's CO2 Pump
and Co-Solvent Pump subpanels, the Pressure indicator shows the current CO2

and co-solvent flow pressure in the system in bars. During operation, the CO2 and
co-solvent pumps work with the ABPR to maintain the flow and system pressure at
the specified back-pressure set point.

Rule: For the pressure readings to be valid, the pump must be operating.

Tip: When working properly, the readings from the pressure gauge and
ChromScope pressure indicators must approximate one another. The readings
can be slightly higher than the system back pressure, owing to the pressure drop
across the extraction vessel.

6.14.2 Determining the operational status of the heater controller
module and its controlled heating devices

Status Indicator location

Heater controller module
power

The Power LED is on the lower right-hand side of the module's front
panel. When the module is powered-on and working properly, the
Power LED glows steady green. When the module is powered off,
the Power LED is dark (unlit).

Heater controller module
operating state

The Enabled LEDs, Z1 through Z6, on the module's front panel glow
steady green when the represented zone is actively controlling its
designated heat-exchanger module. These are the Enabled LED's
other operational modes:

• Flashing green during operation indicates the module is working
to maintain the temperature set point, alternately activating and
deactivating the heat exchanger, as needed.

• Unlit (black) indicates the zone is idle.

Temperature set point
and read back for the
inline heater1

In the Status Control's Inline Heater subpanel, the value of the
setting in the box next to Temperature (C) shows the current
temperature set point, in degrees Celsius, of the extracting solvent
heat exchanger (HE2) that heats the extracting solvent. The box
next to the temperature set point is the read back. This read back
indicator also appears in the Inline Heater icon in the System
Status panel.
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Status Indicator location

Temperature set point
and read back for the
electrical vessel heaters1

In the Status Control's Vessel Heater 1 and Vessel Heater 2
subpanels, the value of the setting in the box next to Temperature
(C) shows the current temperature set point, in degrees Celsius, of
the individual vessel heaters. The box next to the temperature set
point is the read back. This read back indicator also appears in the 
Vessel Heater icon in the System Status panel.

Temperature set point
and read back for the
electrical cyclone heaters1

In the Status Control's Cyclone Heater 1, Cyclone Heater 2, and 
Cyclone Heater 3 subpanels (if configured), the value of the setting
in the box next to Temperature (C) shows the current temperature
set point, in degrees Celsius, of the individual cyclone heaters. The
box next to the temperature set point is the read back. This read
back indicator also appears in the Cyclone Heater icon in the 
System Status panel.

Temperature plot The Current Run Temperature plot shows the real-time temperature
plots for the current run.

Tip: To display the data-point coordinates in an area of a plot, in
the toolbar, click Data Cursor, and then move the pointer over the
plot area to view the data coordinates. Click Data Cursor again to
disable this function.

1

Important: From the Status Control panel, you can directly control the temperature set point
by changing the setting in the Temperature box. If you do this while a method is controlling the
system, and the method has not fully run, any manual changes that you initiate remain in effect
only until the method's next step, at which point the conditions specified in the method are
reinstated.
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6.14.3 Determining the operational status of the vessel switcher and
the automated CO2 recycler

Status Indicator location

Vessel switcher operating
status and control1

For systems equipped with automation, find the current operating
state of the vessel switcher valve configuration in the Status
Control's Vessel Switcher subpanel. This status indication also
appears in the Vessel Switcher icon in the System Status panel. In
the Vessel Switcher subpanel's Select Vessel box, you can change
the vessel switcher valve configuration by choosing any of the
following selections:

• Extraction 1 – Sets the valves to extraction vessel 1.

• Extraction 2 – Sets the valves to extraction vessel 2.

• Vessel Equilibration – Equalizes the pressures in extraction
vessel 1 and extraction vessel 2. You typically use this setting as
a transitional step to reclaim CO2 and increase throughput by
directing the system to siphon the CO2 from the pressurized
vessel into the unpressurized alternative vessel before the
system switches to the alternative vessel in the next step.

Note: You specify the duration for equilibration on the Vessel
Switcher configuration subpanel located under the Device
Configuration node.

• Series: 1 to 2 – Connects the outflow of extraction vessel 1 to
the inflow of extraction vessel 2.

• Series: 2 to 1 – Connects the outflow of extraction vessel 2 to
the inflow of extraction vessel 1.

Note: Series configurations are limited to configurations with 5-liter
extraction vessels equipped with the series configuration kit.
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Status Indicator location

Automated CO2 recycler For systems equipped with the automated CO2 recycler, find the
current pressure, in bars, of the CO2 recycler in the Status Control's 
CO2 Recycler subpanel.

See also: Specifying settings or viewing device status for the
vessel switcher.

Note: 

• If the pressure is less than 4,826 kPa (48 bar, 700 psi), increase
the CO2 recycler chiller temperature.

• If the pressure is greater than 4,999 kPa (50 bar, 725 psi),
decrease the CO2 recycler chiller temperature.

For details and operating instructions, refer to the CO2 Recycler
Overview and Maintenance Guide that accompanies the system.

1

Important: From the Status Control panel, you can control the vessel switcher valve
configuration by changing the selection in the Select Vessel box. If you do this while a method
is controlling the system, and the method has not fully run, any manual changes that you make
remain in effect only until the method's next step, at which point the conditions specified in the
method are reinstated.

6.14.4 Determining the operational status of the ABPR module

Status Indicator location

Power The Power LED is on the left-hand side of the module’s front panel. When the
module is powered-on and working properly, the Power LED glows steady
green. When the module is powered-off, the Power LED is dark (unlit).

Operating
state

The Enabled LED appears on the left-hand side of the module’s front panel,
above the Power LED. When the module is powered-on and working properly,
the Enabled LED glows steady green.
The Enabled LED’s other operational modes are as follows:

• Flashing green during operation indicates that the module is in an error
state and requires a reset.

• Dark (unlit) indicates that the module is idle (no run in progress).
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Status Indicator location

Current
system
pressure

In the System Status ABPR icon and Status Control's ABPR subpanel, the 
Pressure indicator shows the current system pressure measured at the
pressure regulator. During operation, the CO2 and co-solvent pumps work
together with the ABPR to maintain the flow and system pressure at the
specified set points.

Note: The ABPR does not regulate pressure below 6000 kPa (60 bar, 870
psi), the lower end of the system’s operating range, because of the inlet
pressure of the liquid CO2.

Pressure set
point

In the Status Control's ABPR subpanel, the value of the setting in the box next
to Pressure (Bar) shows the pressure regulator’s pressure set point.

Important: From the Status Control's ABPR subpanel, you can directly
control the pressure set point by changing the setting in the Pressure (Bar)
box. If a method is controlling the system and the method has not fully run, any
manual changes you initiate remain in effect only until the method’s next step,
when the conditions specified in the method are reinstated.

Rule: When the system flow and pressure settings are equilibrated, and the
pumps and pressure regulator are operating properly, the current pressure
reading indicators for the ABPR match the setting in the Pressure (Bar) box,
within ±200 kPa (±2 bar, ±29 psi), to account for normal operating fluctuation.

Pressure Drop The Pressure Drop indicator in the Status Control's ABPR subpanel shows the
difference in pressure measured before and after the extraction vessel.

Pressure plot The Current Run Pressure plot shows the real-time pressure plot for the current
run.

Tip: To display the data-point coordinates in an area of a plot, in the toolbar,
click Data Cursor, and then move the pointer over the plot area to view the
data coordinates. Click Data Cursor again to disable this function.

Valve
temperature

In the System Messages box, with the pointer over the System Status ABPR
icon or Status Control's ABPR subpanel, the valve-temperature indicator
reports the temperature, in degrees Celsius, of the ABPR valve.

External
Heater
Temperature

In the System Messages box, with the pointer over the System Status ABPR
icon or Status Control's ABPR subpanel, the External Heater Temperature
indicator reports the temperature, in degrees Celsius, of the optional external
heater, if it is connected to the ABPR. (If an external heater is not connected,
the reported temperature is 0 °C.)
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Status Indicator location

Needle
Position

In the Status Control's ABPR subpanel, the Needle Position indicator for the
ABPR module indicates the extent of the valve's open position. The software
can automatically open the valve to a maximum needle count of 3000. To fully
open the valve and depressurize the system, you can manually set a needle
count of 6000. A needle count of 0 indicates that the ABPR is closed and
pressurizing the extraction vessel.

Tip: To fully open the valve and depressurize the system, when the ABPR is
idle, from the Device Configuration's ABPR subpanel, use the Set Needle
Count setting to manually set a needle count of 6000.

6.15 Collecting fractions

Warning: Observe Good Laboratory Practice (GLP) at all times, particularly when
working with hazardous materials. Consult the Material Safety Data Sheets regarding
the solvents you use. Additionally, consult the safety representative for your
organization regarding its protocols for handling such materials.

 

Warning: To avoid personal contamination with biologically hazardous or toxic compounds,
wear clean, chemical-resistant, powder-free gloves when performing this procedure.

Warning: To avoid eye or facial injury, wear a face shield when performing this
procedure.

Requirement: Wear clean, chemical-resistant, powder-free gloves when performing
this procedure.

Warning: To avoid personal injury caused by contact with splashing extracted
compounds or solvent when collecting fractions, before opening a cyclone separator
drain, ensure that the collection-drain splash guard is in its protective position above the
drain opening and fraction-collection container.

Warning: To avoid injuries caused by shattering glass fragments, do not use
laboratory glassware to collect fractions or waste components. When opening drain
valves, a high-pressure release of solvent or extracted compounds can knock a glass
container out of your hand and cause it to shatter.

Warning: To avoid spills, empty the collection container at regular intervals.

Tip: If your application calls for reducing front-end system pressure before collecting fractions,
for best results, avoid lowering the pressure at too rapid a rate. If you are in the middle of a run,
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lower the automated back-pressure regulator (ABPR) set point incrementally, in 2500 kPa (25
bar, 363 psi) steps, until the desired end-pressure setting is achieved. If you are at the end of a
run, use the automatic depressurization settings to lower the pressure.

Important: During depressurization, the system pressure does not always achieve the specified
end-pressure setting because the ABPR cannot reduce the system pressure below the level
established by the manual back-pressure regulator on cyclone separator 1 (MBPR1). In this
situation, specifying an end-pressure below that set by the MBPR1 has no effect.

Required tools and materials

• Chemical-resistant, powder-free gloves

• Face shield

• Lab coat

• Several non-glass containers appropriately sized for collecting fractions and capable of fitting
beneath the collection-drain splash guard.

To collect fractions:

1. Power off the CO2 pump.

2. If the system includes an optional co-solvent pump, verify that the status for that pump is 0
mL/min, or that the pump switched off.

3. Depressurize the system to less than 6895 kPa (69 bar, 1000 psi) by slowly opening
MBPR1 and MBPR2.

4. Place a collection container under one of the cyclone separator's drain outlets, beneath the
splash guard, and slowly open its drain valve to begin collecting the extracted material.

Tips: 

• If you did not depressurize the system to less than 6895 kPa (69 bar, 1000 psi), you
must begin collecting fractions at CS1, and continue to CS2, and then CS3.

• To avoid a high-pressure release and resultant loss of extracted material, use care
when opening any of the cyclone separator's drain valves. You must release pressure
in the cyclone separators gradually.

• Typically, the material you collect from CS1 is the most resinous or viscous and is only
soluble at high pressures.

• Typically, the material you collect from CS2 is more solid than liquid and is only soluble
at intermediate pressures.

• Typically, the material you collect from CS3 is liquid and is only soluble at low
pressures.

5. When the flow of extracted material exiting the cyclone separator stops, close its drain
valve.
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6. For the next cyclone separator, place a collection container under the separator's drain
outlet, beneath the splash guard, and slowly open its drain valve to begin collecting the
extracted material.

7. When the flow of extracted material exiting the cyclone separator vessel stops, close its
drain valve.

8. For systems equipped with three cyclone separators, place a collection container under the
drain outlet of the next cyclone separator, beneath the splash guard, and slowly open its
drain valve to begin collecting the extracted material; otherwise, skip this step.

9. When the flow of extracted material exiting the cyclone separator stops, close its drain
valve.

10. If you are not preparing the system for a subsequent run, verify that the temperature
settings for the heat exchanger, extraction vessel, and cyclone separators are switched off.

6.16 Preparing for the next extraction run
After an extraction run, you must prepare the system for the next run.

Warning: To avoid burn injuries, exercise care when handling the extraction vessels,
separation cyclones, heat exchanger outlet tubing, or other components heated to high
temperatures or cooled to low temperatures. Wait until the hot components have
sufficiently cooled or the cold components have sufficiently warmed before you handle
them.

Tip: For systems equipped with dual extraction vessels that you are using one at a time, switch
the flow path, to allow cleaning and reloading of the previously used vessel, and to prepare for
the next run using the alternative vessel.

To prepare for the next extraction run:

1. Empty the extraction vessel and its cap for sludge deposits. If you observe sludge
deposits, clean or replace the cap frits (see Emptying and cleaning the extraction vessel).

2. Inspect the view cell. If you observe liquid CO2 or dark material in the view cell lens, clean
the view cell (see Cleaning the view cell).

3. If the view cell required cleaning, after you clean it, check the CO2 recycler for carryover
(see Checking the CO2 recycler for carryover).

4. If you observe carryover from the CO2 recycler, clean or replace the inlet filter (see
Servicing the CO2 inlet filter), and then clean the manual back-pressure regulators (see
Cleaning the manual back-pressure regulators).

5. Verify that the CO2 supply source is sufficient and that the tank pressure is greater than
5,861 kPa (59 bar, 850 psi).
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6. Ensure that the room temperature is 18 to 24 °C.

Important: Thermal variations in excess of 2 °C per 1.5 hours can adversely affect
system performance.

7. If the system is not running, ensure that the recirculation valve on the CO2 recycler is in the
open (vertical) position. When ready to run, turn the recirculation valve to the closed
(horizontal) position.

Note: The "open" recirculation valve position may also be referred to as the Standby
position in other system documents.

Figure 6–24: CO₂ recycler recirculation valve handle in open (vertical) position

Recirculation valve handle in open (vertical) position

Tip: If the CO2 tank is over pressure, turn the recirculation valve back to the open
(vertical) position for one hour.

6.16.1 Emptying and cleaning the extraction vessel
After the extraction vessel is sufficiently cooled and switched out of the system flow, you can
disconnect, empty, and clean it.

Warning: To avoid electric shock,

• ensure that the electrical power to the equipment is interrupted;

• when cleaning the surface of the equipment, apply water to a cloth, and then wipe
the instrument or device. Do not spray or otherwise apply water directly onto any
equipment surface.

Warning: To avoid personal injury, use eye and hand protection during the cleaning
process.
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Warning: To avoid burn injuries, exercise care when handling the extraction vessels,
separation cyclones, heat exchanger outlet tubing, or other components heated to high
temperatures or cooled to low temperatures. Wait until the hot components have
sufficiently cooled or the cold components have sufficiently warmed before you handle
them.

Required tools and materials

• Food-grade ethanol

• Lint-free cloth

• Mild detergent and water

• Plastic scoop or shop vacuum

• PTFE spray

• Soft bristle brush

• Steel-toed shoes

• Extraction vessel cap frit (if replacing)

To disconnect, empty, and clean the extraction vessel:

1. Ensure that the pumps and automated back-pressure regulator (ABPR) are switched off,
and that the extraction vessel has cooled to a safe-handling temperature and is switched
out of the system flow path.

2. Ensure that the extraction vessel's pressure gauge displays 0 kPa, (0 bar, 0 psi). If
necessary, carefully drain any residual pressure from the extraction vessel by slowly
opening its exhaust valve (MV6 or MV7).

Important: For safety, this valve must be exhausted to an outside vent.

Figure 6–25: Location of MV6 or MV7 valve on back side of extraction vessel

Location of MV6 or MV7 valve
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3. Use the quick-disconnect fitting to disconnect the tubing connect to the extraction vessel's
cap.

Figure 6–26: Quick-disconnect fitting on extraction vessel

Quick-disconnect fitting

Warning: To avoid a high-pressure release of sample and solvent, or damage
to the vessel's cap, never attempt to force open a vessel cap using a wrench. In
the event that the vessel's pressure-escape vent becomes plugged, the vessel
can remain under pressure indefinitely. If you cannot easily open the vessel's
cap, allow the vessel to depressurize for at least fifteen minutes, and then try
again to remove its cap.

Warning: To avoid hand or foot injury caused by accidently dropping a vessel's
cap, wear steel-toed shoes and use care when handling the cap. Depending on
its size, the cap can weigh as much as 5 kg.

4. Loosen and remove the extraction vessel's cap by turning it clockwise.

Notice: To avoid damaging the extraction vessel's sealing surface, do not empty
the vessel using a metal implement.

5. Use a plastic scoop or shop vacuum to empty the vessel of any remaining sample material.

Notice: To avoid damaging the vessel's sealing surface, do not scrub the vessel
with steel wool or a wire brush.

6. Optionally, spray the vessel's interior with 95% food-grade ethanol, and then wipe it dry
with a clean, lint-free cloth.

7. Allow the vessel to completely air dry.
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8. If you observe any sludge under the cap, do the following:

a. Remove the frit from the cap by turning it clockwise.

Figure 6–27: Extraction vessel cap with frit

Frit

Extraction vessel cap

b. Clean the frit with 95% food-grade ethanol.

c. If the frit is damaged, replace it.

d. Inspect the spring in the seal and clean it with 95% food-grade ethanol, if needed.

Figure 6–28: Extraction vessel cap with frit removed

Spring in seal

Extraction vessel cap

e. Reinstall the frit on the cap.

9. Use a soft, lint-free cloth to clean the threads of the vessel's cap.
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10. Apply a light coating of PTFE spray to the threads of the cap.

11. Reinstall the cap by hand-tightening it.

12. Use a cloth dampened with a solution of mild detergent and water to clean the vessel's
exterior.

6.16.2 Reducing the CO₂ recycler pressure
High CO2 recycler pressure increases the risk of sample carryover to the recycler.

To reduce the CO2 recycler pressure:

1. In the ChromScope Main window, click Stop to stop the system flow.

2. Set the recirculation valve on the CO2 recycler in the open (vertical) position.

Result: This forces gas pressure from the top portion of the recycler through the recycling
cooling heat exchanger.

Figure 6–29: CO2 recycler recirculation valve handle in open (vertical) position

Recirculation valve handle in Open (vertical) position

3. Change the recycler chiller temperature from 11 °C to 6 °C.

4. Wait until the recycler pressure drops to approximately 4826 kPa (48 bar, 700 psi).

Tip: The pressure drop takes approximately 30 to 90 minutes.

5. Reset the recycler chiller temperature back to the original 11 °C (or the original chiller
conditions).

Tip: 11 °C applies to 19 to 23 °C room temperature conditions.
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6. Set the recirculation valve on the CO2 recycler in the closed (horizontal) position.

7. Resume normal system operations.

6.16.3 Cleaning the view cell
Use the view cell to inspect for carryover from the cyclone separator or view cell to the CO2

recycler. Liquid CO2 or dark material in the view cell lens indicates carryover to the recycler.
Clean the view cell, and then adjust the temperature and pressures on cyclone separator 3 (CS3)
so that only CO2 gas appears in the view cell lens.

Note: Generally, increasing the temperature or decreasing the pressure in CS3 will decrease the
CO2 density, decreasing its solvating power and causing material that was being carried over to
the recycler to precipitate in CS3.

Required tools and materials

• 1-1/2-inch spanner wrench

• 9/16-inch open-end wrench

• Food-grade ethanol (for cleaning a view cell in a system extracting compounds from botanical
products)

• Methanol (for cleaning a view cell in a system extracting compounds from non-botanical
products)

To clean the view cell:

1. Depressurize the system and then wait 15 minutes to dissipate all pressure from the
cyclone separators.

2. Use the 9/16-inch open-end wrench to loosen the two fittings that secure the view cell
assembly to the back-side of the manual back-pressure regulator (MBPR) on CS3, and
then remove the assembly.
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Figure 6–30: View cell installed in system

MBPR3

View cell assembly

Fittings

3. Use the 1-1/2-inch spanner wrench to loosen the view cell lens cover on each side of the
view cell, and remove the covers.

Figure 6–31: Spanner wrench on view cell lens cover

View cell lens cover

Spanner wrench

View cell lens cover

4. Remove both view cell lenses from the view cell and clean them with 95% food-grade
ethanol.
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Figure 6–32: View cell lens and O-ring

Lens

O-ring

5. Inspect the O-rings on each lens and replace them if necessary.

6. Reinstall the lenses and O-rings in the view cell.

7. Screw each lens cover onto the view cell, and then use the 1-1/2-inch spanner wrench to
tighten them.

8. Use the 9/16-inch open-end wrench to reinstall the view cell assembly on the back-side of
MBPR3.

6.16.4 Checking the CO₂ recycler for carryover
Visible liquid CO2 or dark material in the view cell lens indicates carryover to the CO2 recycler.
Clean the view cell, and then check the CO2 recycler for carryover.

To check the CO2 recycler for carryover:

1. Place a paper towel under the CO2 recycler drain port, and then partially open and close its
manual drain valve repeatedly to expel any sample carryover.
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Figure 6–33: CO2 recycler manual drain valve

1

Drain valve handle

Drain port

2. If sludge is visible on the paper towel, perform the Level 1 cleaning procedure (see
Performing the Level 1 cleaning procedure).

6.16.5 Servicing the CO₂ inlet filter
An in-line filter in the CO2 inlet line helps prevent particles from entering the system and
damaging components such as check valves. A clogged filter restricts flow to the pump,
diminishing its performance. Clean or replace the CO2 inlet filter as part of a scheduled
maintenance routine or whenever a clogged filter restricts CO2 flow.

Warning: To avoid serious injury, including asphyxiation, that can result from
disconnecting a pressurized CO2 line, before disconnecting the line from the CO2

source, stop the flow of CO2 from the system, and shut the valve at the CO2 supply.

Required tools and materials

• 3/4-inch open-end wrench

• Food-grade ethanol (if cleaning)

• Ultrasonic bath

• CO2 inlet filter (if replacing)

• CO2 inlet filter seal (if replacing)
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To service the inlet filter:

1. Close the CO2 recycler outlet (isolation) valve.

Figure 6–34: CO2 recycler outlet (isolation) valve

Bottom of CO2 recycler

CO2 recycler outlet (isolation) valve handle

2. On the ChromScope main page, set the CO2 flow to 30 g/min until it shuts down.

Result: This will drain the CO2 from the filter tubing and inlet.

3. Locate the CO2 inlet filter assembly where the CO2 supply connects to the system.

Figure 6–35: CO2 inlet filter assembly

4. Use a 3/4-inch open-end wrench to loosen and remove the cover of the inlet filter.

February 21, 2018, 715004757 Rev. D
Page 114



Figure 6–36: CO2 inlet filter assembly exploded view

Place the 3/4-inch open-end wrench here

Inlet filter cover

Inlet filter

5. Remove the inlet filter from the inlet filter housing, and then do one of the following:

• If the filter is partially blocked, sonicate the filter in 95% food-grade ethanol for 20
minutes, and then reinstall it.

• If the filter is completely blocked, replace the filter, and perform the level 3 cleaning
procedure.

Tip: A partially or completely blocked filter indicates that the CO2 source might be
contaminated with particulate matter.
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6. Replace and tighten the inlet filter cover.

7. Open the valve to the CO2 supply source, and inspect the inlet filter assembly for leaks.

6.17 Shutting down the system after a single extraction
application
Follow this shutdown procedure when completing a single extraction or switching types of
materials for extraction.

See also: For information on extracting material from the second extraction vessel, see
Manually switching to the alternative extraction vessel.

Required tools and materials

• 9/16-inch open-end wrench

• 2-1/4-inch open-end wrench

• Food-grade ethanol

• Heat gun

• Shop vacuum

• Steel-toed shoes

• Soft bristle brush

• Ultrasonic bath

• Wash bottle

Shutting down the system after a single extraction application involves these steps:

1. Preparing the extraction vessel.

2. Cleaning the cyclone separators.

3. Opening the recirculation valve on the CO2 recycler.

6.17.1 Preparing the extraction vessel

Required tools and materials

• Food-grade ethanol

• Shop vacuum

• Steel-toed shoes

• Ultrasonic bath
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To prepare the extraction vessel:

1. Ensure that the extraction vessel being loaded has cooled to a safe handling temperature.

2. If the vessel is connected to the system, ensure that the pumps and ABPR are switched
off, and that the vessel is switched out of the system flow path.

3. Depressurize the extraction vessel to at least the pressure of cyclone separator 1 (CS1).

4. Gradually open the MV6 exhaust valve to drain the CO2 from the extraction vessel.

Tip: The MV6 exhaust valve is located on the left, backside of the extraction vessel.

Important: For safety, this valve must be exhausted to an outside vent.

Figure 6–37: Location of MV6 valve on back side of extraction vessel

Location of MV6 valve

5. After draining the CO2 from the extraction vessel, close the MV6 valve.

6. Confirm that the extraction vessel's pressure gauge displays 0 kPa, (0 bar, 0 psi) to ensure
that all CO2 has been drained from it.

7. Use the quick-disconnect fitting to disconnect the MV1–V1 tubing from the extraction
vessel's cap.

February 21, 2018, 715004757 Rev. D
Page 117



Figure 6–38: Quick-disconnect fitting on extraction vessel

Quick-disconnect fitting

Warning: To avoid a high-pressure release of sample and solvent, or damage
to the vessel's cap, never attempt to force open a vessel cap using a wrench. In
the event that the vessel's pressure-escape vent becomes plugged, the vessel
can remain under pressure indefinitely. If you cannot easily open the vessel's
cap, allow the vessel to depressurize for at least fifteen minutes, and then try
again to remove its cap.

Warning: To avoid hand or foot injury caused by accidently dropping a vessel's
cap, wear steel-toed shoes and use care when handling the cap. Depending on
its size, the cap can weigh as much as 5 kg.

8. Loosen and remove the extraction vessel's cap by turning it counterclockwise.

9. Use the shop vacuum to remove any dry waste from the extraction vessel.

10. If you observe any sludge under the cap, do the following:

a. Remove the frit from the cap by turning it clockwise.
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Figure 6–39: Extraction vessel cap with frit

Frit

Extraction vessel cap

b. Inspect the frit and clean it with 95% food-grade ethanol, if needed.

c. If the frit is damaged, replace it.

d. Inspect the spring in the seal and sonicate it with 95% food-grade ethanol, if
clogged.

Figure 6–40: Extraction vessel cap with frit removed

Spring in seal

Extraction vessel cap

e. If the spring is damaged, replace it.

f. Reinstall the frit on the cap.

11. Repeat the steps above to prepare a second extraction vessel.
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6.17.2 Cleaning the cyclone separators and tubing

Required tools and materials

• 9/16-inch open-end wrench

• Food-grade ethanol

• Heat gun

• 2-1/4-inch open-end wrench

• Soft bristle brush with 3-inches bristles

• Ultrasonic bath (optional)

• Wash bottle

To clean the cyclone separators and tubing:

1. Confirm the system is at atmospheric pressure and that the CO2 pump and co-solvent
pump (if present) are powered-off.

Tip: When the system reaches atmospheric pressure, the pressure reading on cyclone
separator 3 (CS3) is zero.

2. In the ChromScope software, set the temperature of each cyclone separator to 40 °C.

3. Label the tubing and each cyclone separator cap as CS1, CS2, and CS3.

4. Use the 9/16-inch open-end wrench to slowly remove the 1/4-inch tubing that connects
each cyclone separator outlet to its respective manual back-pressure regulator (MBPR)
inlet.
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Figure 6–41: Manual back-pressure regulator inlet, tubing, and cyclone separator
outlet

Manual back-pressure regulator inlet

Tubing

Cyclone separator outlet

5. Use a wash bottle of 95% food-grade ethanol to clean all of the tubing.

Tip: If the tubing is severely clogged, sonicate it with 95% food-grade ethanol.

6. Remove the cyclone separator caps.

Tip: If the cyclone separator cap will not turn, use the 2-1/4-inch open-end wrench to
loosen it.

7. Inspect the O-ring on each cap and replace it if necessary.
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Figure 6–42: Underside of cyclone separator cap and O-ring

O-ring

Underside of cap

8. Clean the underside of each cap with the wash bottle and rag (or paper towels).

9. Squirt 95% food-grade ethanol into the outlet fittings, located on the top of each cyclone
separator cap.

Figure 6–43: Location of outlet fitting on cyclone separator cap

Outlet fitting

10. Close each cyclone separator drain valve.

Note: The ethanol exits out of the tube on the underside of the cap.
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Figure 6–44: Tube on underside of cyclone separator cap

Underside of cap

Tube

11. Place a beaker under each of the cyclone separator drain lines.

12. Squirt approximately 300 mL of 95% food-grade ethanol along the interior walls in each
cyclone separator.

Figure 6–45: Cyclone separator interior wall

Interior wall

13. Scrub the interior walls of each cyclone separator using a soft-bristle brush.
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Soft-bristle brush

Interior wall

14. After approximately 5 to 10 minutes of soaking, open each cyclone separator drain valve.

Tip: If there is wax in the cyclone separator drain valve at the beginning of the cleaning
process, use a heat gun to melt it.

15. When the ethanol begins to drain, continuously squirt 95% food-grade ethanol along the
interior walls of each cyclone separator until it runs clear.

16. Turn off the cyclone separator heaters.

17. Close each cyclone separator drain valve.

Figure 6–46: Cyclone separator drain valves
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CS1 drain valve

CS2 drain valve

CS3 drain valve

18. Reinstall the cyclone separator caps and tubing to their labeled positions.

Requirement: Set all the MBPRs to their original values at system startup.

19. Reconnect the stainless steel flex line from the CO2 recycler.

6.17.3 Opening the recirculation valve on the CO2 recycler

To open the recirculation valve on the CO2 recycler:

1. Place the recirculation valve handle on the CO2 recycler in the open (vertical) position.

Tips: 

• Opening the CO2 recycler's recirculation valve prevents overheating and overpressure
issues.

• The "open" recirculation valve position may also be referred to as the Standby position
in other system documents.

Figure 6–47: CO2 recycler recirculation valve handle in open position (manual
recycler shown)

Recirculation valve handle in open (vertical) position
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6.18 Switching extraction vessels in a system using manual
valves
After a current run ends on systems equipped with manually operated valves used to switch flow
to the designated extraction vessel, to perform the next run using the alternative extraction
vessel, you must stop the system flow before switching the flow path to the alternative extraction
vessel (for example, switching the flow path from extraction vessel 1 to extraction vessel 2). If the
system is configured with automated valve switching, these tasks are unnecessary.

Warning: To avoid burn injuries, exercise care when handling the extraction vessels,
separation cyclones, heat exchanger outlet tubing, or other components heated to high
temperatures or cooled to low temperatures. Wait until the hot components have
sufficiently cooled or the cold components have sufficiently warmed before you handle
them.

To switch extraction vessels in a system using manual valves:

1. If the pumps and ABPR remain in operation, in the ChromScope Main window, click Stop
to switch off the system pumps, ABPR, and heaters.

Note: This will also cancel the method.

2. To reclaim CO2 remaining in the preceding run's extraction vessel, depressurize the
system to less than 6,895 kPa (69 bar, 1,000 psi) by slowly opening MBPR1 and MBPR2.

Tip: Depressurizing the system reduces CO2 waste and ensures safe switching between
extraction vessels.

3. Equalize the pressure between the two extraction vessels by slowly opening MV1-V2 while
keeping MV1-V1 open.

4. Wait until the pressures on both vessels' gauges equalize, and then, depending on which
extraction vessel you are switching to for the next run, complete one of these actions:

• If switching from extraction vessel 1 to extraction vessel 2, keep MV1-V2 and MV2-V2
open, and close MV1-V1 and MV2-V1.

• If switching from extraction vessel 2 to extraction vessel 1, keep MV1-V1 and MV2-V1
open, and close MV1-V2 and MV2-V2.

Important: You must release the pressure remaining in the preceding run's extraction
vessel before disconnecting the tubing from the vessel's cap and emptying, cleaning, and
loading the vessel for the next run.

5. Perform the next run using the alternative extraction vessel, referring to the procedures in
System startup and extraction workflow.
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6.19 Switching extraction vessels in a system with an
automation module
Bio-Botanical Extraction Systems with an automation module can automatically switch between
extraction vessel 1 (EV1) and extraction vessel 2 (EV2). The following table shows the valid
extraction selections for systems with an automation module.

Table 6–5: Extraction selections for systems with an automation module

Extraction
selection

Requirements Details

Extraction 1 Automation module Changes the automation valves to EV1

Extraction 2 Automation module Changes the automation valves to EV2

Vessel equilibration Automation module • Opens both automation valves for EV1
and EV2.

• Equalizes the pressures between EV1
and EV2. This uses half of the volume of
CO2 in EV1 to fill EV2.

Series: 1 to 2 Bio-Botanical Extraction
System in-line serial kit, 5-
liter only

Connects the outflow of EV1 to the inflow of
EV2.

Series: 2 to 1 Bio-Botanical Extraction
System in-line serial kit, 5-
liter only

Connects the outflow of EV2 to the inflow of
EV1.

Bio-Botanical Extraction Systems that have 2-liter cyclone separators can delay collection
(pulling) of the extract until after both extraction vessels have been run. Although this saves time,
it does not allow volatile components (terpenes) to be collected.

Extraction sequence for collecting terpenes and oils in both 1- and 2-liter cyclone
separators:

1. Extract terpenes from EV1 for approximately 60 minutes.

2. Collect terpenes in cyclone separator 3 (CS3).

3. Extract oils from EV1 for approximately 180 minutes.

4. Collect oils in CS2 and some CS1 (also waxes).

5. Reduce the flow pressure and flow rate.

6. Vessel equilibration switching EV1 to EV2 for approximately six minutes.

7. Extract terpenes from EV2 for approximately 60 minutes.

8. Collect terpenes in cyclone separator 3 (CS3).
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9. Extract oils from EV2 for approximately 180 minutes.

10. Collect oils in CS2 and some CS1 (also waxes).

11. Reduce the flow pressure.

12. Power-down the system.

Extraction sequence for collecting oils in 2-liter cyclone separators:

1. Extract oils from EV1 for approximately 180 minutes or more.

2. Reduce the flow pressure and flow rate.

3. Vessel equilibration switching from EV1 to EV2 for approximately six minutes.

4. Extract oils from EV2 for approximately 180 minutes.

5. Collect oils in CS2 and some CS1 (also waxes) or more.

6. Reduce the flow pressure.

7. Power-down the system.

Extraction sequence for collecting oils in 1-liter cyclone separators:

1. Extract oils from EV1 for approximately 180 minutes or more.

2. Collect oils in CS2 and some CS1 (also waxes) or more.

3. Reduce the flow pressure and flow rate.

4. Vessel equilibration switching from EV1 to EV2 for approximately six minutes.

5. Extract oils from EV2 for approximately 180 minutes.

6. Collect oils in CS2 and some CS1 (also waxes) or more.

7. Reduce the flow pressure.

8. Power-down the system.
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7 Data analysis

7.1 Data-log files
ChromScope automatically logs data about each extraction run and stores it in data-log files
assigned the file extension (*.tta). These files appear in the Project's Data Files folder. If you
specified a subfolder naming convention when setting up the project, the data-log files are
organized by date, sample name, or user name, and labeled with a time stamp indicating when
the run ended.

7.1.1 Viewing data-log files
Observe these guidelines when opening and viewing data-log files:

• Upon opening a data-log file, view the file's details in the tabbed area of the data grid.

• Specify a file-open mode preference for opening your data-log files according to how you
want to view them.

• In the opened data-log file, right-click to select plots that you want to view in overlay.

You can export any of the plot images shown in the data-log file by creating a document and then
copying and pasting the plots into it. To copy and paste a plot, right-click it and click Save.

Alternatively, from the toolbar, click Copy to Clipboard . You can then paste the plot into
your document.

To view a run's data-log file:

Click the file name.

Result: The data-log file opens in the selected data-file folder. Click the tabs on the opened file
to view the run's temperature, flow rate, and pressure plots. You can also click the General Info
and Method Info tabs to view a record of the run's general and method information.

7.1.1.1 Setting a preference for file-open mode

You can select from three file-open modes (New Tab, Current Tab, or Current Tab Overlay)
according to how you want to open and view data-log files. When you select a mode, all data-log
files you open remain open in that mode until you select another mode. The following table
describes each of the three modes and its affect on currently opened data-log files when you use
it to open a new data file.
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File-open
mode

File tab caption upon opening a new
data-log file

Effect on currently opened data-log
files

New Tab A new file (outer) tab, which displays the
file's name, is created for each data-log
file that you open.

All opened data-log files remain open.

Current Tab The data-log file is opened in the
currently selected tab, which displays
the file's name.

The data-log file that was previously
opened in the current tab is closed.
Other data-log files opened in other
tabs remain open.

Current Tab
Overlay

The data-log file is opened in the
currently selected tab, which displays
the file's name.

All opened data-log files in the current
tab remain open. The tab displays the
name of the last opened file.

To set the file-open mode:

From the File menu, click Data File Open Mode > New Tab, Current Tab, or Current Tab
Overlay.

Alternative: From the toolbar, click New Tab , Current Tab , or Current Tab

Overlay .

Rules: 

• For New Tab and Current Tab, the information in the data grid pertains only to the single,
opened data-log file.

• For Current Tab Overlay, the information in the data grid encompasses all of the data-log
files opened in the current tab.

7.1.2 Viewing plots
ChromScope software provides options for viewing plots that display acquired data so that you
can analyze them. You can open a single plot or all of the plots for a selected data file in an
expanded-view window, where you perform reporting tasks.

You can choose between the following two views of displaying the plots in the Expanded View
window.

Current Graph
Expanded View

Displays an enlarged view of a current plot from the open data-log file in
the View window. This view is useful when you want only to analyze and
work with a single plot.

All Graphs
Expanded View

Displays all of the plots from the open data-log file in the View window.
This view is useful when you want to generate reports of multiple plots
from the same data-log file.
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Tips: 

• To simply view the plots in a separate window that does not include the expanded toolbar,
from the View menu, click Show > Current Graph or All Graphs in File.

• To display data point coordinates in an area of a plot, in the toolbar, click Data Cursor ,
and then move the pointer over the plot area to view the data coordinates. Click Data Cursor

 again to disable this function.

7.1.2.1 Opening a single plot in expanded view

To open a single plot in expanded view:

1. From the open data file, select the tab of the plot that you want to expand.

2. From the View menu, click Expand > Current Graph.

Alternative: Double-click the file tab to view the expanded graph in a new window.

Result: The plot appears in a new window, which automatically closes when you select
another plot or data-log file.

7.1.2.2 Opening all of the plots in the expanded view

To open all of the plots in expanded view:

1. Select the tab of the opened data-log file that you want to expand.

2. From the View menu, click Expand > All Graphs in File.

Alternative: Double-click the file tab to view the expanded graph in a new window.

Result: All of the file's plots appear in a new window, which automatically closes when
you select another data-log file.

7.1.2.3 Displaying the expanded view toolbar

To display the expanded view toolbar:

1. Open a plot or plots in expanded view.

2. In the expanded view window, select the control that you want from the toolbar.
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7.2 Configuring your display preferences
In the Display Options panel, you can specify and save your preferences for viewing plots and
their associated data in the data-log file's data grid. Use these preferences to show or hide
various elements of the data-log file's raw data.

Rule: The raw data contained in the data-log file remains unchanged by these settings.
Consequently, you can cancel or change your display preferences to show or hide elements that
were previously hidden or displayed in the opened data-log file.

You can set display options to show or hide these elements:

• Run information that appears in the data grid

• Graph components, including individual plots such as Flow or Pressure, and their properties
such as Duration Marks and Grid lines

• Options for applying actual or normalized scales to files displayed in overlay mode

You can also set display options to control the characteristics of these elements:

• General preferences for determining how flow is displayed

• Zooming controls that determine the displayed chart's viewable boundaries for all plots or just
the currently active plot

• Axis offset in overlay

• Annotation orientation for duration information

7.2.1 Setting display preference for flow
You can set a preference for how you want pump flow to appear in charts.

To set display preference for flow:

1. From the View menu, click Display Options to open the Display Options panel.

Alternative: In the toolbar, click Display Options .

2. In the General Options subpanel, select CO2 and CoSolvent Flow Values to show both of
these values in the Flow Plot, or CoSolvent% to show only the co-solvent percentage in
the Flow Plot.

3. Click OK to save your display settings.

7.2.2 Setting zooming options and parameters
The zooming values determine the displayed chart's viewable boundaries.
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To set zooming options and parameters:

1. From the View menu, click Display Options to open the Display Options panel.

Alternative: In the toolbar, click Display Options .

2. In the Zoom Options subpanel, select the Zooming option Use Global Zoom to apply the
zooming controls to all plots, or Use Local Zoom to apply the zooming controls only to the
currently active plot.

3. Specify the values for the X Min, Y Min, X Span, and Y Span parameters.

Tip: To set a floating zoom capability that corresponds to the full data range of the
displayed chart, specify 0 for the X Min, Y Min, X Span, and Y Span values.

Table 7–1: Example

Value Result in the displayed chart

X Min = 1 The start value for the x axis is 1.

Y Min = 2.5 The end value for the y axis is 3 (X Min + X Span).

X Span = 2 The start value for the y axis is 2.5.

X Span = 2 The end value for the y axis is 3 (Y Min + Y Span).

4. Click OK to save your display settings.

7.2.3 Setting run information display options
The Run Information settings affect only the data grid. Chart and reports remain unaffected.

Note: The Run Information fields provide extraction run details, such as vessel and cyclone
temperatures. In the data grid, this information appears on the Method Info tab.

The table at the end of this procedure shows all of the Run Information options that are available
to display on the Method Info tab.

To set run information display options:

1. From the View menu, click Display Options to open the Display Options panel.

Alternative: In the toolbar, click Display Options .

2. In the Run Information subpanel, select the individual run information options that you want
to appear in the data grid, or click Select All to select all of the available run information
options.
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Tip: To hide all run information, clear the Select All check box and the check boxes for
the individual run information options.

3. Click OK to save your display settings.

Table 7–2: Run information options for Method Info

Run Information options

Date Time Stamp

Method

Method Version

Sample

Extraction Vessel

Extraction Vessel 1 Temperature (C)

Extraction Vessel 2 Temperature (C)

Cyclone Vessel 1 Temperature (C)

Cyclone Vessel 2 Temperature (C)

Cyclone Vessel 3 Temperature (C)

Inline Heater Temperature (C)

Inline Collection Heater Temperature (C)

Dynamic Duration 1 (min)

Static Duration (min)

Dynamic Duration 2 (min)

CO2 Flow Rate

Co-Solvent Flow Rate

Front Pressure

Back Pressure

Pressure Drop

7.2.4 Setting annotation display options and orientation
Selected annotations appear in both charts and reports.

To set annotations display options and orientation:

1. From the View menu, click Display Options to open the Display Options panel.
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Alternative: In the toolbar, click Display Options .

2. In the Annotations subpanel, select the Duration Marks Label to display duration marks in
your plots and reports.

3. Specify the orientation, in degrees, for positioning the annotations on the chart.

Range: 0 to 180
4. Click Set Font and Set Font Color to revise Annotation text size, font, font style, and

color.

5. Click OK to save your display settings.

7.2.5 Setting graph display options
Graph components include individual plots, such as Flow or Pressure, and their properties such
as Duration Marks and Grid Lines.

The table, at the end of this procedure, lists the graph components in the Display Options panel,
which appear in the opened data-log file. Depending on a system's configuration, the
temperatures for some vessels (for example Cyc Vessel 3 Temperature) may not apply.

To set graph display options:

1. From the View menu, click Display Options to open the Display Options panel.

Alternative: In the toolbar, click Display Options .

2. In the Graph Display Options subpanel, select the individual graph components that you
want to appear in the data-log file and its plots, or click Select All to select all of the
available graph components.

Tip: To hide all graph components, clear the Select All check box and the check boxes
for the individual graph components.

3. Click OK to save your display settings.

Table 7–3: Graph display options for charts

Graph display options

Temperature Plot

Flow Plot

Pressure Plot

Duration Marks

Show Grid Lines

Ext Vessel 1 Temperature
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Table 7–3: Graph display options for charts (continued)

Graph display options

Ext Vessel 2 Temperature

Ext Vessel 1 Band 2 Temperature

Ext Vessel 2 Band 2 Temperature

Cyc Vessel 1 Temperature

Cyc Vessel 2 Temperature

Cyc Vessel 3 Temperature

Inline Heater Temperature

Inline Collection Heater Temperature

Ext Vessel 1 Internal Temperature

Ext Vessel 2 Internal Temperature

7.2.6 Setting overlay, axis offsets in overlay, and axis scale options
You can specify options for applying actual or normalized scales to the files displayed in overlay
mode.

To set overlay options and axis offsets in overlay:

1. From the View menu, click Display Options to open the Display Options panel.

Alternative: In the toolbar, click Display Options .

2. In the Overlay Options subpanel, select Actual Overlay to display your plots on the actual
scale on the y axis, or select Normalized OverLay to display them on a normalized scale.

Rules: 

• Normalization has no affect on data-log files that are not opened in overlay mode.

• Normalization applies to flow and pressure plots.

3. To manually align adjacent, overlaid plots, set the offsets affecting the time (x axis) and the
signal (y axis) that you require by specifying values for X Offset and Y Offset parameters.

Result: For flow and pressure plots, an X Offset value shifts the time for each plot
horizontally on the x axis, while a Y Offset value shifts the signal for each plot vertically on
the y axis.

Rules: 
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• Axis offset values affect only the data-log file's plots. The stored data and calculations
in the data grid remain unchanged.

• When you select Normalized Overlay, the value for Y Offset is defined as a
percentage of the normalized Y scale.

4. For the Current Run Axis Scale Options, select the appropriate run axis scale option to
give Real Time Axis Scale or Static Axis Scale.

Tip: Static Axis Scale enables manual setting of scale values, which is helpful when you
want a predetermined scale.

5. Click OK to save your display settings.
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8 Data management and reporting

8.1 Data-log files

8.1.1 Exporting a set of data-log files
You can export data-log files by group—as Microsoft Excel or CSV file formats—for use with
document-processing applications and other data-control software. When you do so, the exported
files are created with the name "<sourcefilename>.xls" or "<sourcefilename>.csv" and saved at a
location of your choice.

To export a set of data-log files:

1. From the Tools menu, click Export > To Excel or To CSV > Browse for File(s).

2. In the open window, select the data-log files for export.

Tip: Use Shift or Ctrl keys to select multiple files.

3. Click Open.

8.1.2 Exporting individual data-log files
You can export data-log files individually as Microsoft Excel or CSV file formats for use with
document processing applications and other data control software. When you do so, the exported
files are created with the name "<sourcefilename>.xls" or "<sourcefilename>.csv" and saved at a
location of your choice.

Rules: 

• If no data-log file is open, Export > Current File is disabled.

• If a set of files is open in overlay mode, Export > Current File works only with the last opened
data-log file.

To Export a currently opened data-log file:

1. Open the data-log file.

2. From the Tools menu, click Export > To Excel or To CSV > Current File.

3. Click Open.
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8.1.3 Submitting data-log files for batch processing
You can use batch processing to process a group of data-log files sequentially, making these
actions possible:

• Selecting which report templates to process in the data-log file.

• Printing batch reports on the default printer or to a PDF file.

To submit data-log files for batch processing:

1. From the Tools menu, click Batch Process.

2. In the Batch Processing window, identify the location (the system and project) containing
the files that you want to process.

3. To select a common report template for all of the files you are processing, select the
template from the Report Template list; otherwise, leave the Report Template box blank.

Rule: If you leave the Report Template box blank, each data stream of the files you are
processing must be reported according to the report template associated with the log files
when you created the methods or the template selected during offline analysis using the
Choose Report Template option.

4. To add files to the batch, select the data folder, select the files that you want to process

from the Available Files list, and then click Add files  to move them into the Batch
Process Files List.

Tips: 

• Use the Shift or Ctrl keys to select multiple files.

• To remove files from the Batch Process File List, select the files and click Remove

.

5. Select PDF or Default printer for the batch report.

6. Click Start.

Results: 

• Batch reports of the processed data-log files are printed on a default printer or saved as
PDF files.

• If saved as PDF files, the file names are auto-generated, and the files are saved in the
defined location.
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8.2 Quick reports
Quick Report is an integrated reporting utility that presents data about each run in a predefined
format. You can generate a quick report from an open data-log file by saving it to a PDF file or by
sending it to a printer that is connected to the ChromScope workstation.

ChromScope includes a predefined Quick Report Template, located in the Default Project's
Report Templates folder. You can use this default template or select your own Quick Report
template from the available custom report templates.

Tip: You can create a custom report template and assign it as a Quick Report template. For
details, see Choosing a Quick Report Template.

See also: Custom report templates.

8.2.1 Choosing a quick report template
For open data-log files where you want to use the Quick Report printing options, you can use the
default project's Quick Report Template, or select a custom report template from any of the
project folders, and assign it as the Quick Report Template.

To choose a Quick Report Template:

1. From the Tools menu, click Choose Quick Report Template.

2. Select the Project folder and report template, and then click Apply.

Result: The template you selected is used the next time you use the Print Quick Report
To PDF or Print Quick Report To Printer options from the File menu.

8.2.2 Printing a quick report to a PDF file

To print a quick report to a PDF file:

1. Open the data-log file.

2. Click the tab to display the plot that you want to capture in the report.

3. From the File menu, click Print Quick Report To PDF.

Alternative: From the toolbar, click Print Quick Report To PDF .

4. In the Save dialog box, type a name for the PDF file or accept the default name, and click 
OK.

Tip: The default name for the PDF file is the data-log file name appended with the date
and time stamp.
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Result: The file is saved under the project's Reports folder.

8.2.3 Printing a quick report to a printer
Requirement: You must power-on a printer connected to the ChromScope workstation.

To print a quick report to a printer:

1. Open the data-log file.

2. Click the tab to display the plot that you want to appear in the report.

3. From the File menu, click Print Quick Report To Printer, and select the printer.

Alternative: From the toolbar, click Print Quick Report To Printer  to print the
report on the default printer.

Restriction: The message Printer not available appears when the printer is not
connected properly and powered-on.

8.3 Custom report templates
You can define and save a set of custom report templates for each project. Each report template
stores the information used to generate a custom report. This information includes the report's
displayed information content, the order of this content, the header and footer layout, and page
setup. Later, you can associate this template with a data-log file by attaching it to the opened file
and use it to generate, preview, and print a custom report.

The topics in this section describe the steps for creating custom report templates and attaching
them to data-log files.

8.3.1 Creating a report template
1. In the Folder View panel for the project, right-click the Report Templates subnode and

select Add new template.

Alternative: From the File menu, click Create new project files > project name > 
Create Report Template.

2. Define the template layout referring to the section "Report Template editor".

3. When you finish defining your report template, click Save to save your report template
settings.

Result: The new template file is saved under the project's Reports Template subnode.
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8.3.1.1 Report template editor

To create a new report template, or open an existing one, you use the Report Template editor,
which opens in the Report Template window. The Report Template window comprises three main
areas: a toolbar at the top, an object navigation tree on the left-hand side, and the report canvas
on the right-hand side.

Figure 8–1: Example Report Template editor window

The Report Template canvas is where you define the actual layout of the report template by
dragging and dropping objects from the object navigation tree. You can then use the toolbar
controls to manipulate these objects and define the page setup.

The following table describes all of the various ways that you can manipulate objects on the
report canvas.
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To add an
object to the
canvas

Click the object in the object tree, and drag the object onto the canvas.
Release the button when the object is in the desired position. You can drag
and drop these items:

• Plots (temperature, flow, and pressure)

• Tables containing the data-log file's general information and and sample list
information

• Individual fields from the tables

• Lines, text boxes, and image boxes

You can drag and drop an object multiple times. You can also insert a table
with limited fields, or columns, by dragging one field at a time to the table being
constructed. Alternatively, you can drag the whole table onto the canvas, and
then remove the unwanted fields.

Restriction: You cannot create a table by mixing fields from the data-log file's
General Info and Method Info.

To resize an
object on the
canvas

Select the object and move the resize cursor on its border to stretch or reduce
the object's size. For a table field, select the field-separator line, and when the
cursor shape becomes a bidirectional arrow, move it to increase or decrease
the width of the field.

To remove an
object Select the object and click Delete . To delete columns in a table, right-

click the shaded region above the column header and click Delete Column.

Tip: If the table has only one column, to delete it, you must select it and click 

Delete .

To reposition
an object

Move the mouse pointer over the object's shaded region, and when it becomes
a cross hair, click and drag the object to its new position. To reposition fields, or
columns, click the shaded region above the column header and drag the field
to its new position in the table.

To select
multiple
objects

While holding the Ctrl or Shift keys, click the objects you want selected.

Tip: To select all of the objects on the canvas, right-click an empty place on
the canvas and click Select All.

8.3.1.1.1 Adding and formatting text

In a text box, you can specify the font, size and style of text. You can insert system variables such
as page number, total pages, and time of report generation. You can also insert variables for
commonly used fields such as file name, method name, or log author.
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To specify text properties:

1. Right-click the shaded region of the text box, and select Properties.

2. In the Text Properties window, choose how you want to specify text properties referring to
the following table.

To format text
characters

In the Properties window, select the Font Family, Font Size, Font
Effects (Underline, Strikethrough, or None), and style (Font Bold
and Font Italic) you want for the text box.

To insert system
variables

In the Properties window, click System Variable, and select Page
Number, Total Pages, or Time from the list.

To insert a data-log
file field

In the Properties window, click System Variable, and select the
field from the Fields sublist.

To format system
variables

You format system variables in two steps:

1. Set the text format for the text box, as described above, and
save your settings.

2. Reopen the Properties window, and select the variables you
need.

8.3.1.1.2 Adding headers and footers

You can add footers and headers to your custom template, to display information at the top and
bottom of every page on a custom report.

You can add these elements to a header or footer:

• Page number

• Total pages

• Report generation time

• Frequently used fields, including "log author", "report by", "file name", and "method name"

• Graphics, including lines and company logo images

To add a header, click the Add Header control. To add a text box or graphic to the header, drag
and drop those objects, which appear in the object navigation tree, into the header area.

Tip: When you add a header, the Add Header control changes to Remove Header, which you
can then click to remove the header.

To add a footer, click the Add Footer control. To add a text box or graphic to the footer, drag and
drop those objects, which appear in the object navigation tree, into the footer area.

Tip: When you add a footer, the Add Footer control changes to Remove Footer, which you can
then click to remove the footer.
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8.3.2 Attaching report templates to data-log files
Observe these guidelines when attaching your report templates:

• If you assign a report template to a method step and run the method, a custom report of each
plot is automatically printed in a "run and report" queue according to the assigned report
template.

• You can attach a report template to an opened data-log file and associate it with the currently
displayed plot.

• You can change what report templates are assigned to a data-log file at any time.

• After you attach a report template to a data-log file, you can display the custom report in a
print preview window.

To attach a report template to the data-log file:

1. Open the data-log file.

2. From the File menu, click Choose Report Template.

3. Select the report template from the list of available templates.

4. Click Apply to attach the selected template to the opened data-log file.

Result: The template is attached to the data-log file, so you can generate and print a
custom report for the opened data-log file.

Rules: 

• At any time, you can remove or change the report template attached to the opened
data-log file.

• Using the Report Template editor, you can modify the report template currently
attached to a data-log file. After you do so, any newly generated custom reports for the
file reflect the template's changes.

8.3.3 Exporting a report template
You can export a report template from one project to another.

To export a report template:

1. Click the Report template node, to display the currently stored instrument methods.

2. Right-click the file that you want to export, and select Export To and the destination project
from the list.

Result: The report template appears in the new project location.
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8.4 Custom reports
After you define a custom report template and attach it to a data-log file, you can generate a
custom report from the opened data-log file by saving the report to a PDF file or sending it to a
printer connected to the ChromScope workstation. You can also preview a custom report of the
opened data-log file in a Report Viewer window.

Alternative: You can associate a report template with the steps of a method, and specify a
custom report of each plot automatically printed in a "run and report" queue, according to the
assigned report template.

Depending on what input boxes and components are defined for the report template used for the
custom report, the report can comprise these main elements:

• Header on each page

• Plots:

• Flow, showing the CO2 and co-solvent flow rates during the run

• Pressure, showing the head-pressure and back-pressure rates during the run

• Temperature, showing the baseline of the mobile-phase temperature during the run

• General information, or details, about the data-log file

• Method information, or details, about the run's extraction parameters

• Footer on each page

8.4.1 Previewing a custom report

To preview a custom report:

1. Open the data-log file.

2. From the File menu, click Preview Custom Report, and then click OK.

Alternative: From the toolbar, click Preview Custom Report .

Result: The custom report opens in the Report Viewer window.

8.4.2 Printing a custom report to a PDF file
Requirement: A report template must be attached to the data-log file that you want captured in
the report. If a template was not previously attached, the Choose Report Template dialog box
appears.
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To print a custom report to a PDF file:

1. Open the data-log file.

2. Click the tab to display the plot that you want to capture in the report.

3. From the File menu, click Print Custom Report To PDF.

Alternative: From the toolbar, click Print Custom Report To PDF .

4. In the Save dialog box, type a name for the PDF file or accept the default name, and click 
OK.

Tip: The default name for the PDF file is the data-log file name appended with the date
and time stamp.

Result: The file is saved under the project's Reports folder.

8.4.3 Printing a custom report to a printer
Requirements: 

• You must power-on a printer connected to the ChromScope workstation.

• A report template must be attached to the data-log file that you want captured in the report. If
one was not previously attached, the Choose Report Template dialog box appears.

To print a custom report to a printer:

1. Open the data-log file.

2. From the File menu, click Print Custom Report To Printer and select the printer.

Alternative: From the toolbar, click Print Custom Report To Printer  to print the
report on the default printer.

Important: The message Printer not available appears if the printer is not
connected properly and powered-on.

8.5 Configuring auto report mail
You can configure an option to automatically distribute reports to a list of email recipients as part
of a method's batch "run and report" queue. The reports are based on the Report Template
settings in the method.
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To configure the auto report mail option:

1. From the Configure menu, click Configure Auto Report Mail.

2. In the Configure Mail window, for each recipient, type the recipient's email address and

click Add to Recipient  to add the recipient's name to the "To:" list box.

Tip: To remove a recipient's name from the "To:" list box, select the name and click 

Remove .

3. To set a default mail subject line, type the text for your subject in the Set Mail Subject text
box, and then select the Apply Default Mail Subject check box.

Requirement: To edit subject text in the Set Mail Subject text box, you must first clear
the Apply Default Mail Subject check box.

4. To set a default mail body text, type the text for your mail in the Set Mail Body text box,
and then select the Apply Default Mail Body check box.

Requirement: To edit mail body text in the Set Mail Body text box, you must first clear
the Apply Default Mail Body check box.

5. Consult your company's IT department to specify the remaining settings for Sender Email
Address, Sender Email Password, and the Mail Server Address and Mail Server Port
settings.

6. Click OK to save your settings.
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9 System maintenance

9.1 Cleaning guidelines for all configurations
Use these tables as a guide for cleaning the Bio-Botanical Extraction System. When cleaning the
system, always observe Good Laboratory Practice (GLP) guidelines and your laboratory's
standard operating procedures.

Table 9–1: Cleaning level descriptions

Cleaning level Cleaning description

1 Flush the system

2 • Clean the manual back-pressure regulators (MBPR)

• Check and clean the view cell

• Check the CO2 recycler for carryover

• Check and clean the inlet filter

3 Clean the CO2 cooling heat exchanger (HE1) tubing, inlet tubing, and flow
meter

4 Clean the CO2 recycler

Table 9–2: Cleaning guidelines

When to clean Level 1
cleaning

Level 2
cleaning

Level 3
cleaning

Level 4
cleaning

After every use x x   

Before running a material that differs
substantially from the last material run

x x x x

After every 6 extractions of heavy-wax
material

  x  

After every 10 extractions of low‐wax
material

  x  

After running any material suspected of
being contaminated with pesticides or
mold

x x x x
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Table 9–2: Cleaning guidelines (continued)

When to clean Level 1
cleaning

Level 2
cleaning

Level 3
cleaning

Level 4
cleaning

When the recycler tank pressure drops
too low

   x

When the CO2 inlet density is too low
(less than 0.87 g/cm³), but the CO2

recycler pressure is within an
acceptable range of 4654 to 5171 kPa
(47 to 52 bar, 675 to 750 psi)

  x x

9.2 Maintenance schedule
Use this table as a guide for planning system maintenance. When performing service or
maintenance tasks, always observe Good Laboratory Practice (GLP) guidelines and your
laboratory's standard operating procedures.

Table 9–3: System maintenance tasks

Task Component Maintenance interval

Clean the view cell Cyclone separator 3 (CS3)
tubing

Once a week or when liquid CO2

or dark material appears in the
view cell lens.

Clean the manual back-
pressure regulators

Manual back-pressure
regulators

Once a year or as necessary.

Service the CO2 filter CO2 filter Replace every six months, or
when a clogged filter impedes CO2

flow.

Replace the CO2 pump's inlet
and outlet check valves

CO2 pump When pump performance
degrades.

Replace the CO2 pump's
piston seals

CO2 pump When pump performance
degrades.

Replace the CO2 pump's
rupture disc

CO2 pump As necessary.

Replace the co-solvent
pump's inlet and outlet check
valves

Co-solvent pump When pump performance
degrades.

Replace the co-solvent
pump's piston seals

Co-solvent pump When pump performance
degrades.
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Table 9–3: System maintenance tasks (continued)

Task Component Maintenance interval

Replace the co-solvent
pump's rupture disc

Co-solvent pump Once a year or as necessary.

Replace the vessel's rupture
discs

Extraction vessels and
cyclone separators

Once a year or as necessary.

Replace fuses in rear of
modules

CO2 pump, automated
back-pressure regulator,
heat exchanger, and six-
zone heater controller
modules

Replace upon failure.

Clean extraction and
collection vessel surfaces

Extraction and collection
vessels

Clean exterior surfaces as needed.
Clean interior surfaces after each
run, or as needed.

9.3 Spare parts
To ensure that your system operates as designed, use only Waters Quality Parts. Visit
www.waters.com/wqp for information about Waters Quality Parts, including how to order them.

9.4 Performing the Level 1 cleaning procedure
Perform the Level 1 cleaning procedure after every use and before you run a material that
significantly differs from the last material run.

Warning: To avoid eye or facial injury, wear a face shield when performing this
procedure.

Required tools and materials

• Face shield

• Thermally insulated gloves

• Large beaker (polypropylene or metal, 1 L)

To perform the Level 1 cleaning procedure:

1. Ensure that there is no botanical material in the extraction vessels.
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Note: You can use marbles or other inert material to fill the void in the extraction vessels.
Doing so fills the system with CO2 faster.

2. In the ChromScope software, set the CO2 flow to 50 g/min and the automated back-
pressure regulator (ABPR) to 1551 kPa (15.5 bar, 225 psi).

3. Specify normal pressures and temperatures for the cyclone separators.

4. Allow the system to run for a minimum of 1 hour at normal operating pressure.

Tip: If possible, allow the system to run overnight.

5. Open the drain valve on cyclone separator 3 (CS3), then cyclone separator 2 (CS2), and
then cyclone separator 1 (CS1).

Figure 9–1: Cyclone separator drain valves

CS1 drain valve

CS2 drain valve

CS3 drain valve

6. Close the CO2 inlet valve to the recycle tank, and then close the CO2 outlet valve from the
recycle tank to the mass flow controller.

Tip: This isolates the CO2 recycler tank.

Warning: To avoid injuries caused by shattering glass fragments, do not use
laboratory glassware to collect fractions or waste components. When opening
drain valves, a high-pressure release of solvent or extracted compounds can
knock a glass container out of your hand and cause it to shatter.

7. Place a beaker under the CO2 recycler drain outlet.

8. Slowly open the CO2 recycler manual drain valve to inspect for oils that carried over to the
recycler.
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Figure 9–2: Drain valve handle and outlet on bottom of CO2 recycling vessel

1

Drain valve handle

Drain outlet

Warning: To avoid freeze burns when closing the CO2 recycler manual drain
valve, wear thermally insulated gloves. During draining, the drain valve can
freeze due to Joule-Thompson cooling, and its temperature can fall as low as -78
°C.

Warning: To avoid eye or facial injury, wear a face shield when closing the CO2

recycler manual drain valve. As the drain valve begins to warm, frozen CO2

blocking the outlet could be explosively expelled.

9. When you see no more oils and only CO2, close the CO2 recycler manual drain valve.

Tip: The CO2 recycler tank can take several hours to drain, depending on the amount of
CO2 in the tank. When draining, the drain valve may freeze due to Joule-Thompson
cooling and clog the drain outlet with frozen CO2. As the drain outlet begins to warm, the
frozen CO2 may be explosively expelled causing a loud sound and an explosive release of
CO2. Wear a face shield and thermally insulated gloves to protect from freeze burns. The
drain valve on the recycle tank will go to as low as -78 °C during draining.

9.5 Performing the Level 2 cleaning procedure on a system
with a co-solvent pump
Perform the Level 2 cleaning procedure after every use and before you run a material that
significantly differs from the last material run.
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Tip: Ensure that you have all of the required tools and materials in stock before performing this
procedure.

Required tools and materials

• 9/16-inch open-end wrench

• 2-1/4-inch open-end wrench

• Compressed air

• Food-grade lubricant

• Food-grade ethanol (1 L)

• Heat gun

• Soft bristle brush

• Ultrasonic bath

• Wash bottle

Performing the Level 2 cleaning procedure on a system with a co-solvent pump involves these
steps:

1. Preparing the system and priming the co-solvent pump.

2. Flushing the system.

3. Cleaning the cyclone separators and their tubing.

4. Cleaning the manual back-pressure regulators.

5. Cleaning the view cell.

6. Checking the CO2 recycler for carryover.

7. Servicing the CO2 filter.

9.5.1 Preparing a system with a co-solvent pump for cleaning

Required tools and materials

• 9/16-inch open-end wrench

• Food-grade ethanol (1 L)

To prepare a system with a co-solvent pump for cleaning:

1. Prepare a solvent reservoir of 1 L 95% food-grade ethanol and place the pump siphon tube
into it.

2. Prime the co-solvent pump.
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a. In the ChromScope software, stop the operation of the co-solvent pump.

b. Place the solvent reservoir from which you are drawing solvent at the same level as
the pump or higher.

c. Ensure that the weighted, solvent-filter inlet is fully submerged in the solvent
reservoir.

d. Place a waste receptacle beneath the MV4 priming outlet to collect the solvent.

Figure 9–3: Location of MV4 valve on module cart

Location of MV4 valve

Figure 9–4: MV4 priming outlet

MV4 priming outlet

e. Close the MV4 system valve, which directs flow to the system.

Figure 9–5: MV4 system valve handle
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MV4 system valve

f. Slowly open the MV4 priming valve, which directs flow to the priming outlet.

Figure 9–6: MV4 priming valve handle

MV4 priming valve

Tip: Open the priming valve slowly. Any pressure remaining in the pump escapes
through the valve.

g. In the ChromScope software, start the solvent flow.

h. Observe the flow until a steady stream exits the outlet of the priming valve, and then
stop the operation.

Notice: To avoid a high-pressure burst of the pump's rupture disc, always
leave one side open on the MV4 valve. Operating the pump with both sides
of the MV4 valve closed will cause the rupture disc to immediately burst.

i. To complete the priming operation, close the MV4 prime valve, which closes the flow
path to the priming valve, and then open the MV4 system valve, which opens the
flow path to the system.

3. Ensure that there is no botanical material in the extraction vessels.

Note: You can use marbles or other inert material to fill the void in the extraction vessels.
Doing so fills the system with CO2 faster.

4. Slowly open the drain valve on cyclone separator 3 (CS3) to bleed off the residual CO2.
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Figure 9–7: Location of CS3 drain valve

CS3 drain valve

5. Use the 9/16-inch open-end wrench to slowly disconnect the stainless steel flex line from
the exhaust inlet atop the CO2 recycler to prevent co-solvent from getting into the recycler.

Figure 9–8: Stainless steel flex line and CO2 recycler exhaust inlet

Stainless steel flex line

Exhaust inlet atop CO2 recycler

6. Route the stainless steel flex line to a suitable exhaust system.

9.5.2 Flushing the system

To flush the system:

1. In the ChromScope software, set the CO2 flow to 80 g/min.

Note: You might need to fill the CO2 recycler during this procedure.

2. If your system has a co-solvent pump, set the flow to 20 mL/min.
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3. Set the automated back-pressure regulator (ABPR) to 19,995 kPa (200 bar, 2900 psi).

4. Set the extracting solvent heat exchanger (HE2) temperature to 70 °C.

5. Set the extraction vessel temperature to 60 °C.

6. Set the cyclone separator 3 (CS3) manual back-pressure regulator (MBPR) to 2068 kPa
(21 bar, 300 psi).

Important: Do not change the other cyclone separator settings.

Figure 9–9: Location of CS3 MBPR and pressure gauge

CS3 MBPR

CS3 pressure gauge

7. Ensure that the cyclone separator temperature settings are specified as follows:

• CS1: 60 °C

• CS2: 60 °C

• CS3: 35 °C

8. If your system has a co-solvent pump:

a. Start the CO2 and co-solvent pumps and allow the flow to continue for approximately
25 minutes.

b. After 25 minutes, stop the co-solvent pump and continue the CO2 flow for 1 hour, to
flush any residual ethanol out of the lines.

9. If your system does not have a co-solvent pump, start the CO2 pump and allow the flow to
continue for 85 minutes.
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10. Open the drain valves on the cyclone separators (CS1, CS2, and CS3) slowly, to allow the
ethanol to drain completely.

Figure 9–10: Cyclone separator drain valves

CS1 drain valve

CS2 drain valve

CS3 drain valve

11. After the ethanol drains, increase the pressure on CS3 to 2068 kPa (21 bar, 300 psi).

12. Depressurize the extraction vessel in 1999 kPa/min (20 bar/min, 290 psi/min) increments,
to the pressure of CS1.

13. Slowly re-open the drain valves on CS1, CS2, and CS3 to verify that all the ethanol is
drained from the system.

14. After the ethanol drains completely, close the drain valves on CS1, CS2, and CS3.

15. Stop the CO2 pump, power-off the heaters, and bleed off the extraction vessel.

16. Set the temperature of CS1, CS2, and CS3 to 45 °C.

17. Slowly reduce the pressure (counterclockwise) on CS1 MBPR at a rate of 1999 kPa/min
(20 bar/min, 290 psi/min), until it reaches the pressure of CS2.
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Figure 9–11: CS1 MBPR and pressure gauges

CS1 MBPR

CS2 pressure gauge

CS1 pressure gauge

18. Slowly reduce the pressure on CS2 MBPR until it reaches the pressure of CS3.

19. Slowly open the drain valve on CS3 and continue to remove the residual CO2.

20. While the CS3 is draining, open the MBPRs on CS1 and CS2 completely.

9.5.3 Cleaning the cyclone separators and tubing

Required tools and materials

• 9/16-inch open-end wrench

• Food-grade ethanol

• Heat gun

• 2-1/4-inch open-end wrench

• Soft bristle brush with 3-inches bristles

• Ultrasonic bath (optional)

• Wash bottle
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To clean the cyclone separators and tubing:

1. Confirm the system is at atmospheric pressure and that the CO2 pump and co-solvent
pump (if present) are powered-off.

Tip: When the system reaches atmospheric pressure, the pressure reading on cyclone
separator 3 (CS3) is zero.

2. In the ChromScope software, set the temperature of each cyclone separator to 40 °C.

3. Label the tubing and each cyclone separator cap as CS1, CS2, and CS3.

4. Use the 9/16-inch open-end wrench to slowly remove the 1/4-inch tubing that connects
each cyclone separator outlet to its respective manual back-pressure regulator (MBPR)
inlet.

Figure 9–12: Manual back-pressure regulator inlet, tubing, and cyclone separator
outlet

Manual back-pressure regulator inlet

Tubing

Cyclone separator outlet

5. Use a wash bottle of 95% food-grade ethanol to clean all of the tubing.

Tip: If the tubing is severely clogged, sonicate it with 95% food-grade ethanol.

6. Remove the cyclone separator caps.

Tip: If the cyclone separator cap will not turn, use the 2-1/4-inch open-end wrench to
loosen it.

7. Inspect the O-ring on each cap and replace it if necessary.
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Figure 9–13: Underside of cyclone separator cap and O-ring

O-ring

Underside of cap

8. Clean the underside of each cap with the wash bottle and rag (or paper towels).

9. Squirt 95% food-grade ethanol into the outlet fittings, located on the top of each cyclone
separator cap.

Figure 9–14: Location of outlet fitting on cyclone separator cap

Outlet fitting

10. Close each cyclone separator drain valve.

Note: The ethanol exits out of the tube on the underside of the cap.
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Figure 9–15: Tube on underside of cyclone separator cap

Underside of cap

Tube

11. Place a beaker under each of the cyclone separator drain lines.

12. Squirt approximately 300 mL of 95% food-grade ethanol along the interior walls in each
cyclone separator.

Figure 9–16: Cyclone separator interior wall

Interior wall

13. Scrub the interior walls of each cyclone separator using a soft-bristle brush.
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Soft-bristle brush

Interior wall

14. After approximately 5 to 10 minutes of soaking, open each cyclone separator drain valve.

Tip: If there is wax in the cyclone separator drain valve at the beginning of the cleaning
process, use a heat gun to melt it.

15. When the ethanol begins to drain, continuously squirt 95% food-grade ethanol along the
interior walls of each cyclone separator until it runs clear.

16. Turn off the cyclone separator heaters.

17. Close each cyclone separator drain valve.

Figure 9–17: Cyclone separator drain valves
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CS1 drain valve

CS2 drain valve

CS3 drain valve

18. Reinstall the cyclone separator caps and tubing to their labeled positions.

Requirement: Set all the MBPRs to their original values at system startup.

19. Reconnect the stainless steel flex line from the CO2 recycler.

9.5.4 Cleaning the manual back-pressure regulators
Clean the manual back-pressure regulators (MBPRs) whenever carryover is observed in the CO2

recycler.

Required tools and materials

• 2-1/4-inch open-end wrench

• Compressed air

• Food-grade ethanol

• Food-grade lubricant

• 13,790 kPa (138 bar, 2000 psi) or 41,369 kPa (414 bar, 6000 psi) MBPR rebuild kit

To clean the manual back-pressure regulators:

1. Relieve all pressure from the system.

2. Turn the large, blue knob on the top of the MBPR fully counterclockwise to reduce the
pressure.
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Figure 9–18: Blue knob on MBPR

Blue knob

3. Use the 2-1/4-inch open-end wrench to loosen and remove the spring housing from the
regulator body.

Note: The range spring will fall out of the spring housing when the housing is removed
from the regulator body.

Figure 9–19: Location of wrench placement on MBPR body

Spring housing

Place the 2-1/4-inch open-end wrench here

Regulator body

4. Remove the lower spring guide and piston/cylinder assembly.
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Figure 9–20: Lower spring guide and piston/cylinder assembly

Lower spring guide

Piston/cylinder assembly

5. Carefully remove the cavity O-ring from the regulator body and discard it.

Figure 9–21: Location of cavity O-ring

Cavity O-ring

6. Thoroughly clean the cavity body with 95% food-grade ethanol.

7. Blow out any remaining solvent with clean, dry, compressed air.

8. Install a new cavity O-ring in the groove inside the regulator body.

9. Use your thumb to press the piston assembly out of the cylinder.
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Figure 9–22: Location of thumb placement for piston assembly removal

Cylinder

Press thumb here

10. Remove the O-ring and backup ring from the piston assembly and discard them.

Figure 9–23: Piston assembly backup ring and O-ring

Piston assembly

Backup ring

O-ring

11. Install the small O-ring over the piston assembly.

12. Install the backup ring over the piston assembly by sliding it all the way against the O-ring.
Ensure that the O-ring and backup ring are oriented correctly, with the O-ring on first, and
the backup ring on second.
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Figure 9–24: O-ring and backup ring installed on piston

O-ring

Backup ring

13. Apply the food-grade lubricant to the small outside diameter of the piston.

Figure 9–25: Location of lubricant application

Apply food-grade lubricant here

14. Install the piston into the cylinder, and then place the piston/cylinder assembly into the
regulator cavity.
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Figure 9–26: Piston installed in cylinder

Cylinder

Piston

Figure 9–27: Piston/cylinder installed in MBPR cavity

Piston assembly

Cylinder

MBPR body

15. Place the lower spring guide onto the end of the piston.

Figure 9–28: Lower spring guide on end of piston
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Lower spring guide

MBPR body

16. Place the range spring on the lower spring guide.

Figure 9–29: Range spring on lower spring guide

Range spring

Location of lower spring guide

17. Place a small amount of food-grade lubricant on the outer threads of the regulator body.

18. Place the spring housing assembly over the regulator body and engage the threads by
hand. Hand-tighten the spring housing assembly.

Notice: To avoid shearing off the bolts that secure the manual back-pressure
regulator body to the shelf, do not overtighten the spring housing assembly.

19. Use the 2-1/4-inch open-end wrench to tighten the spring housing assembly an additional
1/2-turn.

20. Apply pressure and check for leaks.

Tips: 

• If you detect a fitting leak, tighten the leaking fittings as necessary.

• If you detect a CO2 leak on the MBPR, this indicates that the O-ring or backup ring is
damaged. To repair the leak, repeat the MBPR rebuild procedure.
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9.5.5 Cleaning the view cell
Use the view cell to inspect for carryover from the cyclone separator or view cell to the CO2

recycler. Liquid CO2 or dark material in the view cell lens indicates carryover to the recycler.
Clean the view cell, and then adjust the temperature and pressures on cyclone separator 3 (CS3)
so that only CO2 gas appears in the view cell lens.

Note: Generally, increasing the temperature or decreasing the pressure in CS3 will decrease the
CO2 density, decreasing its solvating power and causing material that was being carried over to
the recycler to precipitate in CS3.

Required tools and materials

• 1-1/2-inch spanner wrench

• 9/16-inch open-end wrench

• Food-grade ethanol (for cleaning a view cell in a system extracting compounds from botanical
products)

• Methanol (for cleaning a view cell in a system extracting compounds from non-botanical
products)

To clean the view cell:

1. Depressurize the system and then wait 15 minutes to dissipate all pressure from the
cyclone separators.

2. Use the 9/16-inch open-end wrench to loosen the two fittings that secure the view cell
assembly to the back-side of the manual back-pressure regulator (MBPR) on CS3, and
then remove the assembly.

Figure 9–30: View cell installed in system
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MBPR3

View cell assembly

Fittings

3. Use the 1-1/2-inch spanner wrench to loosen the view cell lens cover on each side of the
view cell, and remove the covers.

Figure 9–31: Spanner wrench on view cell lens cover

View cell lens cover

Spanner wrench

View cell lens cover

4. Remove both view cell lenses from the view cell and clean them with 95% food-grade
ethanol.

Figure 9–32: View cell lens and O-ring

Lens

O-ring
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5. Inspect the O-rings on each lens and replace them if necessary.

6. Reinstall the lenses and O-rings in the view cell.

7. Screw each lens cover onto the view cell, and then use the 1-1/2-inch spanner wrench to
tighten them.

8. Use the 9/16-inch open-end wrench to reinstall the view cell assembly on the back-side of
MBPR3.

9.5.6 Checking the CO₂ recycler for carryover
Visible liquid CO2 or dark material in the view cell lens indicates carryover to the CO2 recycler.
Clean the view cell, and then check the CO2 recycler for carryover.

To check the CO2 recycler for carryover:

1. Place a paper towel under the CO2 recycler drain port, and then partially open and close its
manual drain valve repeatedly to expel any sample carryover.

Figure 9–33: CO2 recycler manual drain valve

1

Drain valve handle

Drain port

2. If sludge is visible on the paper towel, perform the Level 1 cleaning procedure (see
Performing the Level 1 cleaning procedure).
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9.5.7 Servicing the CO₂ inlet filter
An in-line filter in the CO2 inlet line helps prevent particles from entering the system and
damaging components such as check valves. A clogged filter restricts flow to the pump,
diminishing its performance. Clean or replace the CO2 inlet filter as part of a scheduled
maintenance routine or whenever a clogged filter restricts CO2 flow.

Warning: To avoid serious injury, including asphyxiation, that can result from
disconnecting a pressurized CO2 line, before disconnecting the line from the CO2

source, stop the flow of CO2 from the system, and shut the valve at the CO2 supply.

Required tools and materials

• 3/4-inch open-end wrench

• Food-grade ethanol (if cleaning)

• Ultrasonic bath

• CO2 inlet filter (if replacing)

• CO2 inlet filter seal (if replacing)

To service the inlet filter:

1. Close the CO2 recycler outlet (isolation) valve.

Figure 9–34: CO2 recycler outlet (isolation) valve

Bottom of CO2 recycler

CO2 recycler outlet (isolation) valve handle

2. On the ChromScope main page, set the CO2 flow to 30 g/min until it shuts down.

Result: This will drain the CO2 from the filter tubing and inlet.

3. Locate the CO2 inlet filter assembly where the CO2 supply connects to the system.
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Figure 9–35: CO2 inlet filter assembly

4. Use a 3/4-inch open-end wrench to loosen and remove the cover of the inlet filter.
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Figure 9–36: CO2 inlet filter assembly exploded view

Place the 3/4-inch open-end wrench here

Inlet filter cover

Inlet filter

5. Remove the inlet filter from the inlet filter housing, and then do one of the following:

• If the filter is partially blocked, sonicate the filter in 95% food-grade ethanol for 20
minutes, and then reinstall it.

• If the filter is completely blocked, replace the filter, and perform the level 3 cleaning
procedure.

Tip: A partially or completely blocked filter indicates that the CO2 source might be
contaminated with particulate matter.
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6. Replace and tighten the inlet filter cover.

7. Open the valve to the CO2 supply source, and inspect the inlet filter assembly for leaks.

9.6 Performing the Level 2 cleaning procedure on a system
without a co-solvent pump
Perform the Level 2 cleaning procedure after every use and before you run a material that
significantly differs from the last material run.

Tip: Ensure that you have all of the required tools and materials in stock before performing this
procedure.

Required tools and materials

• 9/16-inch open-end wrench

• Compressed air

• Food-grade ethanol (1 L)

• Heat gun

• Large, adjustable wrench

• Soft bristle brush

• Ultrasonic bath

• Wash bottle

Performing the Level 2 cleaning procedure on a system without a co-solvent
pump involves these steps:

1. Preparing the system.

2. Flushing the system.

3. Cleaning the cyclone separators and their tubing.

4. Cleaning the manual back-pressure regulators.

5. Cleaning the view cell.

6. Checking the CO2 recycler for carryover.

7. Servicing the CO2 filter.
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9.6.1 Preparing a system without a co-solvent pump for cleaning

Required tools and materials

• 9/16-inch open-end wrench

• Food-grade ethanol (500 mL)

To prepare a system without a co-solvent pump for cleaning:

1. Prepare a solvent reservoir of 500 mL 95% food-grade ethanol and place the pump siphon
tube into it.

2. Ensure that there is no botanical material in the extraction vessels.

Note: You can use marbles or other inert material to fill the void in the extraction vessels.
Doing so fills the system with CO2 faster.

3. Slowly open the drain valves in the order of cyclone separator 3 (CS3), cyclone separator 2
(CS2) and cyclone separator 1 (CS1), to bleed off residual CO2.

Figure 9–37: Cyclone separator drain valves

CS1 drain valve

CS2 drain valve

CS3 drain valve

4. Use the 9/16-inch open-end wrench to slowly disconnect the stainless steel flex line from
the CO2 recycler to prevent co-solvent from getting into the recycler.
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Figure 9–38: Stainless steel flex line and CO2 recycler exhaust inlet

Stainless steel flex line

Exhaust inlet atop CO2 recycler

5. Route the stainless steel flex line to a suitable exhaust system.

9.6.2 Flushing the system

To flush the system:

1. In the ChromScope software, set the CO2 flow to 80 g/min.

Note: You might need to fill the CO2 recycler during this procedure.

2. If your system has a co-solvent pump, set the flow to 20 mL/min.

3. Set the automated back-pressure regulator (ABPR) to 19,995 kPa (200 bar, 2900 psi).

4. Set the extracting solvent heat exchanger (HE2) temperature to 70 °C.

5. Set the extraction vessel temperature to 60 °C.

6. Set the cyclone separator 3 (CS3) manual back-pressure regulator (MBPR) to 2068 kPa
(21 bar, 300 psi).

Important: Do not change the other cyclone separator settings.
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Figure 9–39: Location of CS3 MBPR and pressure gauge

CS3 MBPR

CS3 pressure gauge

7. Ensure that the cyclone separator temperature settings are specified as follows:

• CS1: 60 °C

• CS2: 60 °C

• CS3: 35 °C

8. If your system has a co-solvent pump:

a. Start the CO2 and co-solvent pumps and allow the flow to continue for approximately
25 minutes.

b. After 25 minutes, stop the co-solvent pump and continue the CO2 flow for 1 hour, to
flush any residual ethanol out of the lines.

9. If your system does not have a co-solvent pump, start the CO2 pump and allow the flow to
continue for 85 minutes.

10. Open the drain valves on the cyclone separators (CS1, CS2, and CS3) slowly, to allow the
ethanol to drain completely.
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Figure 9–40: Cyclone separator drain valves

CS1 drain valve

CS2 drain valve

CS3 drain valve

11. After the ethanol drains, increase the pressure on CS3 to 2068 kPa (21 bar, 300 psi).

12. Depressurize the extraction vessel in 1999 kPa/min (20 bar/min, 290 psi/min) increments,
to the pressure of CS1.

13. Slowly re-open the drain valves on CS1, CS2, and CS3 to verify that all the ethanol is
drained from the system.

14. After the ethanol drains completely, close the drain valves on CS1, CS2, and CS3.

15. Stop the CO2 pump, power-off the heaters, and bleed off the extraction vessel.

16. Set the temperature of CS1, CS2, and CS3 to 45 °C.

17. Slowly reduce the pressure (counterclockwise) on CS1 MBPR at a rate of 1999 kPa/min
(20 bar/min, 290 psi/min), until it reaches the pressure of CS2.
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Figure 9–41: CS1 MBPR and pressure gauges

CS1 MBPR

CS2 pressure gauge

CS1 pressure gauge

18. Slowly reduce the pressure on CS2 MBPR until it reaches the pressure of CS3.

19. Slowly open the drain valve on CS3 and continue to remove the residual CO2.

20. While the CS3 is draining, open the MBPRs on CS1 and CS2 completely.

9.6.3 Cleaning the cyclone separators and tubing

Required tools and materials

• 9/16-inch open-end wrench

• Food-grade ethanol

• Heat gun

• 2-1/4-inch open-end wrench

• Soft bristle brush with 3-inches bristles

• Ultrasonic bath (optional)

• Wash bottle
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To clean the cyclone separators and tubing:

1. Confirm the system is at atmospheric pressure and that the CO2 pump and co-solvent
pump (if present) are powered-off.

Tip: When the system reaches atmospheric pressure, the pressure reading on cyclone
separator 3 (CS3) is zero.

2. In the ChromScope software, set the temperature of each cyclone separator to 40 °C.

3. Label the tubing and each cyclone separator cap as CS1, CS2, and CS3.

4. Use the 9/16-inch open-end wrench to slowly remove the 1/4-inch tubing that connects
each cyclone separator outlet to its respective manual back-pressure regulator (MBPR)
inlet.

Figure 9–42: Manual back-pressure regulator inlet, tubing, and cyclone separator
outlet

Manual back-pressure regulator inlet

Tubing

Cyclone separator outlet

5. Use a wash bottle of 95% food-grade ethanol to clean all of the tubing.

Tip: If the tubing is severely clogged, sonicate it with 95% food-grade ethanol.

6. Remove the cyclone separator caps.

Tip: If the cyclone separator cap will not turn, use the 2-1/4-inch open-end wrench to
loosen it.

7. Inspect the O-ring on each cap and replace it if necessary.
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Figure 9–43: Underside of cyclone separator cap and O-ring

O-ring

Underside of cap

8. Clean the underside of each cap with the wash bottle and rag (or paper towels).

9. Squirt 95% food-grade ethanol into the outlet fittings, located on the top of each cyclone
separator cap.

Figure 9–44: Location of outlet fitting on cyclone separator cap

Outlet fitting

10. Close each cyclone separator drain valve.

Note: The ethanol exits out of the tube on the underside of the cap.
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Figure 9–45: Tube on underside of cyclone separator cap

Underside of cap

Tube

11. Place a beaker under each of the cyclone separator drain lines.

12. Squirt approximately 300 mL of 95% food-grade ethanol along the interior walls in each
cyclone separator.

Figure 9–46: Cyclone separator interior wall

Interior wall

13. Scrub the interior walls of each cyclone separator using a soft-bristle brush.
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Soft-bristle brush

Interior wall

14. After approximately 5 to 10 minutes of soaking, open each cyclone separator drain valve.

Tip: If there is wax in the cyclone separator drain valve at the beginning of the cleaning
process, use a heat gun to melt it.

15. When the ethanol begins to drain, continuously squirt 95% food-grade ethanol along the
interior walls of each cyclone separator until it runs clear.

16. Turn off the cyclone separator heaters.

17. Close each cyclone separator drain valve.

Figure 9–47: Cyclone separator drain valves
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CS1 drain valve

CS2 drain valve

CS3 drain valve

18. Reinstall the cyclone separator caps and tubing to their labeled positions.

Requirement: Set all the MBPRs to their original values at system startup.

19. Reconnect the stainless steel flex line from the CO2 recycler.

9.6.4 Cleaning the manual back-pressure regulators
Clean the manual back-pressure regulators (MBPRs) whenever carryover is observed in the CO2

recycler.

Required tools and materials

• 2-1/4-inch open-end wrench

• Compressed air

• Food-grade ethanol

• Food-grade lubricant

• 13,790 kPa (138 bar, 2000 psi) or 41,369 kPa (414 bar, 6000 psi) MBPR rebuild kit

To clean the manual back-pressure regulators:

1. Relieve all pressure from the system.

2. Turn the large, blue knob on the top of the MBPR fully counterclockwise to reduce the
pressure.
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Figure 9–48: Blue knob on MBPR

Blue knob

3. Use the 2-1/4-inch open-end wrench to loosen and remove the spring housing from the
regulator body.

Note: The range spring will fall out of the spring housing when the housing is removed
from the regulator body.

Figure 9–49: Location of wrench placement on MBPR body

Spring housing

Place the 2-1/4-inch open-end wrench here

Regulator body

4. Remove the lower spring guide and piston/cylinder assembly.
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Figure 9–50: Lower spring guide and piston/cylinder assembly

Lower spring guide

Piston/cylinder assembly

5. Carefully remove the cavity O-ring from the regulator body and discard it.

Figure 9–51: Location of cavity O-ring

Cavity O-ring

6. Thoroughly clean the cavity body with 95% food-grade ethanol.

7. Blow out any remaining solvent with clean, dry, compressed air.

8. Install a new cavity O-ring in the groove inside the regulator body.

9. Use your thumb to press the piston assembly out of the cylinder.

February 21, 2018, 715004757 Rev. D
Page 190



Figure 9–52: Location of thumb placement for piston assembly removal

Cylinder

Press thumb here

10. Remove the O-ring and backup ring from the piston assembly and discard them.

Figure 9–53: Piston assembly backup ring and O-ring

Piston assembly

Backup ring

O-ring

11. Install the small O-ring over the piston assembly.

12. Install the backup ring over the piston assembly by sliding it all the way against the O-ring.
Ensure that the O-ring and backup ring are oriented correctly, with the O-ring on first, and
the backup ring on second.
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Figure 9–54: O-ring and backup ring installed on piston

O-ring

Backup ring

13. Apply the food-grade lubricant to the small outside diameter of the piston.

Figure 9–55: Location of lubricant application

Apply food-grade lubricant here

14. Install the piston into the cylinder, and then place the piston/cylinder assembly into the
regulator cavity.
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Figure 9–56: Piston installed in cylinder

Cylinder

Piston

Figure 9–57: Piston/cylinder installed in MBPR cavity

Piston assembly

Cylinder

MBPR body

15. Place the lower spring guide onto the end of the piston.

Figure 9–58: Lower spring guide on end of piston
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Lower spring guide

MBPR body

16. Place the range spring on the lower spring guide.

Figure 9–59: Range spring on lower spring guide

Range spring

Location of lower spring guide

17. Place a small amount of food-grade lubricant on the outer threads of the regulator body.

18. Place the spring housing assembly over the regulator body and engage the threads by
hand. Hand-tighten the spring housing assembly.

Notice: To avoid shearing off the bolts that secure the manual back-pressure
regulator body to the shelf, do not overtighten the spring housing assembly.

19. Use the 2-1/4-inch open-end wrench to tighten the spring housing assembly an additional
1/2-turn.

20. Apply pressure and check for leaks.

Tips: 

• If you detect a fitting leak, tighten the leaking fittings as necessary.

• If you detect a CO2 leak on the MBPR, this indicates that the O-ring or backup ring is
damaged. To repair the leak, repeat the MBPR rebuild procedure.
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9.6.5 Cleaning the view cell
Use the view cell to inspect for carryover from the cyclone separator or view cell to the CO2

recycler. Liquid CO2 or dark material in the view cell lens indicates carryover to the recycler.
Clean the view cell, and then adjust the temperature and pressures on cyclone separator 3 (CS3)
so that only CO2 gas appears in the view cell lens.

Note: Generally, increasing the temperature or decreasing the pressure in CS3 will decrease the
CO2 density, decreasing its solvating power and causing material that was being carried over to
the recycler to precipitate in CS3.

Required tools and materials

• 1-1/2-inch spanner wrench

• 9/16-inch open-end wrench

• Food-grade ethanol (for cleaning a view cell in a system extracting compounds from botanical
products)

• Methanol (for cleaning a view cell in a system extracting compounds from non-botanical
products)

To clean the view cell:

1. Depressurize the system and then wait 15 minutes to dissipate all pressure from the
cyclone separators.

2. Use the 9/16-inch open-end wrench to loosen the two fittings that secure the view cell
assembly to the back-side of the manual back-pressure regulator (MBPR) on CS3, and
then remove the assembly.

Figure 9–60: View cell installed in system
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MBPR3

View cell assembly

Fittings

3. Use the 1-1/2-inch spanner wrench to loosen the view cell lens cover on each side of the
view cell, and remove the covers.

Figure 9–61: Spanner wrench on view cell lens cover

View cell lens cover

Spanner wrench

View cell lens cover

4. Remove both view cell lenses from the view cell and clean them with 95% food-grade
ethanol.

Figure 9–62: View cell lens and O-ring

Lens

O-ring
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5. Inspect the O-rings on each lens and replace them if necessary.

6. Reinstall the lenses and O-rings in the view cell.

7. Screw each lens cover onto the view cell, and then use the 1-1/2-inch spanner wrench to
tighten them.

8. Use the 9/16-inch open-end wrench to reinstall the view cell assembly on the back-side of
MBPR3.

9.6.6 Checking the CO₂ recycler for carryover
Visible liquid CO2 or dark material in the view cell lens indicates carryover to the CO2 recycler.
Clean the view cell, and then check the CO2 recycler for carryover.

To check the CO2 recycler for carryover:

1. Place a paper towel under the CO2 recycler drain port, and then partially open and close its
manual drain valve repeatedly to expel any sample carryover.

Figure 9–63: CO2 recycler manual drain valve

1

Drain valve handle

Drain port

2. If sludge is visible on the paper towel, perform the Level 1 cleaning procedure (see
Performing the Level 1 cleaning procedure).
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9.6.7 Servicing the CO₂ inlet filter
An in-line filter in the CO2 inlet line helps prevent particles from entering the system and
damaging components such as check valves. A clogged filter restricts flow to the pump,
diminishing its performance. Clean or replace the CO2 inlet filter as part of a scheduled
maintenance routine or whenever a clogged filter restricts CO2 flow.

Warning: To avoid serious injury, including asphyxiation, that can result from
disconnecting a pressurized CO2 line, before disconnecting the line from the CO2

source, stop the flow of CO2 from the system, and shut the valve at the CO2 supply.

Required tools and materials

• 3/4-inch open-end wrench

• Food-grade ethanol (if cleaning)

• Ultrasonic bath

• CO2 inlet filter (if replacing)

• CO2 inlet filter seal (if replacing)

To service the inlet filter:

1. Close the CO2 recycler outlet (isolation) valve.

Figure 9–64: CO2 recycler outlet (isolation) valve

Bottom of CO2 recycler

CO2 recycler outlet (isolation) valve handle

2. On the ChromScope main page, set the CO2 flow to 30 g/min until it shuts down.

Result: This will drain the CO2 from the filter tubing and inlet.

3. Locate the CO2 inlet filter assembly where the CO2 supply connects to the system.
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Figure 9–65: CO2 inlet filter assembly

4. Use a 3/4-inch open-end wrench to loosen and remove the cover of the inlet filter.
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Figure 9–66: CO2 inlet filter assembly exploded view

Place the 3/4-inch open-end wrench here

Inlet filter cover

Inlet filter

5. Remove the inlet filter from the inlet filter housing, and then do one of the following:

• If the filter is partially blocked, sonicate the filter in 95% food-grade ethanol for 20
minutes, and then reinstall it.

• If the filter is completely blocked, replace the filter, and perform the level 3 cleaning
procedure.

Tip: A partially or completely blocked filter indicates that the CO2 source might be
contaminated with particulate matter.
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6. Replace and tighten the inlet filter cover.

7. Open the valve to the CO2 supply source, and inspect the inlet filter assembly for leaks.

9.7 Performing the Level 3 cleaning procedure on a system
with an automation module
This procedure, which involves cleaning the CO2 cooling heat exchanger (HE1), the extracting
solvent heat exchanger (HE2), the inlet tubing, and the flow meter (FM), is intended for systems
that include an automation module, but do not include a co-solvent pump.

Warning: Observe Good Laboratory Practice (GLP) at all times, particularly when
working with hazardous materials. Consult the Material Safety Data Sheets regarding
the solvents you use. Additionally, consult the safety representative for your
organization regarding its protocols for handling such materials.

Warning: To avoid serious injury or death from CO2 vapors, ensure that the room
containing the system is well ventilated. The ventilation system must provide an air
exchange rate of four rooms per hour.

 

Warning: To avoid personal contamination with biologically hazardous or toxic compounds,
wear clean, chemical-resistant, powder-free gloves when performing this procedure.

Warning: To avoid electrical shock, power-off and unplug each module before
performing any maintenance operation on it.

Warning: To avoid eye injury, use eye protection when performing this procedure.

Requirement: Wear clean, chemical-resistant, powder-free gloves when performing
this procedure.

Requirement: Use eye protection when performing this procedure.

Perform the Level 3 cleaning procedure:

• After every six extractions of heavy-wax material

• After every ten extractions of low‐wax material

• Before running a material that differs substantially from the last material run

• After running any material suspected of being contaminated with pesticides or mold

• When the CO2 inlet density is too low (less than 0.87 g/cm3), but the CO2 recycler pressure is
within an acceptable range of 4654 to 5171 kPa (47 to 52 bar, 675 to 750 psi)
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Tip: Ensure that you have all of the required tools and materials in stock before performing this
procedure.

Required tools and materials

• Chemical-resistant, powder-free gloves

• Protective eyewear

• 3/8-inch open-end wrench

• 7/16-inch open-end wrench

• 1/2-inch open-end wrench

• 1/8-inch Stainless steel tubing cutter

• Handheld terminal (included in system startup kit)

• RS-232 adapter (included in system startup kit)

• 1/8-inch compression fitting nut

• 1/8-inch compression fitting ferrule set

• 1/8-inch tubing, Teflon inlet with filter, and 1/8-inch Valco type fitting

• 1/8-inch union

• Food-grade ethanol or 50:50 Food-grade ethanol/Water (4 L)

• 4-L bottle (2)

Performing the Level 3 cleaning procedure involves these steps:

1. Preparing the system for cleaning.

2. Cleaning the flow path.

3. Verifying the system.

9.7.1 Preparing a system with an automation module for cleaning

Warning: Observe Good Laboratory Practice (GLP) at all times, particularly when
working with hazardous materials. Consult the Material Safety Data Sheets regarding
the solvents you use. Additionally, consult the safety representative for your
organization regarding its protocols for handling such materials.

Warning: To avoid serious injury or death from CO2 vapors, ensure that the room
containing the system is well ventilated. The ventilation system must provide an air
exchange rate of four rooms per hour.
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Warning: To avoid personal contamination with biologically hazardous or toxic compounds,
wear clean, chemical-resistant, powder-free gloves when performing this procedure.

Warning: To avoid eye injury, use eye protection when performing this procedure.

Requirement: Wear clean, chemical-resistant, powder-free gloves when performing
this procedure.

Requirement: Use eye protection when performing this procedure.

Required tools and materials

• Chemical-resistant, powder-free gloves

• Protective eyewear

• 3/8-inch open-end wrench

• 7/16-inch open-end wrench

• Food-grade ethanol

• Handheld terminal (included in system startup kit)

• RS-232 adapter (included in system startup kit)

To prepare the system for cleaning:

1. Turn off the CO2 supply by closing the manual CO2 supply valve on the CO2 recycler, the
CO2 tank valve, or the external CO2 supply valve.

2. Ensure the extraction vessel 1 (EV1) pressure gauge displays 0 kPa, (0 bar, 0 psi). If
necessary, carefully drain any residual pressure from the extraction vessel by slowly
opening its exhaust valve (MV6).
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Figure 9–67: Location of MV6 valve on back side of extraction vessel

Location of MV6 valve

3. Use the 3/8‐inch open-end wrench to disconnect the outlet tubing from the extracting
solvent heat exchanger 2 (HE2).

4. Connect a length of 1/8‐inch tubing with a 3/8‐inch fitting to the HE2 outlet, and then
tighten the fitting with the 3/8-inch open-end wrench.

Figure 9–68: Tubing in HE2 outlet

1/8-inch tubing with 3/8-inch fitting in HE2 outlet

Disconnected HE2 outlet tubing

5. Use the 3/8-inch open-end wrench to connect the other end of the tubing to the CO2 inlet
at the rear of the cart.
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Figure 9–69: Location of CO2 inlet

CO2 inlet

6. Set the chiller temperature to 38 °C.

Note: The chiller is used with the CO2 pump and CO2 cooling heat exchanger 1 (HE1).

Tip: Allow a minimum of 20 minutes for the chiller to reach the set temperature. To set the
temperature, see the manufacturer instructions that were shipped with the chiller.

7. Close the CO2 recycler outlet (isolation) valve to isolate the recycler from the system.

Figure 9–70: CO2 recycler outlet (isolation) valve

Bottom of CO2 recycler

CO2 recycler outlet (isolation) valve handle

8. Exit ChromScope.

9. At the CO2 pump inlet tee, use the 7/16-inch open end wrench to loosen the nut on the left
side of the tee, and then remove the tubing clamp to allow the pump inlet tubing to rotate.
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Figure 9–71: Location of tubing clamp and nut on left side of CO2 pump inlet tee

Tubing clamp

CO2 pump inlet tubing

Left-side nut

10. At the CO2 pump inlet tee, remove the inlet tube, and then rotate the line and place it in an
empty beaker to collect the solvent.

Figure 9–72: Removing inlet tube from CO2 pump inlet tee

CO2 pump inlet tee

Inlet tube
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11. Re-tighten the nut on the left side of the CO2 pump inlet tee.

Warning: To avoid injuries arising from contact with spilled solvent, ensure that
the solvent bottle is stable.

12. Connect a small, 1/8‐inch tube to the CO2 pump inlet tee, and then insert the other end of
the tube into a 4‐L bottle of 95% food-grade ethanol.

Figure 9–73: Removing inlet tube from CO2 pump inlet tee

CO2 pump inlet tee

Small, 1/8-inch tube

13. Disconnect the RS‐232 cable (marked P0) from the port on the right-side, rear of the CO2

pump, and then connect the handheld terminal cable to this port.

Requirement: If this is the first time using the handheld terminal, you must connect the
RS-232 adapter (included in the system startup kit).
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Figure 9–74: Handheld terminal cable in RS-232 port

Handheld terminal cable

14. Power‐on the CO2 pump by pressing the switch at the rear of the pump.

Result: The pump emits a beep, verifying that it recognizes the handheld terminal.

15. Verify that the chiller is at the set temperature of 38 °C.

Requirement: Do not proceed to the next step until the chiller temperature is 38 °C.

16. On the handheld terminal, press F1, and then enter an alarm value of 200.

17. Move the handheld terminal to a location near the extraction vessel inlet valve (MV2), and
then prime the pump:

a. On the handheld terminal, press F2, and then press E.

b. Enter a flow rate of 25 ml, and then press ENTER.

Warning: To avoid injuries arising from contact with spilled solvent, use a cloth
to collect the solvent as it begins to exit the MV2 port that was formerly attached
to extraction vessel 1.

18. When ethanol begins to exit the extraction vessel 1 inlet valve port (MV2–V1), press F5 on
the handheld terminal.

Result: The CO2 pump is now primed.

19. Quickly power-off the CO2 pump by pressing the switch located at the rear of the unit.
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9.7.2 Cleaning the flow path

Warning: Observe Good Laboratory Practice (GLP) at all times, particularly when
working with hazardous materials. Consult the Material Safety Data Sheets regarding
the solvents you use. Additionally, consult the safety representative for your
organization regarding its protocols for handling such materials.

Warning: To avoid serious injury or death from CO2 vapors, ensure that the room
containing the system is well ventilated. The ventilation system must provide an air
exchange rate of four rooms per hour.

 

Warning: To avoid personal contamination with biologically hazardous or toxic compounds,
wear clean, chemical-resistant, powder-free gloves when performing this procedure.

Warning: To avoid eye injury, use eye protection when performing this procedure.

Requirement: Wear clean, chemical-resistant, powder-free gloves when performing
this procedure.

Requirement: Use eye protection when performing this procedure.

Required tools and materials:

• Chemical-resistant, powder-free gloves

• Protective eyewear

• 3/8-inch open-end wrench

To clean the flow path:

1. Use the 3/8-inch open-end wrench to disconnect the outlet fitting from the CO2 recycler
outlet (isolation) valve and connect it to the MV2 vessel 1 inlet port (MV2-V1).
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Figure 9–75: CO2 recycler outlet (isolation) valve fitting

Bottom of CO₂ recycler

CO₂ recycler outlet (isolation) valve from the recycle tank to the 5 µM filter, before the
mass flow controller

Outlet fitting

Figure 9–76: Location of MV2 valve on module cart

Location of MV2 valve

Figure 9–77: Fitting connected to MV2-V1 inlet port

MV2V
2 V1
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Fitting connected to MV2-V1 inlet port

2. On the handheld terminal, press F2, then press E, enter a flow rate of 5, and then press 
Enter.

Note: The ethanol flows through the CO2 pump (P-200 pump), extracting solvent heat
exchanger (HE2), needle valve (MV2) on extraction vessel 1, inlet line, inlet filter, union,
CO2 cooling heat exchanger (HE1), and flow meter (FM).

Figure 9–78: Level 3 cleaning flow path

Extraction
vessel 1

Extraction
vessel 2

MV2/V1

HE2

FM

Waste Ethanol

HE1

Inlet CO2
solenoid valve

Inlet CO2
filter
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Legend:

Cleaning flow path

3. Periodically swap waste containers to determine when the ethanol begins to clear,
indicating a clear flow path.

4. When the effluent is clear for 5 minutes, press F5 to stop the CO2 pump.

5. Use the 3/8-inch open-end wrench to disconnect the fitting from the MV2-V1 inlet port, and
reconnect it to the CO2 recycler outlet (isolation) valve.

Figure 9–79: CO2 recycler outlet (isolation) valve fitting

Bottom of CO2 recycler

CO2 recycler outlet (isolation) valve from the recycle tank to the 5 µM filter, before the
mass flow controller

Outlet fitting

6. Set the chiller temperature to 3 °C.

Requirement: Do not proceed to the next step until the chiller is at the set temperature of
3 °C.

7. Remove the 1/8‐inch tube from the pump inlet tee and reconnect the inlet tube to the tee.

Tip: Loosen the left nut on the tee before the pump.
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Figure 9–80: Reconnecting inlet tube to CO2 pump inlet tee

CO2 pump inlet tee

Inlet tube

8. Open the outlet valve on the CO2 recycler.

Figure 9–81: CO2 recycler outlet (isolation) valve

Bottom of CO2 recycler

CO2 recycler outlet (isolation) valve handle

9. On the handheld terminal, press F2, then press E, enter a flow rate of 5, and then press 
Enter.

10. When the CO2 begins to exit from the MV2-V1 inlet port, press F5 to stop the CO2 pump.

11. Power-off the CO2 pump by pressing the switch located at the rear of the unit.

12. Disconnect the handheld terminal from the port on the right-side, rear of the CO2 pump,
and then reconnect the RS-232 cable.
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9.7.3 Verifying the system

To verify the system:

1. Power on the CO2 pump and wait for the diagnostic routine to complete.

Note: The diagnostic routine takes 20 to 30 seconds to complete.

2. Reconnect the inlet line from extraction vessel 1 to the MV2 vessel 1 inlet port (MV2/V1).

3. Run the system for 2 minutes at a flow rate of 50 g/min to ensure that the system is
working correctly and that all modules are recognized.

9.8 Performing the Level 3 cleaning procedure on a system
without an automation module
This procedure is intended for systems that do not include an automation module or a co-solvent
pump.

Warning: Observe Good Laboratory Practice (GLP) at all times, particularly when
working with hazardous materials. Consult the Material Safety Data Sheets regarding
the solvents you use. Additionally, consult the safety representative for your
organization regarding its protocols for handling such materials.

Warning: To avoid serious injury or death from CO2 vapors, ensure that the room
containing the system is well ventilated. The ventilation system must provide an air
exchange rate of four rooms per hour.

 

Warning: To avoid personal contamination with biologically hazardous or toxic compounds,
wear clean, chemical-resistant, powder-free gloves when performing this procedure.

Warning: To avoid electrical shock, power-off and unplug each module before
performing any maintenance operation on it.

Warning: To avoid eye injury, use eye protection when performing this procedure.

Requirement: Wear clean, chemical-resistant, powder-free gloves when performing
this procedure.

Requirement: Use eye protection when performing this procedure.

Perform the Level 3 cleaning procedure:
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• After every six extractions of heavy-wax material

• After every ten extractions of low‐wax material

• Before running a material that differs substantially from the last material run

• After running any material suspected of being contaminated with pesticides or mold

• When the CO2 inlet density is too low (less than 0.87 g/cm3) but the CO2 recycler pressure is
within an acceptable range 4654 to 5171 kPa (47 to 52 bar, 675 to 750 psi)

Tip: Ensure that you have all of the required tools and materials in stock before performing this
procedure.

Required tools and materials

• Chemical-resistant, powder-free gloves

• Protective eyewear

• 3/8-inch open-end wrench

• 7/16-inch open-end wrench

• 1/2-inch open-end wrench

• 1/8-inch Stainless steel tubing cutter

• Handheld terminal (included in system startup kit)

• RS-232 adapter (included in system startup kit)

• 1/8-inch compression fitting nut

• 1/8-inch compression fitting ferrule set

• 1/8-inch tubing, Teflon inlet with filter, and 1/8-inch Valco type fitting

• 1/8-inch union

• Food-grade ethanol or 50:50 Food-grade ethanol/Water (4 L)

• 4-L bottle (2)

Performing the Level 3 cleaning procedure involves these steps:

1. Preparing the system for cleaning.

2. Cleaning the flow path.

3. Verifying the system.
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9.8.1 Preparing a system without an automation module for cleaning

Warning: Observe Good Laboratory Practice (GLP) at all times, particularly when
working with hazardous materials. Consult the Material Safety Data Sheets regarding
the solvents you use. Additionally, consult the safety representative for your
organization regarding its protocols for handling such materials.

Warning: To avoid serious injury or death from CO2 vapors, ensure that the room
containing the system is well ventilated. The ventilation system must provide an air
exchange rate of four rooms per hour.

 

Warning: To avoid personal contamination with biologically hazardous or toxic compounds,
wear clean, chemical-resistant, powder-free gloves when performing this procedure.

Warning: To avoid eye injury, use eye protection when performing this procedure.

Requirement: Wear clean, chemical-resistant, powder-free gloves when performing
this procedure.

Requirement: Use eye protection when performing this procedure.

Required tools and materials

• Chemical-resistant, powder-free gloves

• Protective eyewear

• 7/16-inch open-end wrench

• 1/2-inch open-end wrench

• Food-grade ethanol

• Handheld terminal (included in system startup kit)

• RS-232 adapter (included in system startup kit)

To prepare the system for cleaning:

1. Set the chiller temperature to 38 °C.

Note: The chiller is used with the CO2 pump and CO2 cooling heat exchanger 1 (HE1).

Tip: Allow a minimum of 20 minutes for the chiller to reach the set temperature. To set the
temperature, see the manufacturer instructions that were shipped with the chiller.

2. Close the inlet and outlet valves to extraction vessel 2 (MV2–V1 and MV2–V2) to isolate
that extraction vessel from the system.
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Figure 9–82: Location of MV2 valve on module cart

Location of MV2 valve

Figure 9–83: MV2–V1 and MV2–V2 valve handles

MV2V
2 V1

MV2–V2 valve handle

MV2–V1 valve handle

3. Ensure the extraction vessel 1 (EV1) pressure gauge displays 0 kPa, (0 bar, 0 psi). If
necessary, carefully drain any residual pressure from the extraction vessel by slowly
opening its exhaust valve (MV6).

Figure 9–84: Location of MV6 valve on back side of extraction vessel
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Location of MV6 valve

4. Close the CO2 recycler's supply (isolation) valve to isolate the recycler from the system.

Figure 9–85: CO2 supply (isolation) valve

Bottom of CO2 recycler

CO2 supply (isolation) from the recycle tank to the 5 μM filter, before the mass flow
controller

5. Exit ChromScope.

6. Use the 1/2-inch open-end wrench to remove the fitting from the MV2 vessel 1 inlet port.

Figure 9–86: Fitting connected to MV2–V1 inlet port

MV2V
2 V1

Fitting connected to MV2–V1 inlet port

7. Open the inlet valve to extraction vessel 1 (MV2–V1).

8. At the CO2 pump inlet tee, use the 7/16-inch open-end wrench to loosen the nut on the left
side of the tee, and then remove the tubing clamp to allow the pump inlet tubing to rotate.
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Figure 9–87: Location of tubing clamp and nut on left side of CO2 pump inlet tee

Tubing clamp

CO2 pump inlet tubing

Left-side nut

9. At the CO2 pump inlet tee, remove the inlet tube, then rotate the line and place it in an
empty beaker to collect the solvent.

Figure 9–88: Removing inlet tube from CO2 pump inlet tee

CO2 pump inlet tee

Inlet tube
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10. Re-tighten the nut on the left side of the CO2 pump inlet tee.

Warning: To avoid injuries arising from contact with spilled solvent, ensure that
the solvent bottle is stable.

11. Connect a small, 1/8‐inch tube to the CO2 pump inlet tee, and then insert the other end of
the tube into a 4‐L bottle of 95% food-grade ethanol.

Figure 9–89: Removing inlet tube from CO2 pump inlet tee

CO2 pump inlet tee

Small, 1/8-inch tube

12. Disconnect the RS‐232 cable (marked P0) from the port on the right-side, rear of the CO2

pump, and then connect the handheld terminal cable to this port.

Requirement: If this is the first time using the handheld terminal, you must connect the
RS-232 adapter (included in the system startup kit).
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Figure 9–90: Handheld terminal cable in RS-232 port

Handheld terminal cable

13. Power‐on the CO2 pump by pressing the switch at the rear of the pump.

Result: The pump emits a beep, verifying that it recognizes the handheld terminal.

14. Verify that the chiller is at the set temperature of 38 °C.

Requirement: Do not proceed to the next step until the chiller temperature is 38 °C.

15. On the handheld terminal, press F1, and then enter an alarm value of 200.

16. Move the handheld terminal to a location near the extraction vessel inlet valve (MV2), and
then prime the pump:

a. On the handheld terminal, press F2, and then press E.

b. Enter a flow rate of 25 ml, and then press ENTER.

Warning: To avoid injuries arising from contact with spilled solvent, use a cloth
to collect the solvent as it begins to exit the MV2 port that was formerly attached
to extraction vessel 1.

17. When ethanol begins to exit the extraction vessel 1 inlet valve port (MV2–V1), press F5 on
the handheld terminal.

Result: The CO2 pump is now primed.

18. Quickly power-off the CO2 pump by pressing the switch located at the rear of the unit.
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9.8.2 Cleaning the flow path

Warning: Observe Good Laboratory Practice (GLP) at all times, particularly when
working with hazardous materials. Consult the Material Safety Data Sheets regarding
the solvents you use. Additionally, consult the safety representative for your
organization regarding its protocols for handling such materials.

Warning: To avoid serious injury or death from CO2 vapors, ensure that the room
containing the system is well ventilated. The ventilation system must provide an air
exchange rate of four rooms per hour.

 

Warning: To avoid personal contamination with biologically hazardous or toxic compounds,
wear clean, chemical-resistant, powder-free gloves when performing this procedure.

Warning: To avoid eye injury, use eye protection when performing this procedure.

Requirement: Wear clean, chemical-resistant, powder-free gloves when performing
this procedure.

Requirement: Use eye protection when performing this procedure.

Required tools and materials:

• Chemical-resistant, powder-free gloves

• Protective eyewear

• 3/8-inch open-end wrench

To clean the flow path:

1. Use the 3/8-inch open-end wrench to disconnect the outlet fitting from the CO2 recycler
outlet (isolation) valve and connect it to the MV2 vessel 1 inlet port (MV2-V1).
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Figure 9–91: CO2 recycler outlet (isolation) valve fitting

Bottom of CO₂ recycler

CO₂ recycler outlet (isolation) valve from the recycle tank to the 5 µM filter, before the
mass flow controller

Outlet fitting

Figure 9–92: Location of MV2 valve on module cart

Location of MV2 valve

Figure 9–93: Fitting connected to MV2-V1 inlet port

MV2V
2 V1
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Fitting connected to MV2-V1 inlet port

2. On the handheld terminal, press F2, then press E, enter a flow rate of 5, and then press 
Enter.

Note: The ethanol flows through the CO2 pump (P-200 pump), extracting solvent heat
exchanger (HE2), needle valve (MV2) on extraction vessel 1, inlet line, inlet filter, union,
CO2 cooling heat exchanger (HE1), and flow meter (FM).

Figure 9–94: Level 3 cleaning flow path

Extraction
vessel 1

Extraction
vessel 2

MV2/V1

HE2

FM

Waste Ethanol

HE1

Inlet CO2
solenoid valve

Inlet CO2
filter

February 21, 2018, 715004757 Rev. D
Page 224



Legend:

Cleaning flow path

3. Periodically swap waste containers to determine when the ethanol begins to clear,
indicating a clear flow path.

4. When the effluent is clear for 5 minutes, press F5 to stop the CO2 pump.

5. Use the 3/8-inch open-end wrench to disconnect the fitting from the MV2-V1 inlet port, and
reconnect it to the CO2 recycler outlet (isolation) valve.

Figure 9–95: CO2 recycler outlet (isolation) valve fitting

Bottom of CO2 recycler

CO2 recycler outlet (isolation) valve from the recycle tank to the 5 µM filter, before the
mass flow controller

Outlet fitting

6. Set the chiller temperature to 3 °C.

Requirement: Do not proceed to the next step until the chiller is at the set temperature of
3 °C.

7. Remove the 1/8‐inch tube from the pump inlet tee and reconnect the inlet tube to the tee.

Tip: Loosen the left nut on the tee before the pump.
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Figure 9–96: Reconnecting inlet tube to CO2 pump inlet tee

CO2 pump inlet tee

Inlet tube

8. Open the outlet valve on the CO2 recycler.

Figure 9–97: CO2 recycler outlet (isolation) valve

Bottom of CO2 recycler

CO2 recycler outlet (isolation) valve handle

9. On the handheld terminal, press F2, then press E, enter a flow rate of 5, and then press 
Enter.

10. When the CO2 begins to exit from the MV2-V1 inlet port, press F5 to stop the CO2 pump.

11. Power-off the CO2 pump by pressing the switch located at the rear of the unit.

12. Disconnect the handheld terminal from the port on the right-side, rear of the CO2 pump,
and then reconnect the RS-232 cable.
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9.8.3 Verifying the system

To verify the system:

1. Power on the CO2 pump and wait for the diagnostic routine to complete.

Note: The diagnostic routine takes 20 to 30 seconds to complete.

2. Reconnect the inlet line from extraction vessel 1 to the MV2 vessel 1 inlet port (MV2/V1).

3. Run the system for 2 minutes at a flow rate of 50 g/min to ensure that the system is
working correctly and that all modules are recognized.

9.9 Performing the Level 4 cleaning procedure
This procedure, which describes how to clean the CO2 recycler in the Bio-Botanical Extraction
System and the SFE 5-liter and 10-liter systems, is intended for systems that include an
automated or manual recycler.

Warning: Observe Good Laboratory Practice (GLP) at all times, particularly when
working with hazardous materials. Consult the Material Safety Data Sheets regarding
the solvents you use. Additionally, consult the safety representative for your
organization regarding its protocols for handling such materials.

Warning: To avoid serious injury or death from CO2 vapors, ensure that the room
containing the system is well ventilated. The ventilation system must provide an air
exchange rate of four rooms per hour.

 

Warning: To avoid personal contamination with biologically hazardous or toxic compounds,
wear clean, chemical-resistant, powder-free gloves when performing this procedure.

Warning: To avoid electrical shock, power-off and unplug each module before
performing any maintenance operation on it.

Warning: To avoid eye injury, use eye protection when performing this procedure.

Requirement: Wear clean, chemical-resistant, powder-free gloves when performing
this procedure.

Requirement: Use eye protection when performing this procedure.

Clean the CO2 recycler when you cannot control the recycler pressure to 5171 kPa (52 bar 750
psi).
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Tip: Ensure that you have all of the required tools and materials in stock before performing this
procedure.

Required tools and materials

• Chemical-resistant, powder-free gloves

• Protective eyewear

• 3/8-inch open-end wrench

• 7/16-inch open-end wrench

• 1/2-inch open-end wrench

• 1-1/2-inch open-end wrench

• PTFE tape

• 1/4-inch compression cap fitting

• Level sensor O-ring

• Food-grade ethanol or 50:50 Food-grade ethanol/Water (4 L)

• 48-inch, stainless steel, drain-cleaning brush

• Large beaker (polypropylene or metal, 1 L)

• Wash bottle

Cleaning the CO2 recycler involves these steps:

1. Draining the CO2 recycler.

2. Cleaning the stainless steel flexible tubing.

3. Cleaning the heat exchanger.

4. Cleaning the CO2 recycler.

5. Filling the CO2 recycler.

9.9.1 Draining the CO₂ recycler

Warning: Observe Good Laboratory Practice (GLP) at all times, particularly when
working with hazardous materials. Consult the Material Safety Data Sheets regarding
the solvents you use. Additionally, consult the safety representative for your
organization regarding its protocols for handling such materials.

Warning: To avoid serious injury or death from CO2 vapors, ensure that the room
containing the system is well ventilated. The ventilation system must provide an air
exchange rate of four rooms per hour.
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Warning: To avoid personal contamination with biologically hazardous or toxic compounds,
wear clean, chemical-resistant, powder-free gloves when performing this procedure.

Warning: To avoid eye or facial injury, wear a face shield when performing this
procedure.

Requirement: Wear clean, chemical-resistant, powder-free gloves when performing
this procedure.

Requirement: Use eye protection when performing this procedure.

Required tools and materials

• Chemical-resistant, powder-free gloves

• Face shield

• 3/8-inch open-end wrench

To drain the CO2 recycler:

1. Close the manual CO2 supply valve at the top of the recycler leading from the CO2 source.

Figure 9–98: Manual CO2 supply valve

1

Manual CO2 supply valve handle

2. Close the drain valve on the bottom of the recycler.
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Figure 9–99: Drain valve outlet and handle on bottom of CO2 recycling vessel

1

Drain valve handle

Drain outlet

3. Ensure that the CO2 recycler drain outlet is routed to a suitable waste container.

Figure 9–100: Example of a suitable waste container

1

2

3
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Waste tubing (from CO2 recycler drain outlet)

Waste-container vent tubing (to fume hood)

Waste container

4. Use the 3/8-inch open-end wrench to disconnect the outlet fitting from the CO2 supply
valve.

Figure 9–101: CO2 supply valve outlet fitting

Bottom of CO2 recycler

CO2 supply isolation valve

Outlet fitting

5. Slowly open the CO2 recycler manual drain valve.

Warning: To avoid freeze burns when closing the CO2 recycler manual drain
valve, wear thermally insulated gloves. During draining, the drain valve can
freeze due to Joule-Thompson cooling, and its temperature can fall as low as -78
°C.

Warning: To avoid eye or facial injury, wear a face shield when closing the CO2

recycler manual drain valve. As the drain valve begins to warm, frozen CO2

blocking the outlet could be explosively expelled.

6. Once the CO2 recycler pressure reaches 0 psi and CO2 is no longer coming out of the
drain outlet, close the CO2 recycler manual drain valve, and remove the recycler tubing.

Tip: The CO2 recycler tank can take several hours to drain, depending on the amount of
CO2 in tank. When draining, the drain valve may freeze due to Joule-Thompson cooling
and clog the drain outlet with frozen CO2. As the drain outlet begins to warm, the frozen
CO2 may be explosively expelled causing a loud sound and an explosive release of CO2.
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Eye protection (preferably a face shield) and thermally insulated gloves to protect from
freeze burns are required. The drain valve on the recycle tank will go to as low as -78 °C
during draining.

Figure 9–102: CO2 recycler tubing

Recycler inlet

Recycler tubing

9.9.2 Cleaning the stainless steel flex tubing

Warning: Observe Good Laboratory Practice (GLP) at all times, particularly when
working with hazardous materials. Consult the Material Safety Data Sheets regarding
the solvents you use. Additionally, consult the safety representative for your
organization regarding its protocols for handling such materials.

Warning: To avoid serious injury or death from CO2 vapors, ensure that the room
containing the system is well ventilated. The ventilation system must provide an air
exchange rate of four rooms per hour.
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Warning: To avoid personal contamination with biologically hazardous or toxic compounds,
wear clean, chemical-resistant, powder-free gloves when performing this procedure.

Warning: To avoid eye injury, use eye protection when performing this procedure.

Requirement: Wear clean, chemical-resistant, powder-free gloves when performing
this procedure.

Requirement: Use eye protection when performing this procedure.

Required tools and materials

• Chemical-resistant, powder-free gloves

• Protective eyewear

• 9/16-inch open-end wrench

• Food-grade ethanol or 50:50 Food-grade ethanol/Water (4 L)

• Wash bottle

To clean the stainless steel flex tubing:

1. While the CO2 recycler is draining, set the recycler chiller to 50 °C.

Tip: To set the temperature, see the manufacturer instructions that were shipped with the
chiller.

2. Turn the manual back-pressure regulator (MBPR) on cyclone separator 3 (CS3) two full
turns clockwise.

Figure 9–103: Location of CS3 MBPR
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CS3 MBPR

3. Use the 9/16-inch open-end wrench to remove the stainless steel (SS) flex tubing
connecting the outlet of the view cell on CS3 MBPR to the CO2 recycler.

Figure 9–104: Stainless steel flex tubing connected to view cell

CS3 MBPR

View cell assembly

Stainless steel flex tubing connection

4. Use a wash bottle to force 95% food-grade ethanol through the stainless steel flex line and
let it soak for 15 minutes. Repeat this step until the ethanol runs clear.

9.9.3 Cleaning the heat exchanger

Warning: Observe Good Laboratory Practice (GLP) at all times, particularly when
working with hazardous materials. Consult the Material Safety Data Sheets regarding
the solvents you use. Additionally, consult the safety representative for your
organization regarding its protocols for handling such materials.

Warning: To avoid serious injury or death from CO2 vapors, ensure that the room
containing the system is well ventilated. The ventilation system must provide an air
exchange rate of four rooms per hour.

 

Warning: To avoid personal contamination with biologically hazardous or toxic compounds,
wear clean, chemical-resistant, powder-free gloves when performing this procedure.

Warning: To avoid eye injury, use eye protection when performing this procedure.

Requirement: Wear clean, chemical-resistant, powder-free gloves when performing
this procedure.

February 21, 2018, 715004757 Rev. D
Page 234



Requirement: Use eye protection when performing this procedure.

Required tools and materials

• Chemical-resistant, powder-free gloves

• Protective eyewear

• 3/4-inch open-end wrench

• 1/4-inch compression cap fitting

• Food-grade ethanol or 50:50 Food-grade ethanol/Water (4 L)

• Large beaker (polypropylene or metal, 1 L)

• Wash bottle

To clean the heat exchanger:

1. Use the 3/4-inch open-end wrench to remove the 1/2‐inch Swagelok fitting on top of the
CO2 recycler heat exchanger.

Tip: To access the fitting, you may need to remove the insulation and U-bracket.

Figure 9–105: Opening the heat exchanger on 2 recycler

Swagelok fitting

Heat exchanger

2. Place a beaker under the heat-exchanger outlet.
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Figure 9–106: Heat-exchanger outlet

Heat-exchanger outlet

Bottom of CO2 recycler

3. Remove the tubing from the heat exchanger outlet.

4. Place the 1/4-inch compression cap fitting on the heat exchanger outlet, and then fill the
heat exchanger with 95% food-grade ethanol.

5. Allow the heat exchanger to soak for 15 minutes, and then drain it.

6. Repeat the previous step until the ethanol is clear. Empty the beaker as necessary.

9.9.4 Cleaning the recycler

Warning: Observe Good Laboratory Practice (GLP) at all times, particularly when
working with hazardous materials. Consult the Material Safety Data Sheets regarding
the solvents you use. Additionally, consult the safety representative for your
organization regarding its protocols for handling such materials.

Warning: To avoid serious injury or death from CO2 vapors, ensure that the room
containing the system is well ventilated. The ventilation system must provide an air
exchange rate of four rooms per hour.

 

Warning: To avoid personal contamination with biologically hazardous or toxic compounds,
wear clean, chemical-resistant, powder-free gloves when performing this procedure.

Warning: To avoid eye injury, use eye protection when performing this procedure.
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Requirement: Wear clean, chemical-resistant, powder-free gloves when performing
this procedure.

Requirement: Use eye protection when performing this procedure.

Required tools and materials

• Chemical-resistant, powder-free gloves

• Protective eyewear

• 1/2-inch open-end wrench

• 1-1/2-inch open-end wrench

• PTFE tape

• Level sensor O-ring

• Food-grade ethanol or 50:50 Food-grade ethanol/Water (4 L)

• 48-inch stainless steel drain-cleaning brush

• Large beaker (polypropylene or metal, 1 L)

• Wash bottle

To clean the recycler:

1. While the heat exchanger soaks, disconnect all cables connected to the CO2 recycler.

2. Use the 1/2-inch open-end wrench to loosen the recirculation valve fitting, and then remove
the recirculation valve.

Figure 9–107: Recirculation valve and fitting
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Recirculation valve

Fitting

3. Use the 1-1/2-inch open-end wrench to unscrew the large nut at the base of the level
sensor, and then remove the sensor.

Figure 9–108: Large nut on level sensor base

Level sensor

Large nut

CO2 recycler tank

Warning: Retrieving a float from the bottom of the CO2 recycler tank requires
tipping the tank upside down. To avoid spinal and muscular injury, do not attempt
to tip the tank upside down without assistance.

Notice: If you feel resistance when pulling upward on the dipstick, this indicates
that dry ice has formed around its float. To avoid damaging the dipstick, wait two
hours before attempting to remove it again.

4. Carefully remove the dipstick, ensuring that you do not contact the floats on the side of the
orifice during removal.
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Figure 9–109: Removing dipstick from CO2 recycler tank

Dipstick

Float

Orifice

CO2 recycler tank

5. Ensure that all valves are closed on the CO2 recycler, and then place a beaker under the
recycler drain outlet.

6. Use the wash bottle to squirt 95% food-grade ethanol around the inside of the recycler
vessel, and then use the 48-inch stainless steel drain-cleaning brush to scrub the sides of
the recycler.

7. Allow the recycler to soak for 15 minutes, and then drain it.

8. Continue scrubbing, soaking, and draining until the ethanol is clear. Empty the beaker as
necessary.

9. Spray 95% food-grade ethanol to carefully clean out the springs and level sensor floats
before reinstalling the level sensor.

10. Reinstall the level sensor, ensuring that you do not to contact the floats on the side of the
orifice during installation.
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11. Remove the old level-sensor O-ring and replace it with a new one.

12. Carefully reinstall the level sensor O-ring.

Requirement: Replace the level sensor O-ring whenever you open the CO2 recycler
tank. If you wait until the O-ring fails, it will take two to three hours to replace.

13. Wrap the recirculation valve threads with PTFE tape, and then reinstall the valve on the
CO2 recycler tank, using the 1/2-inch open-end wrench to tighten the recirculation valve
fitting.

14. Reinstall the stainless steel flex tubing, recycler tubing, and CO2 supply tubing.

9.9.5 Filling the CO₂ recycler

Warning: Observe Good Laboratory Practice (GLP) at all times, particularly when
working with hazardous materials. Consult the Material Safety Data Sheets regarding
the solvents you use. Additionally, consult the safety representative for your
organization regarding its protocols for handling such materials.

Warning: To avoid serious injury or death from CO2 vapors, ensure that the room
containing the system is well ventilated. The ventilation system must provide an air
exchange rate of four rooms per hour.

 

Warning: To avoid personal contamination with biologically hazardous or toxic compounds,
wear clean, chemical-resistant, powder-free gloves when performing this procedure.

Warning: To avoid eye injury, use eye protection when performing this procedure.

Requirement: Wear clean, chemical-resistant, powder-free gloves when performing
this procedure.

Requirement: Use eye protection when performing this procedure.

Required tools and materials

• Chemical-resistant, powder-free gloves

• Protective eyewear

To fill the CO2 recycler:

1. Ensure the valves are in the following positions:
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• Manual CO2 supply valve: closed

• System supply valve: closed

• Recycler drain outlet: closed

Figure 9–110: Manual CO2 supply valve

1

Manual CO2 supply valve handle

Figure 9–111: CO2 recycler system supply and drain valves

Bottom of CO2 recycler tank

Drain valve handle

System supply valve handle

Notice: Opening the CO2 supply valve too quickly will cause dry ice to form at
the bottom of the CO2 recycler. If this occurs, allow the ice to melt overnight or
use a heat gun to melt it.

2. Slightly open the manual CO2 supply valve.
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Tips: 

• Filling the CO2 recycler takes approximately 20 minutes. To monitor the fill rate, check
the recycler chiller temperature. If the recycler chiller temperature drops more than 2
°C, the recycler is filling too quickly.

• If you are using automated refilling (solenoid control), ensure that the manual valve
remains only slightly open for the initial filling. After the initial filling is finished, open the
valve completely.

3. Wait until the low light on the level sensor is illuminated. Keep the manual CO2 supply
valve open for 1 minute, and then close it.

4. Turn on the pump, and then slightly open the manual CO2 supply valve again. If the low
light on the level sensor is not illuminated after 2 minutes, check the CO2 supply, and refill
it if necessary.

9.10 Preparing for system shutdown
You must prepare a system for shutdown before actually shutting it down. To do so, you can set
the conditions via the ChromScope software for cleaning and flushing the system. You can then
run these conditions to perform those functions before the system-shutdown conditions apply.

Always observe Good Laboratory Practice (GLP) guidelines and your laboratory's standard
operating procedures.

9.10.1 Shutting down the system for short periods
Short-term shutdown is appropriate for shutting down the system for a few days, such as a
weekend.

To perform a short-term system shutdown:

1. Use an acceptable cleaning solvent to empty and clean all extraction and collection
vessels of residual product.

2. Set conditions suitable for cleaning the solvent and fraction-collection flow lines for your
application.

Tip: Minimally set the flow for CO2 and, optionally, co-solvent, to flush to the co-solvent
and fraction-collection flow lines for as long as 15 minutes.

3. When the flushing ends, shut off the CO2 inlet supply.

4. If the pumps and ABPR remain in operation, in the ChromScope Main window, click Stop
to switch off the system pumps, ABPR, and heaters.

5. Leave the system pressurized.
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6. Optionally, shut down the CO2 recycler chiller.

Tip: If you shut down the chiller, you must refill the CO2 recycler with CO2 before starting
up the system. Depending on the CO2 tank temperature and its distance from the recycler,
refilling can take up to two hours.

7. If the system is stopped for more than 1 hour, open the recirculation valve on the CO2

recycler.

9.10.2 Shutting down the system for long periods
Long-term shutdown is appropriate for shutting down the system for several days or longer.

To perform a long-term system shutdown:

1. Perform the shutdown procedure described in Shutting down the system for short periods.

2. Exit ChromScope.

3. Power-off the PC workstation.

4. Power-off each component (including the CO₂ recycler chiller).

5. Disconnect all electrical connections to the system.

6. If shutting down the system for an extended period, or before moving the system to a new
location, fully depressurize the system as follows:

a. If the system is equipped with a CO₂ recycler, shut down and depressurize the
recycler by opening its drain valve.

b. For each cyclone separator, release any pressure remaining in the system's back
end by fully opening the separator's associated manual back-pressure regulator
(MBPR) valve (MBPR1, MBPR2, or MBPR3) and drain valve (MV8, MV9, or MV10).

Figure 9–112: Location of MV8, MV9, and MV10 valve on side of module cart
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Location of MV8, MV9, and MV10 valve

c. For each extraction vessel, release any pressure remaining in the system's front end
by opening the MV2 valve stem that directs flow to the vessel, and then opening the
vessel's associated drain valve (MV6 or MV7).

Figure 9–113: Location of MV2 valve on module cart

Location of MV2 valve

Figure 9–114: Location of MV6 or MV7 valve on back side of extraction vessel

Location of MV6 or MV7 valve

9.11 Servicing the CO₂ inlet filter
An in-line filter in the CO2 inlet line helps prevent particles from entering the system and
damaging components such as check valves. A clogged filter restricts flow to the pump,
diminishing its performance. Clean or replace the CO2 inlet filter as part of a scheduled
maintenance routine or whenever a clogged filter restricts CO2 flow.
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Warning: To avoid serious injury, including asphyxiation, that can result from
disconnecting a pressurized CO2 line, before disconnecting the line from the CO2

source, stop the flow of CO2 from the system, and shut the valve at the CO2 supply.

Required tools and materials

• 3/4-inch open-end wrench

• Food-grade ethanol (if cleaning)

• Ultrasonic bath

• CO2 inlet filter (if replacing)

• CO2 inlet filter seal (if replacing)

To service the inlet filter:

1. Close the CO2 recycler outlet (isolation) valve.

Figure 9–115: CO2 recycler outlet (isolation) valve

Bottom of CO2 recycler

CO2 recycler outlet (isolation) valve handle

2. On the ChromScope main page, set the CO2 flow to 30 g/min until it shuts down.

Result: This will drain the CO2 from the filter tubing and inlet.

3. Locate the CO2 inlet filter assembly where the CO2 supply connects to the system.
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Figure 9–116: CO2 inlet filter assembly

4. Use a 3/4-inch open-end wrench to loosen and remove the cover of the inlet filter.
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Figure 9–117: CO2 inlet filter assembly exploded view

Place the 3/4-inch open-end wrench here

Inlet filter cover

Inlet filter

5. Remove the inlet filter from the inlet filter housing, and then do one of the following:

• If the filter is partially blocked, sonicate the filter in 95% food-grade ethanol for 20
minutes, and then reinstall it.

• If the filter is completely blocked, replace the filter, and perform the level 3 cleaning
procedure.

Tip: A partially or completely blocked filter indicates that the CO2 source might be
contaminated with particulate matter.
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6. Replace and tighten the inlet filter cover.

7. Open the valve to the CO2 supply source, and inspect the inlet filter assembly for leaks.

9.12 Maintaining the P-Series high-pressure pump
The SFE systems use P-Series high-pressure pumps to deliver precise quantities of liquid CO2

and co-solvent, or modifier, to the system. The pump models, which are shipped fully assembled
and ready to use, vary in size to provide sufficient flow capacity to accommodate extractions of
different sample volumes. The pump models share a design that incorporates a low-dead-volume
head and check valves, which provide efficient pumping of liquid CO2 or co-solvent. As the
pump's piston retracts, the lower check valve opens to allow fluid into the chamber. Concurrently,
the upper check valve closes, to prevent the system fluid from entering the chamber. When the
piston completes its fill cycle, it begins to move forward, causing the lower check valve to close.
When the pressure in the piston chamber exceeds the system pressure, the upper check valve
opens and allows the fluid to flow into the system. The pump consists of pistons that provide
pulse-free solvent delivery.

Warning: To avoid electric shock, do not remove protective panels from system
modules. The components within are not user-serviceable.

Requirements: 

• Before servicing a P-Series pump used to pump liquid CO2, shut the valve to the CO2 supply
source, and open the bleeder valve, to completely depressurize the pump. Then power-off the
pump, disconnect it from its power source, and remove and plug the cooling lines attached to
the front of the pump heads.

• Before servicing a P-Series pump used to pump co-solvent, power-off the pump, and
disconnect it from its power source. Then depressurize the system, and remove the solvent
inlet lines from the solvent reservoirs, or move the solvent reservoirs to a location below the
pump.

Warning: To avoid injuries arising from contact with solvent spilled as a result of
unintentional siphoning, before servicing a pump, remove the solvent inlet lines from the
solvent reservoirs or move the solvent reservoirs to a location below the pump.

The topics in this section convey instructions for maintaining the system's high-pressure pumps.

9.12.1 Maintaining the P-200 high-pressure pump
Depending on the SFE system configuration, the system uses the P-200 high-pressure pump to
deliver precise quantities of liquid CO2 to the system.

The topics in this section convey instructions for maintaining the P-200 high-pressure pump.
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9.12.1.1 Replacing the P-200 or P-350 pump's inlet and outlet check valves

The inlet check valves on the bottom of the pump heads allow flow into the heads as the piston
retracts. As the piston advances and pressure in the chamber begins to build, the inlet check
valves prevent retrograde flow.

The outlet check valves atop the pump heads allow flow out of the heads as the piston advances.
As the piston retracts, the outlet check valves prevent system pressure from entering the heads.

The P-200 pump has a mass flow rate of approximately 1.125 to 1.0 times its RPM.
Proportionately, the typical P-200 pump RPM is approximately .875 to 1.0 times its mass flow
rate. For example, the estimated mass flow rate for a P-200 pump running at 117 RPM is 124
g/min (117 × 1.0625 = 124 g/min).

Notes: 

• The example assumes that the pump is running well.

• The correction factor varies, based on check valve and seal wear.

• Because the thermophysical relationships present are highly nonlinear, the correction factor is
only an estimate.

When a check valve fails, the pump's outflow decreases, causing the pump to run faster in order
to maintain the specified flow rate. If the flow rate from the pump is lower than the stated RPM,
one or more check valves can be defective. Other possible problems include cooling restriction
on the inlet, leaking piston seals, and a low CO2 supply.

Required tools and materials

• 3/8-inch open-end wrench

• 1/2-inch open-end wrench

• Needle-nose pliers

• Inlet and outlet check valves designated for the P-Series model pump

• PTFE spray

To replace the check valve:

1. Use a 3/8-inch open-end wrench and a 1/2-inch open-end wrench as backup to disconnect
the inlet line or outlet line from the pump check valve nut and the manifold.
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Figure 9–118: Outlet and inlet connections on pump head

1

2

Outlet line

Inlet line

2. Remove the tubing.

3. Remove the check-valve nut.

Tip: If the check valve is an outlet valve, use needle-nose pliers to remove the valve from
the head.

Figure 9–119: Outlet check valve - with arrow up

1

Outlet check valve
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4. Clean the retainer-nut threads and spray them with a PTFE lubricant.

5. Install the new check valve with the arrow pointing up.

6. Finger-tighten the nut into the head until the nut contacts the check valve.

7. Use a 3/8-inch wrench to tighten the check-valve nut approximately 120°.

8. Reinstall the tubing.

9. After servicing the CO2 pump, open the valve to the CO2 supply source and inspect for
leaks.

9.12.1.2 Replacing the P-200 or P-350 pump's piston seals

The P-Series pump incorporates low-friction sapphire for the pistons. The sapphire passes
through a spring-loaded seal. After some time, the seal begins to wear and requires replacement.
Typical symptoms of a leaking seal are decreased pump efficiency, excessive bubbles exuding
from behind the head, and a buildup of frost on the CO2 pump, from leaking CO2.

Requirement: Always replace the backup ring when replacing the piston seal.

Required tools and materials

• 3/8-inch open-end wrench

• 1/2-inch open-end wrench

• 3/16-inch hex wrench

• 30W, non-detergent, motor oil

• Acetone

• Lint-free cloth

• Pump piston seal service kit designated for the P-Series model pump

To replace the piston seals:

1. Disconnect the inlet and outlet lines from the pump's check-valve nuts and the manifold
using a 3/8-inch open-end wrench and a 1/2-inch open-end wrench as backup.
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Figure 9–120: Pump heads showing tubing and six securing screws

1

Pump head spacer plate

2. Remove the 6 screws securing the head-spacer plate to the front of the pump using a 3/16-
inch hex wrench.

3. Withdraw the plate head assembly from the front of the pump.

Tip: Mark the top of the plate, the left and right heads, pistons, and bearing blocks for
future reference.

Figure 9–121: Pump head assembly removed

Warning: To avoid finger or hand lacerations from sharp-edged surfaces, use
care when installing or removing head-assembly components. Bending or
twisting the sapphire piston shaft can cause it to fracture or splinter.

4. Withdraw the piston from the first head and bearing-block assembly.
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Figure 9–122: Piston assembly

1

Piston sapphire

5. Clean the piston sapphire using acetone and a lint-free cloth.

6. Remove the 4 socket-head screws that secure the bearing block to the head-spacer plate
and pump head using the hex wrench.

Figure 9–123: Pump head bearing block

1

2

3

Socket head screws

Bearing block

Pump head

7. Remove the backup ring and spring seal from the pump head using the plastic, hooked tool
from the service kit.
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Figure 9–124: Backup ring and piston spring seal

Backup ring

Piston spring seal

8. Clean the seal cavity using acetone using a cotton swab.

9. Slide the new spring seal into the head with the spring facing into the head.

Requirement: The spring must not be visible when installed.

10. Slide the backup ring into the head until it seats flush.

11. Loosely install the 4 socket-head screws securing the head to the spacer plate and bearing
block.

12. With the piston's return spring removed, insert the piston using a rotating motion into the
bearing block, spacer plate, and head until it contacts the head seals.

Figure 9–125: Installed piston with spring removed to seat the new seals

13. Tighten the 4 socket head screws into the head. Use the partially installed piston as a
guide to center the bearing.

14. Repeat the preceding steps to replace the seals in the second pump head.
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15. Remove each piston assembly, and then reinstall it with its piston-return spring mounted
on the piston shaft.

16. Turn the pistons so the oiler wicks face upward, and slide the plate assembly back, into the
front of the pump.

Note: The P-Series pump uses sealed bearings. Under normal operating conditions, such
bearings require no additional lubrication, except for the roller bearing at the rear of each
piston assembly. To lubricate the piston's roller bearings, monthly apply 3-4 drops of 30W,
non-detergent, motor oil to the oiler wicks.

17. Loosely install the 6 socket-head screws joining the spacer plate and pump chassis.

18. Begin tightening the screws, approximately 1 or 2 turns each and in a clockwise pattern
until all are tight.

19. Reinstall the tubing to the check-valve nuts and the manifold.

20. Reattach the cooling lines to the front of the pump heads.

21. Confirm pump operation as follows, according to the type of the pump serviced:

• For the P-Series pump that functions as the CO2 pump, open the valve to the CO2

supply source, and inspect the pump for leaks. In ChromScope, verify that the CO2 flow
rate is set to zero and the pump and ABPR pressure readings are within +/- 1.5 bar. If
the readings are outside this tolerance, contact your Waters service representative, to
request pump calibration service.

• For the P-Series pump that functions as the co-solvent pump, reinstall the solvent
reservoir lines, and use the appropriate MV valve to prime the pump. Start a solvent
flow, and inspect the pump for leaks.

9.12.1.3 Replacing the P-200, P200X, or P-350 pump's rupture disc

The P-Series pump is equipped with a rupture-disc safety device. This device is designed to burst
if the pressure exceeds the disc's limit. The rupture discs are of a special, nonfragmenting type
and must not be replaced with any other type.

Recommendation: Before replacing a ruptured pressure disc, identify and correct the problem
that caused the disc to burst. A burst event can result from any of these causes:

• Improperly calibrated pressure transducer

• Operating the pump with the outlet valve closed

• Running the pump with incorrect control parameters

• Using an incorrect rupture disc

Warning: To avoid injury from a bursting rupture disc, do not replace a rupture disc
with one that is not prescribed for use with the pump, particularly one whose burst rating
is higher than that specified for the pump. You cannot determine a disc's burst rating by
examining the disc itself, for many discs appear to be identical though their burst ratings
differ. You can verify a disc's rating only by inspecting its tag.
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Warning: Observe Good Laboratory Practice (GLP) at all times, particularly when
working with hazardous materials. Consult the Material Safety Data Sheets regarding
the solvents you use. Additionally, consult the safety representative for your
organization regarding its protocols for handling such materials.

Notice: To avoid damaging pump components, replace a rupture disc only with one of
the prescribed burst rating, which appears on the disc's tag.

Notice: To avoid contaminating system components, wear clean, chemical-resistant,
powder-free gloves when performing this procedure.

Warning: To avoid eye injury, use eye protection when performing this procedure.

Requirement: Wear clean, chemical-resistant, powder-free gloves when performing
this procedure.

Requirement: Use eye protection when performing this procedure.

Required tools and materials

• Chemical-resistant, powder-free gloves

• Protective eyewear

• 13/16-inch open-end wrench

• 1-inch open-end wrench

• Calibrated torque wrench capable of measuring torque of 10 to 150 foot/pounds

• PTFE spray

• Rupture-disc replacement kit designated for the P-Series model pump

To replace a burst rupture disc:

Warning: To avoid injury from a burst outlet valve, do not completely close the
valve before performing this procedure.

1. Use the 13/16-inch open-end wrench and the 1-inch open-end wrench as backup to loosen
and remove the disc-retainer nut from the housing.
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Figure 9–126: Rupture disc rating tag and retainer nut

1 2

3

Rupture-disc rating tag

Disc-retainer nut

Housing

2. Remove the burst rupture disc.

3. Clean the retainer-nut threads and spray them with PTFE lubricant.

4. Place the replacement disc onto the disc retainer.

Figure 9–127: Rupture disc components

1

2

Replacement disc

Disc retainer

5. Use your finger to slide the holder and disc into the housing, disc-first with the dome side
facing inward (downstream or towards the outdoor vent), and carefully thread the disc-
retainer nut into the housing.
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6. Use the calibrated torque wrench and the 1-inch open-end wrench to tighten the disc-
retainer nut and housing to 15 ft/lbs.

7. Install the tag supplied with the rupture disc around the holder.

9.12.2 Maintaining the P-50 high-pressure pump
Depending on the system configuration, the P-50 high-pressure pump module is provided with
the system. The pump delivers precise quantities of co-solvent to the system flow.

The topics in this section convey instructions for maintaining the P-50 high-pressure pump.

9.12.2.1 Replacing the P-50 pump's inlet and outlet check valves

The inlet check valves, on the bottom of the pump heads, allow flow into the pump heads as the
piston retracts. As the piston advances, and pressure in the chamber begins to build, the inlet
check valves close, preventing retrograde flow.

The outlet check valves, atop the pump heads, allow flow out of the pump heads as the piston
advances. As the piston retracts, the outlet check valves prevent system pressure from entering
the pump heads.

When a check valve fails, the pump's outflow decreases, causing the pump to run faster, to
maintain the specified flow rate. A typical pump's flow rate slightly exceeds the pump's RPM
multiplied by a factor of four. If the flow rate from the pump is lower than the stated RPM, one or
more check valves can be defective. Other possible causes for diminished flow rate include
cooling restriction on the inlet, leaking piston seals, and low supply source.

Required tools and materials

• 3/8-inch open-end wrench

• 1/2-inch open-end wrench

• Needle-nose pliers

• Inlet and outlet check valves designated for the P-50 model pump

• PTFE spray

To replace the check valve:

1. If using the P-50 to pump liquid CO2 to the system, shut the valve to the CO2 supply
source, and then open the bleeder valve, to completely depressurize the pump.

2. For the check valve that you are replacing, use the 3/8-inch open-end wrench and the 1/2-
inch open-end wrench, as backup, to disconnect the inlet or outlet line from the pump
check-valve nut and the manifold.

3. Remove the tubing.

4. Remove the check-valve nut.
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Tip: If the check valve is an outlet valve, use needle-nose pliers to remove the valve from
the head.

Figure 9–128: Outlet check valve - with arrow up

1

Check valve with arrow pointing up

5. Clean the retainer-nut threads, and spray them with a PTFE lubricant.

6. Install the new check valve with the arrow pointing up.

7. Finger tighten the nut into the head until the nut contacts the check valve.

8. Using the 1/2-inch open-end wrench, tighten the check-valve nut approximately 120°.

9. Reinstall the tubing.

10. If using the P-50 to pump liquid CO2 to the system, open the valve to the CO2 supply
source, and inspect for leaks.

9.12.2.2 Replacing the P-50 pump's piston seals

The P-50 high-pressure pump's seals incorporate low-friction sapphire. The sapphire passes
through a spring-loaded seal, which eventually wears, and requires replacement.

Requirement: Always replace the backup ring when replacing the piston seal.

Required tools and materials

• 3/8-inch open-end wrench

• 1/2-inch open-end wrench

• 3/16-inch hex wrench

• Acetone

• Cotton swabs
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• Lint-free cloth

• Pump piston seal service kit designated for the P-50 model pump

To replace the piston seals:

1. Use the 3/8-inch open-end wrench and the ½-inch open-end wrench as backup to
disconnect the inlet and outlet lines from the pump's check-valve nuts and the manifold.

2. Use the 3/16-inch hex wrench to remove the 4 head nuts and washers securing the head
to the front of the pump.

Warning: To avoid finger or hand lacerations from sharp-edged surfaces, use
care when installing or removing head-assembly components. Bending or
twisting the sapphire piston shaft can cause it to fracture or splinter.

3. Withdraw the head assembly from the front of the pump.

Figure 9–129: Pump head assembly removed

1

Sapphire piston

4. Clean the sapphire piston using acetone and a lint-free cloth.

5. Remove the backup bearing and piston seal from the pump head using the plastic, hooked
tool from the service kit.
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Figure 9–130: Piston spring seal and backup seal

Pump head

Piston spring seal

Backup seal

6. Clean the seal cavity using acetone using a cotton swab.

7. Slide the new seal into the pump head with the spring facing toward the front of the head.

Requirement: When installed, the spring must not be visible.

Figure 9–131: Pump head with installed spring seal

Spring seal

8. Slide the backup bearing into the head until it is seats flush.

9. Orient the head so that the two bleed holes on its side are visible when both heads are
installed.
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Figure 9–132: Bleed holes on side of pump head

Bleed holes

10. With the head properly oriented, align it with the head bolts, and slide it into place.

11. Loosely install the 4 head nuts between the head and the pump chassis.

12. Use the hex wrench to tighten the nuts with approximately 1 or 2 turns each and in a
clockwise pattern until all are tight.

13. Reinstall the tubing to the check-valve nuts and the manifold.

14. If using the P-50 pump to deliver liquid CO2 to the system, reinstall the cooling lines
attached to the front of the pump heads. Open the valve to the CO2 supply source, and
inspect for leaks.

9.12.2.3 Replacing the P-50 pump's rupture disc

The P-50 high-pressure pump is equipped with a rupture disc safety device. This device is
designed to burst if the pressure exceeds the disc limit. The rupture discs are a special
nonfragmenting type and must not be replaced with any other type.

Recommendation: Before replacing a rupture disc, identify and resolve the problem that
caused the disc to burst. A burst event can result from any of these causes:

• Improperly calibrated pressure transducer

• Operating the pump with outlet valve closed

• Running the pump with incorrect control parameters

• Using an incorrect rupture disc

Warning: To avoid injury from a bursting rupture disc, do not replace a rupture disc
with one that is not prescribed for use with the pump, particularly one whose burst rating
is higher than that specified for the pump. You cannot determine a disc's burst rating by
examining the disc itself, for many discs appear to be identical though their burst ratings
differ. You can verify a disc's rating only by inspecting its tag.
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Notice: To avoid damaging pump components, replace a rupture disc only with one of
the prescribed burst rating, which appears on the disc's tag.

Figure 9–133: Rupture disc rating tag

1

Rupture disc rating tag

Required tools and materials

• 3/4-inch open-end wrench

• PTFE spray

• Rupture disc replacement kit designated for the P-50 model pump

To replace a burst rupture disc:

1. Use the 3/4-inch open-end wrench to loosen and remove the disc retainer nut from the
manifold.

2. Remove the burst rupture disc.

3. Clean the retainer nut threads and spray with a PTFE spray lubricant.

4. Install the replacement disc into the disc holder with the dome side facing inward.

Figure 9–134: Rupture disc components

Retainer nut

Disc holder

Rupture disc

5. Place the disc holder with the disc on top of the lower nut, and carefully thread the disc
retainer nut into the manifold.
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Figure 9–135: Rupture disc and holder installed in retainer nut

Disc holder and rupture disc

Retainer nut

6. Finger tighten the nut until the rupture disc contacts the base of the manifold.

7. Use the 3/4-inch open-end wrench to tighten the nut to 60°.

8. Around the holder, install the tag supplied with the rupture disc.

9.13 Maintaining the automated back-pressure regulator
For information on maintaining the automated back-pressure regulator (ABPR), see the
Automated Back-Pressure Regulator Overview and Maintenance Guide.

9.14 Maintaining the heat-exchanger module
The heat exchanger heats a fluid circulating through it, in preparation for the next phase of a
system's operation. A temperature controller monitors the temperature of the heat exchanger,
compensating for variations produced by different flow rates.

The heat exchanger contains no user-serviceable components, so it does not require routine
maintenance. For models of the heat exchanger fitted with fuses, the two fuses are installed in an
external power-entry module on its rear panel.

9.15 Replacing the vessel's rupture disc
The extraction and cyclone separator vessels are equipped with a rupture disc safety device. This
device is designed to burst if the pressure exceeds the disc limit. The rupture discs are a special
nonfragmenting type and must not be replaced with any other type.

Recommendation: Before replacing a rupture disc, identify and resolve the problem that
caused the disc to burst. A burst event can result from any of these causes:
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• Improperly calibrated pressure transducer

• Running the system with incorrect control parameters

• Using an incorrect rupture disc

Warning: To avoid injury from a bursting rupture disc, do not replace a disc with one
that is not prescribed for use with the vessel, particularly one whose burst rating is
higher than that specified for the vessel. Note that you cannot determine a disc's burst
rating by examining the disc itself, for many discs appear to be identical, though their
burst ratings differ. You can verify a disc's rating only by inspecting its tag.

Required tools and materials

• 3/4-inch open-end wrench

• PTFE spray

• Rupture disc replacement kit designated for the vessel

To replace a burst rupture disc:

1. Use a 3/4-inch open-end wrench to loosen and remove the disc retainer nut from the
manifold.

2. Remove the burst rupture disc.

3. Clean the retainer nut threads and spray with a PTFE lubricant.

4. Install the replacement disc into the disc holder with the dome side facing inward.

Figure 9–136: Rupture disc components

Retainer nut

Disc holder

Rupture disc

5. Place the disc holder with the disc on top of the lower nut, and carefully thread the disc
retainer nut into the manifold.
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Figure 9–137: Rupture disc and holder installed in retainer nut

Disc holder and rupture disc

Retainer nut

6. Finger tighten the nut until the rupture disc contacts the base of the manifold.

7. Use a 3/4-inch open-end wrench to tighten the nut to 60°.

8. Around the holder, install the tag supplied with the rupture disc.

9.16 Replacing the component fuses
The system components are equipped with fuses that interrupt the electric current when
something within the component fails. They protect both the operator and the equipment. Fuse
failure is, under normal conditions, an extremely rare occurrence. Fuses that regularly fail indicate
a probable fault in the component and must be investigated. Contact Waters Customer Support
for assistance.

Exception: The fuses inside heat exchanger models equipped with an internal power-entry
module are not customer-serviceable. Their replacement requires contacting a Waters service
representative.

The fuse holder is located above the power switch on the rear of the module. Always replace a
fuse with one of equal rating. The fuse-replacement information is printed on the rear of the
module and described in the tables below.

Important: For modules that support dual-voltage settings, always refer to the fuse-replacement
information printed on the rear of the module for fuse-replacement instructions that accord with
the module's voltage setting.

Table 9–4: System and component fuses

System module Power rating Fuse rating

Six-zone temperature controller
module (CN6)

100-240 Vac, 50-60Hz 1A-250V

ABPR 100-240 Vac, 50-60Hz 3A-250V

February 21, 2018, 715004757 Rev. D
Page 266



Table 9–4: System and component fuses (continued)

System module Power rating Fuse rating

Heat exchanger (for models with
external power-entry module on
rear panel only)

500/1000 watt - 120/240 Vac,
50/60 Hz
2000 watt - 240 Vac, 50/60 Hz

500 watt - 6.3A-250V
1000/2000 watt -
10A-250V

P-50 high-pressure pump 100-240 Vac, 50-60Hz 10A-250V

P-200/P-350 high-pressure pump 100-240 Vac, 50-60Hz 10A-250V

Mass flow meter 115-130 Vac, 50/60 Hz 0.4A-250V

Chiller unit 100-240 Vac, 50/60 Hz 10 A, 5 × 20 mm, IEC
127, fast acting

Notice: To avoid damaging system modules, before replacing an opened fuse,
determine the cause of the fuse's failure. It is possible that a serious underlying problem
requires attention. Contact Waters Technical Service for assistance.

Warning: To avoid electrical fire, ensure that replacement fuses comply with the
ratings affixed to the rear panel of the module.

Warning: To avoid electrical shock, before removing a fuse, power-off the module,
and then remove the power cord from the receptacle on the back of the module.

Required tools and materials

• Appropriate replacement fuses

To replace the fuses in a module:

1. Move the power switch to the "off" (0) position, and remove the power cord from the back
of the unit.

2. Open the fuse-holder door located above the power switch.

3. Remove the fuse, and replace it with one of the same type and rating.

4. Close the fuse-holder door, reconnect the power cord, and move the power switch to the
"on" (1) position.
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9.17 Cleaning the exterior of the equipment

Warning: To avoid electric shock,

• ensure that the electrical power to the equipment is interrupted;

• when cleaning the surface of the equipment, apply water to a cloth, and then wipe
the instrument or device. Do not spray or otherwise apply water directly onto any
equipment surface.

Warning: To avoid personal injury, use eye and hand protection during the cleaning
process.

Requirement: Use eye protection when performing this procedure.

Requirement: Wear clean, chemical-resistant, powder-free gloves when performing
this procedure.

To clean the exterior of the equipment:

Clean surfaces of the equipment using only a clean, soft, lint-free paper or clean cloth dampened
with water.
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10 Diagnostic tests and
troubleshooting

10.1 System alarms

10.1.1 Software alarm is triggered, then resets

Problem Solution

A software alarm occurred
and then reset. A system
overpressure condition,
caused by a pressure spike,
is a typical example of such a
alarm.

1. Open and view the System Status panel or the current
history file to determine the cause of the problem.

2. From the Tools menu, click Reset System Alarm(s) > 
OK.

3. If the problem persists, exit the ChromScope software,
and cycle power to the failed module.

4. If the alarm persists, report its occurrence, along with any
supplemental information, to your Waters service
representative.

10.1.2 Communication failure

Problem Solution

Communication with a
module fails, triggering
a software alarm.

1. Open and view the System Status or Status Control panel, or the
current history file to determine the cause of the problem.

2. Inspect the failed component's cables and connections, to ensure
they are tight.

3. Exit the ChromScope software, and cycle power to the failed
module.

4. Restart the ChromScope software.

5. If the alarm persists, report its occurrence, along with any
supplemental information, to your Waters service representative.
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10.1.3 Internal hardware or software alarm shutting-down system

Problem Solution

An internal hardware or
software alarm is
triggered causing a
module or the system to
shut-down.

1. Open and view the System Status or Status Control panel, or
the current history file to determine the cause of the problem.

2. Exit the ChromScope software and cycle power to the failed
module.

3. Restart the ChromScope software.

4. If the alarm persists, report its occurrence, along with any
supplemental information, to your Waters service
representative.

10.2 Reviewing the data-log files
ChromScope software automatically logs data about each extraction run performed by the system
and stores it in data-log files (with the extension ".tta"). Data-log files are organized under the
Project's Data Files folder, by date, and labeled with a time stamp indicating when the run ended.

Whenever you suspect a problem occurred with the system, open and view the most recent data-
log file to try and diagnose the problem and determine its corrective action. You can adopt this
approach to solve most problems that occur during a run.

To review data-log files:

1. In the Folder View panel for the project, in the Data Files folder, click the folder name
that represents the date on which the files were generated.

Result: The data-log files generated on that date are displayed in the File View panel.

2. In the File View panel, click the file name.

Result: The data-log file opens in the ChromScope main window. Click the tabs on the
open data-log file to view the run's temperature, flow, and pressure plots. You can also
click the General Info and Method Info tabs to view a record of the run's general and
method information.

10.3 Troubleshooting system problems
Follow these basic steps to perform system troubleshooting:
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Warning: Observe Good Laboratory Practice (GLP) at all times, particularly when
working with hazardous materials. Consult the Material Safety Data Sheets regarding
the solvents you use. Additionally, consult the safety representative for your
organization regarding its protocols for handling such materials.

• Examine the system and consider the likely causes of the problem. For example,
unresponsive instruments can mean that power or signal cables are disconnected or
connected improperly.

• Compare the system's performance with its performance before the problem arose. When a
system is installed, document parameters and operating conditions, establishing a
performance baseline. Likewise, in a daily log, document system performance. You must
know whether the parameters specified when tuning a system approximate those specified for
a previous test sample. If they do not, and the settings needed to achieve optimum
performance and a good result differ significantly from those previously specified, some part
of the system requires attention.

• Using known samples, measure the performance of individual instruments. To identify atypical
parameters, methodically investigate and eliminate possible causes of a problem:

• System pressure (high, low, erratic)

• Baseline (flow path or electronics problem)

• Incorrect qualitative or quantitative results

• Consult the other troubleshooting sections in the system documentation to identify potential
causes of a problem and find corrective actions. If you isolate a problem to a system module
that has additional documentation, consult the documentation for that module.

10.4 Troubleshooting the high-pressure CO₂ pump

10.4.1 Unable to achieve CO₂ pump pressure or flow rate

Problem Solution

Low CO2 supply Replace CO2 supply tank, or confirm the bulk supply of CO2. A
cylinder or in-house source is adequate.
If using an optional flow meter, confirm that the density is above 0.87
g/cm3. If the density is lower, the CO2 supply is low, or the CO2 flow
path leaks.

Inadequate cooling At the chiller unit, ensure that the bath temperature is between 0 and
+5 °C, inspect cooling lines to the pump heads and heat exchangers,
and determine coolant fluid level.
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Problem Solution

CO2 supply does not
contain a dip tube

Contact CO2 supplier; switch tank.

Defective check valve Replace the CO2 pump's check valve.

Leaking piston seal Replace the CO2 pump's piston seal.

Defective flow meter Contact your Waters technical service representative.

10.4.2 Pressure reading reported on the display fails to match that of
gauge

Problem Solution

Defective gauge Replace gauge.

Defective pressure transducer Contact your Waters technical service representative.

Miscalibrated pressure transducer Contact your Waters technical service representative.

10.4.3 Pressure reading reported on display fails to match that of
other system components

Problem Solution

Restriction in lines: closed
valves

Ensure valves are in proper positions, inspect for proper tubing
sizes and properly cut tubing, and confirm valve alignments.

Defective pressure transducer Contact your Waters technical service representative.

Miscalibrated pressure
transducer

Contact your Waters technical service representative.

10.4.4 CO₂ pump stops because of high RPMs

Problem Solution

Problem with CO2

source
• Confirm that the CO2 supply is adequate (flow meter shows density

greater than 0.85 g/mL).

• Add a new supply tank, or confirm that the CO2 recycler is operating
properly.
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Problem Solution

Tubing connector
leaking

Replace tubing connector fitting.

Extraction vessel
frozen

• Verify that the temperature in the extraction chamber, as reported in the
software's Heater Controller panel, reflects or approximates the
temperature set point.

• Inspect the extraction vessel's lower exterior area for evidence of ice
buildup.

• Confirm that the heater controller and heater are functioning properly.

10.4.5 Repeated failure of pump check valves

Problem Solution

Contaminated solvent Replace solvent supply.

PTFE particles in lines Inspect for proper application of PTFE tape on fittings and for the
integrity of the seal between tank and supply-line fitting.

Dirt particles in lines Clean lines after cutting; add an in-line filter to the supply line.

10.4.6 Burst rupture disc

Problem Solution

Outlet valve closed Open outlet valve.

Defective pressure transducer Replace pressure transducer. Request Waters technical
service representative to recalibrate unit.

Defective or incorrect rupture disc Replace rupture disc.

10.5 Troubleshooting the extraction and cyclone separator
vessels

10.5.1 Frost forming on a cyclone separator
A cyclone separator can form frost when the following conditions exist:
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• The vessel's heater controller settings are switched off or set too low.

• The temperature controller module configured for that vessel is not operating, or its cables are
improperly connected.

• During depressurization when collecting a sample, even when the vessel's heater and
temperature control module are operating correctly.

See also: Unable to achieve temperature set point for heat exchanger or vessel

10.5.2 Unable to achieve or maintain system pressure

Problem Solution

No power to the ABPR
module

• Confirm connectivity to the ac power source.

• Replace the module's fuse.

• The model of ABPR module is equipped with an internal
temperature safety switch that was activated because of a problem
with the module. Call a Waters service representative.

Leaks in the system or
problems with pump
output

Inspect the system for leaks or problems associated with pump output.

ABPR needle out of
alignment

ABPR needle may need alignment, due to either wear on the needle
and seat or a defective valve component. Call a Waters service
representative.

10.5.3 Unable to achieve temperature set point for heat exchanger or
vessel

Problem Solution

No power to temperature
controller module, heat
exchanger, or vessel's
electrical heater.

• Confirm that the temperature controller module for the heat
exchanger or vessel heater is connected to the AC power
source.

• Confirm that the heat exchanger or vessel heater is connected
to the AC power source.

• Replace the fuse in the temperature controller module.

• The internal temperature safety switch of the temperature
controller, the heat exchanger, or the vessel's electrical heater
was activated because of a problem with the controller or
heater element. Contact a Waters service representative.
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Problem Solution

Zone is not enabled on
temperature controller.

In the software's Heater Controller panel, verify that the correct
zone is enabled.

Control cable or
thermocouple cable is
disconnected or connected
to different zones on the
temperature controller.

Verify that the control cable and thermocouple cable are
connected to the same zone on the temperature controller, and
that the zone is the correct one specified for the heater or heat
exchanger.

Insufficient time allowed to
achieve temperature set
point.

Allow up to one hour to achieve a thermal steady-state.

Note: The tolerance for the system temperature set point is +/-5
°C.

10.5.4 Burst rupture disc

Problem Solution

Outlet valve closed Open outlet valve.

Defective pressure transducer Replace pressure transducer. Request Waters technical
service representative to recalibrate unit.

Defective or incorrect rupture disc Replace rupture disc.

10.6 Troubleshooting the optional high-pressure co-solvent
pump

10.6.1 Unable to achieve pump flow rate

Problem Solution

Low solvent supply Refill solvent reservoir.

Clogged solvent filter Replace solvent filter.

Defective pump check valve Clean or replace check valves.

Leaking piston seal Replace piston seal.
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10.6.2 Pressure reading reported on the display fails to match that of
gauge

Problem Solution

Defective gauge Replace gauge.

Defective pressure transducer Contact your Waters technical service representative.

Miscalibrated pressure transducer Contact your Waters technical service representative.

10.6.3 Pressure reading reported on display fails to match that of
other system components

Problem Solution

Restriction in lines: closed
valves

Ensure valves are in proper positions, inspect for proper tubing
sizes and properly cut tubing, and confirm valve alignments.

Defective pressure transducer Contact your Waters technical service representative.

Miscalibrated pressure
transducer

Contact your Waters technical service representative.

10.6.4 Repeated failures of pump check valves

Problem Solution

Contaminated CO2 Contact CO2 supplier.

PTFE particles in lines • Ascertain the proper application of PTFE tape on fittings.

• Ascertain the integrity of the seal between the tank and fitting
of the supply-supply line.

Dirt particles in solvent lines • Clean lines after cutting them.

• Insert a filter in the solvent-supply line.

10.6.5 Burst rupture disc

Problem Solution

Outlet valve closed Open outlet valve.
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Problem Solution

Defective pressure transducer Replace pressure transducer. Request Waters technical
service representative to recalibrate unit.

Defective or incorrect rupture disc Replace rupture disc.

10.7 Troubleshooting the CO₂ recycler

Problem Solution

CO2 recycler will
not fill

• Confirm that electrical power to the level indicator is uninterrupted.

• For the manual CO2 recycler only, confirm that the manual supply valve
is open.

• Confirm the sufficiency of the CO2 supply.

• Confirm that the chiller is powered-on and operational.

SFE system CO2

pump stops due to
high rpm alarm, but
the recycler
indicates adequate
supply

• Confirm that the recycler is not isolated from the SFE system.

• Verify that the recycler pressure is sufficient. If pressure is too low,
increase the chiller temperature (up from 13.5 °C).

Recycler relief
valve opens

• Confirm that both manual valves are open.

• Inspect the chiller temperature setting. If it is above or near 14 °C,
decrease it by 1 °C, and repeat this decrease until the recycler
pressure stabilizes at 5500 to 6000 kPa (55 to 60 bar, 798 to 870 psi).
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Problem Solution

Sample carryover
to CO2 recycler

Possible cause:

Large pressure drops between cyclone separators 2 (CS2) and 3 (CS3)
cause significant cooling in CS3, which condenses the exhaust from CS3
into a liquid, resulting in carryover to the CO2 recycler.

Solution:

Install an inline collection heater between CS2 and CS3 to reduce the
manual back- pressure on CS2, which maintains the exhaust from CS3 as
a gas and eliminates carryover.

Possible cause:

The temperature in the room where the system is located is too low.
Because room temperature affects the CO2 recycler pressure, too-low
temperatures cause the recycler to have more liquid CO2 than gas, which
drives the recycler pressure lower. The large pressure drop has a waterfall
effect, pulling the extractables from the cyclone separators into the
recycler. Low-polarity extractables, such as terpenes and alkanes, are
especially vulnerable to such pressure drops and polarity changes.

Solution:

Maintain a room temperature of between 18 and 24 °C.
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Problem Solution

Sample carryover
to CO2 recycler
(continued)

Possible cause:

The temperature in the room where the system is located is too high. A
high room temperature can cause the CO2 recycler pressure to rise to too
high of a level. High recycler pressure can cause terpenes and waxes to
remain in the CO2 as it exits CS3, and then carryover to the recycler. As
the recycler heat exchanger gets coated with extract, it becomes less
efficient at cooling the liquid CO2 entering the recycler, which causes the
recycler temperature to rise. As this continues, the waxes and terpenes
continue to carry over to the Bio-Botanical Extraction System inlet filter and
CO2 pump.

Solution:

Maintain a room temperature of between 18 and 24 °C.

Possible cause:

High CO2 recycler pressure caused by clogs in the recycler's cooling heat
exchanger.

Solution:

Perform the Level 4 cleaning procedure. For more information, see
Performing the Level 4 cleaning procedure.

Possible cause:

High CO2 recycler pressure caused by an unexpected system shutdown
from a power outage or other system failure.

Solution:

Reduce the CO2 recycler pressure. For more information, see Reducing
the CO2 recycler pressure.
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A Safety advisories

Waters products display safety symbols that identify hazards associated with the product’s
operation and maintenance. The symbols also appear in product manuals with statements that
describe the hazards and advise how to avoid them. This appendix presents all safety symbols
and statements that apply to Waters’ product offerings. The symbols and statements can apply to
a specific product, or apply to other products within the same system.

A.1 Warning symbols
Warning symbols alert you to the risk of death, injury, or seriously adverse physiological reactions
associated with the misuse of an instrument or device. Heed all warnings when you install, repair,
or operate any Waters instrument or device. Waters accepts no liability in cases of injury or
property damage resulting from the failure of individuals to comply with any safety precaution
when installing, repairing, or operating any of its instruments or devices.

The following symbols warn of risks that can arise when you operate or maintain a Waters
instrument or device or component of an instrument or device. When one of these symbols
appears in a manual’s narrative sections or procedures, an accompanying statement identifies
the applicable risk and explains how to avoid it.

Warning: (General risk of danger. When this symbol appears on an instrument,
consult the instrument’s user documentation for important safety-related information
before you use the instrument.)

Warning: (Risk of burn injury from contacting hot surfaces.)

Warning: (Risk of electric shock.)

Warning: (Risk of fire.)

Warning: (Risk of sharp-point puncture injury.)

Warning: (Risk of hand crush injury.)
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Warning: (Risk of injury caused by moving machinery.)

Warning: (Risk of exposure to ultraviolet radiation.)

Warning: (Risk of contacting corrosive substances.)

Warning: (Risk of exposure to a toxic substance.)

Warning: (Risk of personal exposure to laser radiation.)

Warning: (Risk of exposure to biological agents that can pose a serious health threat.)

Warning: (Risk of tipping.)

Warning: (Risk of explosion.)

Warning: (Risk of high-pressure gas release.)

A.1.1 Specific warnings

A.1.1.1 Burst warning

This warning applies to Waters instruments and devices fitted with nonmetallic tubing.

Warning: To avoid injury from bursting, nonmetallic tubing, heed these precautions
when working in the vicinity of such tubing when it is pressurized:

• Wear eye protection.

• Extinguish all nearby flames.

• Do not use tubing that is, or has been, stressed or kinked.

• Do not expose nonmetallic tubing to compounds with which it is chemically
incompatible: tetrahydrofuran, nitric acid, and sulfuric acid, for example.

• Be aware that some compounds, like methylene chloride and dimethyl sulfoxide,
can cause nonmetallic tubing to swell, significantly reducing the pressure at which
the tubing can rupture.
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A.1.1.2 Biohazard warning

The following warning applies to Waters instruments and devices that can process material
containing biohazards, which are substances that contain biological agents capable of producing
harmful effects in humans.

Warning: To avoid infection with potentially infectious, human-sourced products,
inactivated microorganisms, and other biological materials, assume that all biological
fluids that you handle are infectious.
Specific precautions appear in the latest edition of the US National Institutes of Health
(NIH) publication, Biosafety in Microbiological and Biomedical Laboratories (BMBL).
Observe Good Laboratory Practice (GLP) at all times, particularly when working with
hazardous materials, and consult the biohazard safety representative for your
organization regarding the proper use and handling of infectious substances.

A.1.1.3 Biohazard and chemical hazard warning

This warning applies to Waters instruments and devices that can process biohazards, corrosive
materials, or toxic materials.

Warning: To avoid personal contamination with biologically hazardous, toxic, or corrosive
materials, you must understand the hazards associated with their handling.
Guidelines prescribing the proper use and handling of such materials appear in the latest edition
of the National Research Council's publication, Prudent Practices in the Laboratory: Handling and
Management of Chemical Hazards.
Observe Good Laboratory Practice (GLP) at all times, particularly when working with hazardous
materials, and consult the safety representative for your organization regarding its protocols for
handling such materials.

A.2 Notices
Notice advisories appear where an instrument, device, or component can be subject to use or
misuse that can damage it or compromise a sample’s integrity. The exclamation point symbol and
its associated statement alert you to such risk.

Notice: To avoid damaging the case of the instrument or device, do not clean it with
abrasives or solvents.

A.3 Bottles Prohibited symbol
The Bottles Prohibited symbol alerts you to the risk of equipment damage caused by solvent
spills.
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Prohibited: To avoid equipment damage caused by spilled solvent, do not place
reservoir bottles directly atop an instrument or device or on its front ledge. Instead,
place the bottles in the bottle tray, which serves as secondary containment in the event
of spills.

A.4 Required protection
The Use Eye Protection and Wear Protective Gloves symbols alert you to the requirement for
personal protective equipment. Select appropriate protective equipment according to your
organization’s standard operating procedures.

Requirement: Use eye protection when performing this procedure.

Requirement: Wear clean, chemical-resistant, powder-free gloves when performing
this procedure.

A.5 Warnings that apply to all Waters instruments and
devices
When operating this device, follow standard quality-control procedures and the equipment
guidelines in this section.

Warning: Changes or modifications to this unit not expressly approved by the party
responsible for compliance could void the user’s authority to operate the equipment.

Avertissement : Toute modification sur cette unité n’ayant pas été expressément
approuvée par l’autorité responsable de la conformité à la réglementation peut annuler
le droit de l’utilisateur à exploiter l’équipement.

Warnung: Jedwede Änderungen oder Modifikationen an dem Gerät ohne die
ausdrückliche Genehmigung der für die ordnungsgemäße Funktionstüchtigkeit
verantwortlichen Personen kann zum Entzug der Bedienungsbefugnis des Systems
führen.

Avvertenza: qualsiasi modifica o alterazione apportata a questa unità e non
espressamente autorizzata dai responsabili per la conformità fa decadere il diritto
all'utilizzo dell'apparecchiatura da parte dell'utente.

Advertencia: cualquier cambio o modificación efectuado en esta unidad que no haya
sido expresamente aprobado por la parte responsable del cumplimiento puede anular la
autorización del usuario para utilizar el equipo.
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警告： 未經有關法規認證部門允許對本設備進行的改變或修改,可能會使使用者喪失操作
該設備的權利。

警告： 未经有关法规认证部门明确允许对本设备进行的改变或改装，可能会使使用者丧
失操作该设备的合法性。

경고: 규정 준수를 책임지는 당사자의 명백한 승인 없이 이 장치를 개조 또는 변경할
경우, 이 장치를 운용할 수 있는 사용자 권한의 효력을 상실할 수 있습니다.

警告: 規制機関から明確な承認を受けずに本装置の変更や改造を行うと、本装置のユーザーとして
の承認が無効になる可能性があります。

Warning: Use caution when working with any polymer tubing under pressure:

• Always wear eye protection when near pressurized polymer tubing.

• Extinguish all nearby flames.

• Do not use tubing that has been severely stressed or kinked.

• Do not use nonmetallic tubing with tetrahydrofuran (THF) or concentrated nitric or
sulfuric acids.

• Be aware that methylene chloride and dimethyl sulfoxide cause nonmetallic tubing
to swell, which greatly reduces the rupture pressure of the tubing.

Avertissement : Manipulez les tubes en polymère sous pression avec precaution:

• Portez systématiquement des lunettes de protection lorsque vous vous trouvez à
proximité de tubes en polymère pressurisés.

• Eteignez toute flamme se trouvant à proximité de l’instrument.

• Evitez d'utiliser des tubes sévèrement déformés ou endommagés.

• Evitez d'utiliser des tubes non métalliques avec du tétrahydrofurane (THF) ou de
l'acide sulfurique ou nitrique concentré.

• Sachez que le chlorure de méthylène et le diméthylesulfoxyde entraînent le
gonflement des tuyaux non métalliques, ce qui réduit considérablement leur
pression de rupture.
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Warnung: Bei der Arbeit mit Polymerschläuchen unter Druck ist besondere Vorsicht
angebracht:

• In der Nähe von unter Druck stehenden Polymerschläuchen stets Schutzbrille
tragen.

• Alle offenen Flammen in der Nähe löschen.

• Keine Schläuche verwenden, die stark geknickt oder überbeansprucht sind.

• Nichtmetallische Schläuche nicht für Tetrahydrofuran (THF) oder konzentrierte
Salpeter- oder Schwefelsäure verwenden.

• Durch Methylenchlorid und Dimethylsulfoxid können nichtmetallische Schläuche
quellen; dadurch wird der Berstdruck des Schlauches erheblich reduziert.

Avvertenza: fare attenzione quando si utilizzano tubi in materiale polimerico sotto
pressione:

• Indossare sempre occhiali da lavoro protettivi nei pressi di tubi di polimero
pressurizzati.

• Spegnere tutte le fiamme vive nell'ambiente circostante.

• Non utilizzare tubi eccessivamente logorati o piegati.

• Non utilizzare tubi non metallici con tetraidrofurano (THF) o acido solforico o nitrico
concentrati.

• Tenere presente che il cloruro di metilene e il dimetilsolfossido provocano
rigonfiamenti nei tubi non metallici, riducendo notevolmente la pressione di rottura
dei tubi stessi.

Advertencia: se recomienda precaución cuando se trabaje con tubos de polímero
sometidos a presión:

• El usuario deberá protegerse siempre los ojos cuando trabaje cerca de tubos de
polímero sometidos a presión.

• Si hubiera alguna llama las proximidades.

• No se debe trabajar con tubos que se hayan doblado o sometido a altas presiones.

• Es necesario utilizar tubos de metal cuando se trabaje con tetrahidrofurano (THF) o
ácidos nítrico o sulfúrico concentrados.

• Hay que tener en cuenta que el cloruro de metileno y el sulfóxido de dimetilo dilatan
los tubos no metálicos, lo que reduce la presión de ruptura de los tubos.
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警告： 當在有壓力的情況下使用聚合物管線時，小心注意以下幾點。

• 當接近有壓力的聚合物管線時一定要戴防護眼鏡。

• 熄滅附近所有的火焰。

• 不要使用已經被壓癟或嚴重彎曲管線。

• 不要在非金屬管線中使用四氫呋喃或濃硝酸或濃硫酸。

• 要了解使用二氯甲烷及二甲基亞楓會導致非金屬管線膨脹，大大降低管線的耐壓能
力。

警告： 当有压力的情况下使用管线时，小心注意以下几点：

• 当接近有压力的聚合物管线时一定要戴防护眼镜。

• 熄灭附近所有的火焰。

• 不要使用已经被压瘪或严重弯曲的管线。

• 不要在非金属管线中使用四氢呋喃或浓硝酸或浓硫酸。

• 要了解使用二氯甲烷及二甲基亚枫会导致非金属管线膨胀，大大降低管线的耐压能
力。

경고: 가압 폴리머 튜브로 작업할 경우에는 주의하십시오.

• 가압 폴리머 튜브 근처에서는 항상 보호 안경을 착용하십시오.

• 근처의 화기를 모두 끄십시오.

• 심하게 변형되거나 꼬인 튜브는 사용하지 마십시오.

• 비금속(Nonmetallic) 튜브를 테트라히드로푸란(Tetrahydrofuran: THF) 또는 농축 질
산 또는 황산과 함께 사용하지 마십시오.

• 염화 메틸렌(Methylene chloride) 및 디메틸술폭시드(Dimethyl sulfoxide)는 비금속
튜브를 부풀려 튜브의 파열 압력을 크게 감소시킬 수 있으므로 유의하십시오.

警告: 圧力のかかったポリマーチューブを扱うときは、注意してください。

• 加圧されたポリマーチューブの付近では、必ず保護メガネを着用してください。

• 近くにある火を消してください。

• 著しく変形した、または折れ曲がったチューブは使用しないでください。

• 非金属チューブには、テトラヒドロフラン(THF)や高濃度の硝酸または硫酸などを流さないでくださ
い。

• 塩化メチレンやジメチルスルホキシドは、非金属チューブの膨張を引き起こす場合があり、その場
合、チューブは極めて低い圧力で破裂します。

This warning applies to Waters instruments fitted with nonmetallic tubing. This warning applies to
instruments operated with flammable solvents.
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Warning: The user shall be made aware that if the equipment is used in a manner not
specified by the manufacturer, the protection provided by the equipment may be
impaired.

Avertissement : L’utilisateur doit être informé que si le matériel est utilisé d’une façon
non spécifiée par le fabricant, la protection assurée par le matériel risque d’être
défectueuses.

Warnung: Der Benutzer wird darauf aufmerksam gemacht, dass bei unsachgemäßer
Verwendung des Gerätes die eingebauten Sicherheitseinrichtungen unter Umständen
nicht ordnungsgemäß funktionieren.

Avvertenza: si rende noto all'utente che l'eventuale utilizzo dell'apparecchiatura
secondo modalità non previste dal produttore può compromettere la protezione offerta
dall'apparecchiatura.

Advertencia: el usuario deberá saber que si el equipo se utiliza de forma distinta a la
especificada por el fabricante, las medidas de protección del equipo podrían ser
insuficientes.

警告： 使用者必須非常清楚如果設備不是按照製造廠商指定的方式使用，那麼該設備所
提供的保護將被消弱。

警告： 使用者必须非常清楚如果设备不是按照制造厂商指定的方式使用，那么该设备所
提供的保护将被削弱。

경고: 제조업체가 명시하지 않은 방식으로 장비를 사용할 경우 장비가 제공하는 보호
수단이 제대로 작동하지 않을 수 있다는 점을 사용자에게 반드시 인식시켜야 합니다.

警告: ユーザーは、製造元により指定されていない方法で機器を使用すると、機器が提供している
保証が無効になる可能性があることに注意して下さい。

A.6 Warnings that address the replacing of fuses
The following warnings pertain to instruments and devices equipped with user-replaceable fuses.
Information describing fuse types and ratings sometimes, but not always, appears on the
instrument or device.

Finding fuse types and ratings when that information appears on the instrument
or device:

Warning: To protect against fire, replace fuses with those of the type and rating
printed on panels adjacent to instrument fuse covers.
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Avertissement : pour éviter tout risque d'incendie, remplacez toujours les fusibles
par d'autres du type et de la puissance indiqués sur le panneau à proximité du
couvercle de la boite à fusible de l'instrument.

Warnung: Zum Schutz gegen Feuer die Sicherungen nur mit Sicherungen ersetzen,
deren Typ und Nennwert auf den Tafeln neben den Sicherungsabdeckungen des
Geräts gedruckt sind.

Avvertenza: per garantire protezione contro gli incendi, sostituire i fusibili con altri
dello stesso tipo aventi le caratteristiche indicate sui pannelli adiacenti alla copertura
fusibili dello strumento.

Advertencia: Para evitar incendios, sustituir los fusibles por aquellos del tipo y
características impresos en los paneles adyacentes a las cubiertas de los fusibles del
instrumento.

警告： 為了避免火災，更換保險絲時，請使用與儀器保險絲蓋旁面板上所印刷之相同類
型與規格的保險絲。

警告： 为了避免火灾，应更换与仪器保险丝盖旁边面板上印刷的类型和规格相同的保险
丝。

경고: 화재의 위험을 막으려면 기기 퓨즈 커버에 가까운 패널에 인쇄된 것과 동일한 타
입 및 정격의 제품으로 퓨즈를 교체하십시오.

警告: 火災予防のために、ヒューズ交換では機器ヒューズカバー脇のパネルに記載されているタイプお
よび定格のヒューズをご使用ください。

Finding fuse types and ratings when that information does not appear on the
instrument or device:

Warning: To protect against fire, replace fuses with those of the type and rating
indicated in the “Replacing fuses” section of the Maintenance Procedures chapter.

Avertissement : pour éviter tout risque d'incendie, remplacez toujours les fusibles
par d'autres du type et de la puissance indiqués dans la rubrique "Remplacement des
fusibles" du chapitre traitant des procédures de maintenance.

Warnung: Zum Schutz gegen Feuer die Sicherungen nur mit Sicherungen ersetzen,
deren Typ und Nennwert im Abschnitt "Sicherungen ersetzen" des Kapitels
"Wartungsverfahren" angegeben sind.

Avvertenza: per garantire protezione contro gli incendi, sostituire i fusibili con altri
dello stesso tipo aventi le caratteristiche indicate nel paragrafo "Sostituzione dei fusibili"
del capitolo "Procedure di manutenzione".

Advertencia: Para evitar incendios, sustituir los fusibles por aquellos del tipo y
características indicados en la sección "Sustituir fusibles".
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警告： 為了避免火災，更換保險絲時，應使用「維護步驟」章節中「更換保險絲」所指
定之相同類型與規格的保險絲。

警告： 为了避免火灾，应更换“维护步骤”一章的“更换保险丝”一节中介绍的相同类
型和规格的保险丝。

경고: 화재의 위험을 막으려면 유지관리 절차 단원의 “퓨즈 교체” 절에 설명된 것과 동
일한 타입 및 정격의 제품으로 퓨즈를 교체하십시오.

警告: 火災予防のために、ヒューズ交換ではメンテナンス項目の「ヒューズの交換」に記載されているタ
イプおよび定格のヒューズをご使用ください。

A.7 Electrical symbols
The following electrical symbols and their associated statements can appear in instrument
manuals and on an instrument’s front or rear panels.

Symbol Description

Electrical power on

Electrical power off

Standby

Direct current

Alternating current

Alternating current (3 phase)

Safety ground

Frame, or chassis, terminal

Fuse

Functional ground

Input

Output
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A.8 Handling symbols
The following handling symbols and their associated statements can appear on labels affixed to
the packaging in which instruments, devices, and component parts are shipped.

Symbol Description

Keep upright!

Keep dry!

Fragile!

Use no hooks!

Upper limit of temperature

Lower limit of temperature

Temperature limitation
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B Specifications

B.1 System specifications
The Waters Bio-Botanical Extraction System is a bulk-scale, preparative system designed to
serve as a high-pressure separator for collecting extracted compounds, to support various
applications, including quantitative recovery of botanicals and natural products.

Table B–1: System specifications

Item Specification

Operating pressure range 10,000 to 60,000 kPa (100 to 600 bar, 1450 to 8702 psi)
±200 kPa (±2 bar, ±29 psi)

Liquid CO2 inlet pressure 5500 to 10,000 kPa (55 to 100 bar, 798 to 1,450 psi)

Liquid CO2 inlet temperature 18 to 24 °C

Note: CO2 Supply tanks should be at ambient temperature
a minimum of 8 hours before use.

Cooling of CO2 pump Circulating coolant

System flow rate 3 to 200 g/min

CO2 pump flow rate 3 to 200 g/min ±2 g/min

Optional co-solvent pump flow
rate

1 to 50 mL/min ±1 mL/min

Temperature control Ambient +5 °C to 60 °C ±1.5 °C

High-pressure extraction One or two, 5-L or 10-L extraction vessels

High-pressure fraction collection Three, 2-L cyclone separators

Process control Automated operation via computer

Software ChromScope software

It is possible to operate individual components outside the range of system defined parameters.
The system is designed and tested only for the ranges defined in the "System Specifications"
table.
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B.1.1 Optional mass flow meter specifications

Item Specification

Maximum pressure 10,000 kPa (100 bar, 1,450 psi)

Note: The mass flow meter on the inlet of the CO2 pump is set at the factory to provide precise
flow control.

B.1.2 High-pressure extraction vessel specifications

Item Specification

Nominal capacity 5 L or 10 L

Maximum operating pressure 60,000 kPa (600 bar, 8,702 psi)

Maximum operating temperature 150 °C

Body material SST, 17-4 PH H-1150

Cap material SST, 17-4 PH H-1150

Seal material Polyimide

Outside diameter, without fittings 15.24 cm

Inside diameter 10.16 cm

Cap port 1/4 NPT (2)

B.1.3 High-pressure cyclone separator specifications

Item Specification

Nominal capacity 2 L

Maximum operating pressure 37,200 kPa (372 bar, 5,395 psi)

Maximum operating temperature 150 °C

Body material SST, 17-4 PH H-1150

Cap material SST, 17-4 PH H-1150

Seal material Polyimide

Diameter, without fittings 11.4 cm

Length, without fittings 32.8 cm
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B.1.4 Optional CO₂ recycler system specifications

Item Specification

Storage capacity 15 L

Operating temperature 5 to 15 °C

Operating pressure 6,000 to 6,500 kPa (60 to 65 bar, 870 to 943 psi)

Bleed valve 1

Level sensor Low, low-low, high, high-high

B.1.5 Heat exchanger specifications

Item Specification

Process connection Tubing: 1/8-inch SST, high-pressure

Maximum temperature 100 °C

B.1.6 Six-zone temperature controller module specification

Item Specification

Inputs and outputs 6

Operating temperature 5 to 40 °C

Temperature sensor input J-type thermocouple

Control output 24 Vdc, non-inductive (50 mA max load per channel)

B.1.7 Automated back-pressure regulator (ABPR 200) specifications

Item Specification

Flow rate up to 200 g/min

Fluid temperature up to 80 °C

Maximum pressure 32,000 kPa (320 bar, 4641 psi)
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B.2 System and component dimensions and weights

Table B–2: System and component dimensions

System component Width Depth Height

System cart with extraction
vessel and CO 2 recycler
carts and chiller

208.2 cm 162.6 cm 127.0 cm for system
with 5-L vessel cart
172.7 cm for system
with 10-L vessel cart

Cooling heat exchanger 6.4 cm 25.4 cm 6.4 cm

P-200 high-pressure CO 2
pump

35.6 cm 61.0 cm 31.2 cm

Optional P-50 high-
pressure co-solvent pump

27.9 cm 66.0 cm 43.2 cm

Relay 17.8cm 17.8 cm 11.4 cm

Automated back-pressure
regulator (ABPR)

17.8 cm 43.2 cm 15.9 cm

Manual back-pressure
regulator (MBPR)

7.6 cm 7.6 cm 10.4 cm

Heat exchanger 11.2 cm 46.4 cm 10.7 cm

Six-zone temperature
controller module

21.1 cm 27.6 cm 20.3 cm

Mass flow meter 15.2 cm 20.3 cm 14.0 cm

System chiller 23.1 cm 48.8 cm 60.0 cm

PC workstation
(computer/monitor)

23.0 cm/45 cm 45 cm/25 cm 45 cm/42 cm

Requirement: Specifications for the PC workstation are
representative and can change depending on the model. In all
cases, the PC workstation must be located adjacent to the system.

Table B–3: System and component weights

System component Weight

Base system minimum configuration 100.0 kg

Base system with P-50 high-pressure co-solvent pump and mass flow meter 122.0 kg

5-L extraction vessel cart (containing two vessels) 91.0 kg

10-L extraction vessel cart (containing two vessels) 190.0 kg

Recycler system 102.0 kg

System chiller 30.0 kg
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Table B–3: System and component weights (continued)

System component Weight

Recycler chiller 66.0 kg

PC workstation (computer/monitor) 14 kg (5 kg)

B.2.1 Additional space requirements
Use these guidelines in concert with the information from the "System and component
dimensions and weights" section for planning your system's laboratory space requirements:

• Maintain a minimum clearance of 30.5 cm at the front and rear of the system, for adequate
ventilation and access to system cables.

• Other than the exhaust tubing, keep the area above the system clear of overhanging
obstructions, to allow access to the top of the system.

• If installing the system inside a fume hood, contact your local Waters service representative
for additional requirements.

• Locate the chillers on the floor as close to the system as possible while maintaining a
minimum clearance of 30.5 cm at the front and rear of the chiller, for adequate ventilation.

• Locate the data system (computer CPU, monitor, keyboard, and mouse) on a laboratory
bench next to the system and within reach of the data system's cables.

• Locate the optional recycle cart next to extraction-vessel cart.

B.3 System and component power requirements

System component Input voltage/frequency Rated power
draw

Fuse rating

ABPR 100-240 Vac, 50/60 Hz 220 VA 3A-250 V

Six-zone temperature controller
module

100-240 Vac, 50/60 Hz 22 VA 1A-250 V

Heat exchanger 100-240 Vac, 50/60 Hz 1000 VA 10A-250 V

P-200 high-pressure CO2 pump 100-240 Vac, 50/60 Hz 880 VA 10A-250 V

Optional P-50 high-pressure
co-solvent pump

110/220 Vac, 50/60 Hz 352 VA 10A-250 V

Relay module-12A 200-240 Vac, 50/60 Hz 12A-2640 VA (2x) 12A-250 V

Relay module-20A 200-240 Vac, 50/60 Hz 20A-2640 VA (4x) 12A-250 V
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System component Input voltage/frequency Rated power
draw

Fuse rating

Optional mass flow meter 115/230 Vac, 50/60 Hz 20 VA 0.4A-250V

2-L cyclone separator vessel
heater

200-240 Vac, 50/60 Hz 1000W N/A

5-L or 10-L extraction vessel
heater

200-240 Vac, 50/60 Hz 2000W N/A

Optional recycler 100-240 Vac, 50/60 Hz 18W N/A

B.4 Electrical specifications

Attribute Specification

Protection classa Class I, (Grounded ac)

Overvoltage categoryb II

Pollution degreec 2

Moisture protectiond Normal (IPXO)

Line voltages, nominal 200 - 240 Vac

Frequency 50 - 60 Hz

Maximum power draw 11.5 kVA (split between two circuits)

a. Protection Class I – The insulating scheme used in the instrument to protect from electrical
shock. Class I identifies a single level of insulation between live parts (wires) and exposed
conductive parts (metal panels), in which the exposed conductive parts are connected to a
grounding system. In turn, this grounding system is connected to the third pin (ground pin) on the
electrical power cord plug.

b. Overvoltage Category II – Pertains to instruments that receive their electrical power from a
local level such as an electrical wall outlet.

c. Pollution Degree 2 – A measure of pollution on electrical circuits that can produce a reduction
of dielectric strength or surface resistivity. Degree 2 refers only to normally nonconductive
pollution. Occasionally, however, expect a temporary conductivity caused by condensation.

d. Moisture Protection – Normal (IPX0) – IPX0 means that no Ingress Protection against any type
of dripping or sprayed water exists. The “X” is a placeholder that identifies protection against dust,
if applicable.
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B.5 Environmental specifications

Attribute Specification

Operating temperature 15 °C to 40 °C

Operating humidity 20% to 80%, noncondensing

Non-operating temperature -30 °C to 60 °C

Non-operating humidity 10% to 85%, noncondensing

Transportation and storage temperature -30 °C to 60 °C

Transportation and storage humidity 20% to 85%, noncondensing

B.6 Wetted materials of construction

Item Specification

Wetted
materials

316, 17-4, and 304 stainless steel, gold, GFPM, polyimide, Nitronic 60, fused
silica, fluoropolymer, fluoropolymer blend, fluoroelastomer, PPS, natural PPS,
platinum, PEEK, sapphire, ruby, UHMWPE, and silicone elastomer (for cooling
bath tubing)
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C Best practices

C.1 Supplies
Waters recommends using the following lab and safety supplies with the Bio-botanical Extraction
System. For information about ordering supplies, visit the Waters website (www.waters.com), or
consult your Waters sales representative.

C.1.1 Lab supplies
Waters recommends the following lab supplies for the Bio-Botanical Extraction System:

System

• Computer table with room for notebooks and manuals

• Computer protectors or dust covers

• Uninterrupted power supply (1 KVa recommended), for computer, monitor, and CO2 level
indicator

• Plexiglas or some other type of floor protection (2 by 2-ft), to be placed on the floor under the
collection containers (beakers)

• Tubing for venting CO2 waste gas, to be connected to a 6.0-cm (1/4-inch) compression fitting

• 6 portable temperature monitors to verify +/- 5 °C room temperature (placed in different areas
to determine where the air flow is needed after the instrument is installed)

Scales

• Balance or balances (0.1 g to 2 kg, upper limit), for weighing trim and extracts

• Tank scale for weighing CO2 tank
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Gases and liquids

• Minimum of six 23-kg (50-lb) CO2 cylinders with dip tube (siphon) for liquid delivery (food
grade)

Notice: To avoid damaging the chiller, do not use automotive antifreeze as the
cooling agent.

• 8-L supply of 50:50 ethylene glycol/water mix or propylene glycol/water mix (see
www.dynalene.com)

Extraction preparation

• Suitable container for sample material

Tip: Oven bags work well.

• Stainless steel funnel with a 2 to 4-inch exit diameter, for adding trim to the extraction vessel.
The extraction vessel interior diameter is approximately four inches. For more information,
see Additional funnel information.

• Grinder with the ability to grind the plant material to a sand or coffee-ground consistency. For
more information, see Additional grinder information.

• Wooden dowel or plastic rod, 2-inch by 3-ft, for packing trim in the extraction vessel.

Tip: Wooden dowels used for closet clothes hangers work well.

• Step stool (for use when packing 10 L vessel)

Sample collection

Warning: To avoid injuries caused by shattering glass fragments, do not use
laboratory glassware to collect fractions or waste components. When opening drain
valves, a high-pressure release of solvent or extracted compounds can knock a glass
container out of your hand and cause it to shatter.

• At least 24 1-L storage containers for extracted product. Stainless steel is recommended
(stainless steel 1.5 qt Bain-marie vessels from a restaurant supply store work well)

Recommendation: Use stainless steel containers, which do not shatter if dropped or
subjected to extreme temperatures. 1.5 quart Bain-marie vessels form a restaurant supply
store are suitable.

• Heat gun (low wattage), used for thinning extract when pulling from the sample vessels and
for melting clogs in the system tubing

Cleaning

• 10 L of 95% food-grade ethanol

Note: Store the ethanol appropriately and follow all state laws.

• 4 squirt bottles (for cleanup solvent and checking for CO2 leaks)
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• Cotton swabs of varying lengths

• Paper towels or shop rags

• Paint brush, 2 to 3-inches wide, for cleaning trim from the threads in the extraction vessel

• Wet/dry vacuum with a 3-inch hose diameter (not necessary if you use vessel baskets)

C.1.1.1 Additional funnel information

A funnel with a 3.8-L capacity, 8-inch or larger mouth, and 4-inch neck opening is available for
purchase online. With this type of funnel, you can pack the extraction vessel without removing the
funnel.

Figure C–1: Funnel example

8-inch or larger mouth

4-inch neck opening

Local hardware stores sell galvanized steel HVAC duct diameter reducers that you can use as
funnels. A 6-inch to 4-inch reducer works well as a funnel, but ensure that you cover the sharp
edges with tape before use.

C.1.1.2 Additional grinder information

Common food blenders are inexpensive, but tend to unevenly grind the botanical material and
generate excessive heat that can degrade the product. You must open the cover and push the
intact material to the bottom of the blender jar several times during the run to ensure that the
material is evenly ground.

For large amounts of botanical material, a large commercial grade grinder works best. These
grinders are more expensive (about $1,000 to $1,500) than common food blenders, but are
manufactured for continuous use in a commercial kitchen and are more durable than common
food blenders. Their larger bowls (3 to 6 L), enable them to process more botanical material with
each run. The design of the grinder bowl ensures that all of the material can be ground without
opening the cover.
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C.1.2 Safety equipment and supplies
Waters recommends the following safety equipment and supplies for the Bio-Botanical Extraction
System:

• Disposable lab coats

• Disposable, lint-free gloves

• Protective eyewear

• Tank safety rack and tank cart, for restraining CO2 tanks

• CO2 monitor, 0 to 5000 ppm (see www.co2meter.com)

• Install the monitor 18 inches above the floor, away from the collection vessels

• CO2 must be vented externally

• Positive pressure air exchange system, to exchange the air in the room

Requirement: The ventilation system must provide an air exchange rate of four rooms per
hour.

Note: Check local regulations for installation guidelines.

C.1.3 Tools
Waters recommends the following tools for the Bio-Botanical Extraction System:

• 7/16-inch open-end wrench, for extraction vessel fittings

• 3/8-inch open-end wrench, for pump fittings

• 1/2-inch open-end wrench, for black CO2 fittings on pump, vessel, and vessel selection valves

• 9/16-inch open-end wrench, for collection vessel fittings

• Large, adjustable wrench, 1-1/4-inch minimum, for CO2 cylinder

• 3/16-inch hex wrench, for pump seal replacement

• Slip-joint pliers, 4-inch minimum opening, for servicing extraction vessel frits and replacing
extraction vessel seals

C.2 Preparing botanical material
Observe these guidelines when preparing botanical material for an extraction:

• Dry the botanical material to a moisture content of 5% to 8% wt/wt. Botanical material that is
too wet (greater than 8%) adversely impacts extraction efficiency.

• Choose a suitable grinder. For more information, see Additional grinder information.
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• Grind the botanical material to at least to a coffee ground consistency, and preferably to a
sand consistency. Grinding the material to a sand consistency increases extraction efficiency.

• Grind the material in a separate room from where the Bio-botanical Extraction System is
located. Ground botanical material can stick to the electronics and cause overheating.

C.3 Loading the sample
When loading botanical material into the extraction vessel, observe these guidelines:

Warning: To avoid injury from flying debris, ensure that the extraction vessel is
completely depressurized before loading botanical material. Failure to do so can
cause the cap to forcefully pop off the extraction vessel.

• Turn on the extraction vessel heater and specify the temperature so that it can reach the set
point while loading the sample.

• The extraction vessel holds a weight of botanical material (in pounds) that is approximately
half the volume of the vessel (in liters). For example, a 5-L vessel holds at least 2.5 lbs (1.13
kg) of botanical material; a 10-L vessel holds at least 5 lbs (2.25 kg) of botanical material.

• When botanical material is finely ground (fine sand), a 5-L vessel holds from 3.5 to 5 lbs. (1.5
to - 2.25 kg)

• If there is not enough botanical material present, use clear, inert glass or stainless steel beads
in a filter bag to account for the difference. For example, 3 lbs is 75% of 4 lbs, so you should
use a filter bag that has a height that is 25% of the vessel. For more information, see
www.filterbag.com.

• Place the beads against the inlet of the extraction vessel so the extract oil does not adhere to
them. Ensure that the glass beads are in front of the botanical material, so the direction of the
flow contacts the inert glass or metal before the botanical material.

• The inlet of the vessel is normally located at the bottom.

• Weigh a large plastic bucket, add the bio-botanical material, and then re-weigh the bucket to
determine the weight of the empty bucket and the weight of the bucket and ground bio-
botanical material.

• Use the large-mouth funnel to add the bio-botanical material to the 5 or 10-L extraction
vessel.

• A dust cloud may form around the extraction vessel while you add the finely ground material
to it. Wear a face mask to avoid breathing in particles from the air surrounding you.

• Re-weigh the plastic bucket and any bio-botanical material that remains in it. The difference
between this weight and the initial bucket weight is the amount of bio-botanical material that
you added to the extraction vessel.

• Use the packing tool or dowel (a wooden baseball bat with the end cut off) to pack the
material down into the extraction vessel. A well-packed vessel is important to extraction
efficiency. If the botanical material plug is not well-packed, CO2 creates channels in the
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material, travels through the path of least resistance (the channel), and fails to interact with
the material. Do not completely fill the extraction vessel before packing. Add a small amount
(approximately 3 inches of material at a time), and then pack it down with the dowel or
packing tool.

• When packing directly into the extraction vessel, fill the sample to the vessel seal line scored
in the stainless steel, which allows enough room for the filter cap to fit.

Figure C–2: Fill line on extraction vessel

1

Vessel's fill line

• Use the paint brush to clean off the material from the threads on the vessel.

• Spray the threads on the cap with Teflon lubricant prior to closing, being careful not to over-
spray on the U-cup seals.

Figure C–3: Spraying extraction vessel cap threads with Teflon lubricant

Teflon lubricant

Threads on extraction vessel cap

• Ensure that the U-cup seal is placed on the cap prior to closing and that the spring faces the
pressure gauge (visible to you).
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C.3.1 Vessel basket
For 5 L extraction vessels, you can use a vessel basket to load botanical material into the vessel,
which makes cleaning the vessel easier. When using a vessel basket, observe these guidelines:

• The vessel basket reduces the loading capacity by 8%, so it is best for indoor grow customers
who process lower volumes.

• When using the vessel basket to load botanical material, you must remove the bottom filter frit
of the main extraction vessel, so that you cannot alternate between using the basket and
using the vessel.

Note: The extraction vessel uses a standard 5-µm frit. An optional, 100-µm frit is also
available.

C.4 CO₂ recycler
The CO2 recycler receives the spent CO2 from the last collection vessel, chills it, and sends it to
the inlet of the Bio-botanical Extraction System. When using the recycler, observe these
guidelines:

• The extraction system requires liquid CO2. Use only dip (siphon) tube CO2 supply cylinders.

Note: Do not use CO2 gas in the extraction system. Doing so will cause the pump to shut
down.

• You can easily identify dip tube cylinders by the red ring around the neck of the tank.

• Prior to use, store the dip tube cylinders in the laboratory at room temperature for 24
hours.

• The CO2 recycler tank has a floating ball inside of it to measure the liquid CO2 level. Older
display panels indicate the level as low-low, low, high, or high-high. Newer display panels
indicate the level as low, medium, or high. The recommended level of the recycler is low, to
allow the liquid CO2 enough space to expand.

• Before the first run on a newly installed system, you must fill the chiller and system with
CO2, which will most likely consume an entire CO2 cylinder. Additional CO2 cylinders are
required only to top off the system, and will last much longer. Once the system is full, a
cylinder typically lasts for five extractions.

• The pressure in the recycler must be 4895 to 5102 kPa (49 to 51 bar, 710 to 740 psi).
Pressures below 4826 kPa (48 bar, 700 psi) cause CO2 liquid to flash to a gas in the pump
head. Pressures above 5102 kPa (51 bar, 740 psi) can cause carryover of extracted matter
from cyclone separator 3 (CS3) to the recycler tank.

• The pressure is controlled by the amount and temperature of CO2 in the recycler. The valve
between the dip tube cylinder and the recycler controls the flow of CO2 into the recycler, and
the temperature of the recycler's chiller can be used to control the pressure of the recycler.
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Adjust temperatures 0.5 degree every 15 minutes with the recycler flow rate. As the
temperature decreases, the recycler pressure also decreases.

Recommendation: Use portable thermometers to monitor the room temperature.

• The recycler chiller temperature can range from 5 to 15 °C, which determines the recycler
tank pressure. Assuming the room temperature is 66 to 74 °F, start at 11 °C, and adjust the
chiller temperature as necessary.

C.4.1 CO₂ care and use
Observe these guidelines when preparing and storing CO2:

• Initially run the system without recycling (two cylinders), if permitted by local law.

• Store tanks overnight in a temperature-controlled environment (18 to 24 °C), preferably in the
extraction room itself, prior to the service engineer's arrival.

• Secure tanks to the bench or wall.

• If necessary, wrap a gas cylinder heater (purchased at a local gas supply dealer) around the
tank to generate tank pressure.

Requirements: 

• CO2 tanks must have dip tubes (liquid CO2).

• CO2 tanks must be equilibrated at room temperature for approximately three hours.

Tips: 

• Warm CO2 tanks stored outside in cool weather using a heating blanket to raise the pressure
to higher than 5861 kPa (59 bar, 850 psi).

• CO2 tanks stored in sunlight will have higher pressure and may not be able to deliver any
liquid CO2 to the CO2 recycler.

C.5 Operating the system
Tip: New users should run the system overnight for the first few runs, which results in maximum
recovery and a low chance of clogging the system. After the first few runs, run the system for four
to six hours per day and compare the recovery against the overnight run to determine the
optimum run time. A Waters Technical Service representative must be present for at least two full
runs.

Important: Ensure that the manual outlet valve for extraction vessel 1 (MV1–V1), manual inlet
valve for extraction vessel 1 (MV2–V1), and P-200 high-pressure pump outlet valve are open
before powering-on the pump.
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To operate the system:

1. Power-on the six-zone temperature controller modules [CN6(1) and CN6(2)], CO2 pump,
co-solvent pump, automated back-pressure regulator (ABPR), automation unit, and
extracting solvent heat exchanger (HE2).

2. Ensure that the chillers are at these set points:

• CO2 chiller = 3.0 °C

• Recycler chiller = 11.0 °C, or whatever temperature is required to achieve 4999 kPa
(50 bar, 725 psi)

3. After the system components are powered on for at least 30 seconds, launch the
ChromScope software.

4. Click Tools > Clear alarms.

5. Power-on the extraction vessel heater, if necessary.

6. Specify the appropriate flow rate, and then start the CO2 pump.

Note: Initially, the flow rate typically exceeds the limit for triggering the "free flow error",
which causes the CO2 pump to power-off. To resolve this, power-on the pump.

7. Set the extraction vessel temperature to 50 °C.

8. Set the main heat exchanger temperature to 60 °C (10 °C higher than the extraction
vessel).

9. Set the ABPR setting to 22,477 kPa (225 bar, 3260 psi), at a temperature of 45 °C.

C.5.1 Recommended extraction parameters
The following tables list the recommended extraction parameters for plant material.

50 g/min: Overnight run of 14 hours (ChromScope v1.6)

Total duration: 840 min

Parameter Step 1: Overnight run

Co-solvent flow (ml/min) 0

CO2 flow (g/min) 50

Extraction vessel Extraction vessel 1

Extraction vessel 1 temperature (°C) 50

Extraction vessel 2 temperature (°C) 0

Cyclone vessel 1 temperature (°C) 45

Cyclone vessel 2 temperature (°C) 35
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Parameter Step 1: Overnight run

Cyclone vessel 3 temperature (°C) 22

In-line heater temperature (°C) 60

In-line collection heater temperature (°C), if installed 30

Extraction pressure (bar) 225

Dynamic duration 1 (min) 0.00

Static duration (min) 0.00

Dynamic duration 2 (min) 840.00

Cycles to execute 1

100 g/min: Method for botanical material (ChromScope v1.6)

Total duration: 420 min

Parameter Step 1: Collect
terpenes

Step 2: Collect
product

Co-solvent flow (ml/min) 0 0

CO2 flow (g/min) 75 100

Extraction vessel Extraction vessel 1 Extraction vessel 1

Extraction vessel 1 temperature (°C) 50 50

Extraction vessel 2 temperature (°C) 0 0

Cyclone vessel 1 temperature (°C) 45 45

Cyclone vessel 2 temperature (°C) 35 35

Cyclone vessel 3 temperature (°C) 22 22

In-line heater temperature (°C) 60 60

In-line collection heater temperature (°C), if
installed

30 30

Extraction pressure (bar) 150 225

Dynamic duration 1 (min) 0.00 0.00

Static duration (min) 0.00 0.00

Dynamic duration 2 (min) 60.00 360.00

Cycles to execute 1 1

150 g/min: Method for botanical material (ChromScope v1.6)

Total duration: 360 min
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Parameter Step 1: Collect
terpenes

Step 2: Collect
product

Co-solvent flow (ml/min) 0 0

CO2 flow (g/min) 75 150

Extraction vessel Extraction vessel 1 Extraction vessel 1

Extraction vessel 1 temperature (°C) 50 50

Extraction vessel 2 temperature (°C) 0 0

Cyclone vessel 1 temperature (°C) 45 45

Cyclone vessel 2 temperature (°C) 35 35

Cyclone vessel 3 temperature (°C) 22 22

In-line heater temperature (°C) 60 60

In-line collection heater temperature (°C), if
installed

30 30

Extraction pressure (bar) 150 225

Dynamic duration 1 (min) 0.00 0.00

Static duration (min) 0.00 0.00

Dynamic duration 2 (min) 60.00 300.00

Cycles to execute 1 1

100 g/min: Method for trim (ChromScope v1.5)

Total duration: 300 min

Parameter Step 1: Collect terpenes Step 2: Collect product

Co-solvent flow (ml/min) 0 0

CO2 flow (g/min) 75 100

Extraction vessel Extraction vessel 1 Extraction vessel 1

Extraction vessel 1 temperature (°C) 50 50

Extraction vessel 2 temperature (°C) 0 0

Cyclone vessel 1 temperature (°C) 45 45

Cyclone vessel 2 temperature (°C) 35 35

Cyclone vessel 3 temperature (°C) 22 22

In-line heater temperature (°C) 60 60

Extraction pressure (bar) 150 225

Dynamic duration 1 (min) 0.00 0.00
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Parameter Step 1: Collect terpenes Step 2: Collect product

Static duration (min) 0.00 0.00

Dynamic duration 2 (min) 60.00 240.00

Cycles to execute 1 1

150 g/min: Method for trim (ChromScope v1.5)

Total duration: 240 min

Parameter Step 1: Collect terpenes Step 2: Collect product

Co-solvent flow (ml/min) 0 0

CO2 flow (g/min) 75 150

Extraction vessel Extraction vessel 1 Extraction vessel 1

Extraction vessel 1 temperature (°C) 50 50

Extraction vessel 2 temperature (°C) 0 0

Cyclone vessel 1 temperature (°C) 45 45

Cyclone vessel 2 temperature (°C) 35 35

Cyclone vessel 3 temperature (°C) 22 22

In-line heater temperature (°C) 60 60

Extraction pressure (bar) 150 225

Dynamic duration 1 (min) 0.00 0.00

Static duration (min) 0.00 0.00

Dynamic duration 2 (min) 60.00 180.00

Cycles to execute 1 1

C.5.2 Cyclone separator temperatures and settings
The system runs dynamically for the allotted time at the temperatures listed in the following table.
Dynamic extractions are recommended to prevent material from accumulating in the tubing and
potentially falling out of solution.

Table C–1: Six-zone temperature controller module temperatures

Zone Temperature

1 Extraction vessel 1 heater: 50 °C, when in use

2 Extraction vessel 1 internal temperature (read only): 47 to 50 °C
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Table C–1: Six-zone temperature controller module temperatures (continued)

Zone Temperature

3 Extraction vessel 2 heater: 50 °C, when in use

4 Extraction vessel 2 internal temperature (read only): 47 to 50 °C

5 Main heat exchanger: 60 °C, 10 °C higher than extraction vessels 1 and 2 (V1/V2)

The following table lists the recommended settings for the cyclone separators.

Table C–2: Recommended cyclone separator settings

Cyclone
separator

Material Pressure during extraction Temperature
during extraction

CS1 Waxes, lipids, oil
acids

13,790 kPa (138 bar, 2000 psi) 45 °C

CS2 Oil neutrals • 6895 kPa (69 bar, 1000 psi),
without the in-line collection
heater. This setting reduces the
pressure drop, which helps
prevent carryover.

• 8274 kPa (83 bar, 1200 psi), with
the in-line collection heater
installed

35 °C

CS3 Terpenes, water,
95% food-grade
ethanol (if used),
and small
amounts of oils

4999 to 5171 kPa (50 to 52 bar, 725
to 750 psi)

25 °C (To help
prevent carryover,
increase to 35 °C)

Important: The CO2 recycler must be at 4826 to 4999 kPa (48 to 50 bar, 700 to 725 psi) to
ensure that the cyclone separator 3 (CS3) pressure during extraction is no more than 172 kPa
(1.5 bar, 25 psi) higher.

Notes: 

• To prevent a buildup of waxes, which can be caused by carryover from the other cyclone
separators, increase the temperature during extraction. Always drain terpenes before
increasing the temperature.

• Do not set CS3 above the recommended temperature and pressure, which can increase the
CO2 solvating power and carry oils, waxes, terpenes, and water into the recycler.

• The ratio of oils in CS1:CS2:CS3 is 1:4:1, so most oils are in CS2.

• Cyclone separators are increased in temperature 10 minutes before the pull to thin the
extract.
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C.5.3 Filling the CO₂ recycler
Observe these guidelines when filling the CO2 recycler:

• Ensure that the dip tube cylinder is open fully, and that the recycler inlet valve is closed.

• Ensure that the drain valve on the bottom of the recycler is closed.

• Ensure that the system (isolation valve) supply is open.

• If you are using manual filling, slightly open the valve to fill the recycler. The filling process
takes approximately 20 minutes to complete. Opening the valve too quickly causes dry ice to
form at the bottom of the recycler. You must allow any dry ice build-up to melt overnight, or
use a heat gun to melt it.

• You can monitor the fill rate by monitoring the recycler chiller temperature. If the chiller
temperature decreases by more than 2 °C, the recycler is filling too quickly. When the low
light illuminates, keep the valve open for 1 minute, and then close the valve. Repeat this
process when you power-on the pump.

• If the green low light does not illuminate after 2 minutes, replace the CO2 supply.

• If you are using automated refilling (solenoid control), ensure that the manual valve is only
slightly open for the initial fill. When the initial fill is complete, open the valve completely.

• With automated refilling, the green low light should illuminate no longer than 2 minutes
after it turns off. If the light takes longer than 2 minutes to illuminate, replace the CO2

supply.

• When running the extraction system, ensure that the recirculation valve on top of the recycler
is closed (horizontal).

• When the system is not in use, leave the chiller powered-on and the recirculation valve open
(vertical), to chill (equilibrate) the CO2 in the recycler.

Important: The pressure in the recycler must be between 4895 to 5102 kPa (49 to 51 bar, 710
to 740 psi). Before you connect the recycler, set the cyclone separator 3 (CS3) pressure to 2068
kPa (21 bar, 300 psi). After you connect the recycler, it maintains the CS3 pressure to 172 kPa (2
bar, 25 psi) higher than its (recycler) pressure through the inline check valve.

C.6 Preparing for sample collection

To prepare for sample collection:

1. After the extraction completes, reduce the pump flow to 25 to 40 g/min.

2. Drain the contents from cyclone separator 3 (CS3), most of which will be terpenes and
water.
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3. Increase the temperature of all three collection vessels to 55 °C.

4. Begin reducing the ABPR pressure from 22,477 kPa (225 bar, 3260 psi) to 13,996 kPa
(140 bar, 2030 psi).

• For a 5-L extraction vessel, reduce the pressure in 1999 kPa/min (20 bar/min, 290 psi/
min) increments.

• For a 10-L extraction vessel, reduce the pressure in 1000 kPa/min (10 bar/min, 145 psi/
min) increments.

Note: You can specify the ABPR depressurization ramp in the method using
ChromScope.

Important: Incremental depressurization is critical in preventing carryover from one
collection vessel to another, and ultimately into the CO2 recycler.

Example of incremental depressurization used to prevent carryover:

Total duration: 184 min

Parameter Step 1 Step 2 Step 3 Step 4 Step 5

Co-solvent flow (ml/
min)

0 0 0 0 0

CO2 flow (g/min) 150 150 150 150 150

Extraction vessel Extraction
vessel 1

Extraction
vessel 1

Extraction
vessel 1

Extraction
vessel 1

Extraction
vessel 1

Extraction vessel 1
temperature (°C)

50 50 50 50 50

Extraction vessel 2
temperature (°C)

35 35 35 35 35

Cyclone separator 1
temperature (°C)

45 45 45 45 45

Cyclone separator 2
temperature (°C)

35 35 35 35 35

Cyclone separator 3
temperature (°C)

25 25 25 25 25

Inline heater
temperature (°C)

60 60 60 60 60

Inline collection
heater temperature
(°C), if installed

35 35 35 35 35

Extraction pressure
(bar)

225 205 185 165 145
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Parameter Step 1 Step 2 Step 3 Step 4 Step 5

Dynamic duration 1
(min)

0.00 0.00 0.00 0.00 0.00

Static duration (min) 0.00 0.00 0.00 0.00 0.00

Dynamic duration 2
(min)

180.00 1.00 1.00 1.00 1.00

Cycles to execute 1 1 1 1 1

C.7 Collecting the sample

To collect the sample:

1. Ensure that the collection rack is set to an appropriate height so that the collection tube is
in the top quarter of the storage container.

Notice: To avoid damage to the splash guard, including freezing and breakage,
ensure that it is installed properly. Splash guards are designed to fit over a 1-L
beaker.

2. Ensure that the splash guard is installed properly, so that it covers the opening on the
storage container.

3. Slowly open the drain valve on cyclone separator 3 (CS3) until the plant material flows out.

4. When the material is exhausted and CO2 is visible, close the drain valve.

5. Warm the cyclone separator 2 (CS2) and cyclone separator 1 (CS1) outlet lines, by moving
the heat gun slowly up and down the entire tube.

6. When the outlet lines are warm, slowly open the drain valves on CS2 and CS1 until the
plant material flows out.

7. When the material is exhausted and CO2 is visible, close the drain valves.

8. If the flow stops and CO2 is not visible, close the drain valves and use the heat gun to melt
any clogs in the line.

9. Re-open the drain valves, continue the collection, and then close the valve when CO2 is
visible.

C.8 Transferring from extraction vessel 1 to extraction
vessel 2
Transfers between extraction vessels conserves CO2, pressurizes the new vessel faster, and
depressurizes the old vessel faster.
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Note: This procedure applies to manual mode only.

To transfer from extraction vessel 1 to extraction vessel 2:

1. Set the flow to 0 and ensure that the CO2 and co-solvent pumps are powered off.

Note: If the CO2 and co-solvent pumps are on, the rupture discs will trigger and must then
be replaced.

2. Ensure that the manual outlet valve for extraction vessel 1 (MV1–V1) is open.

Figure C–4: Location of MV1 valve on module cart

Location of MV1 valve

Figure C–5: MV1–V1 outlet valve handle

MV1V
2 V1

MV1–V1 outlet valve handle

Notice: To avoid damaging the filter frit, do not open the manual outlet valve for
the extraction vessel too quickly.

3. Slowly open the manual outlet valve for extraction vessel 2 (MV1–V2) approximately one
full turn over 1 minute.
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Figure C–6: MV1–V2 outlet valve handle

MV1V
2 V1

MV1–V2 outlet valve handle

4. When the line that runs from MV1–V2 starts to feel cold, stop opening the manual outlet
valve.

5. Maintain the position of the manual outlet valve for approximately 10 minutes or until the
readings on both pressure gauges on the extraction vessels are equal.

6. Close MV1–V1 completely.

7. Close MV1–V2 completely.

8. Close the manual inlet valve for extraction vessel 2 (MV2–V2) completely.

Figure C–7: Location of MV2 valve on module cart

Location of MV2 valve

Figure C–8: MV2–V2 inlet valve handle

MV2V
2 V1
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MV2–V2 inlet valve handle

9. Close manual inlet valve for extraction vessel 1 (MV2–V1) completely.

Figure C–9: MV2–V1 inlet valve handle

MV2V
2 V1

MV2–V1 inlet valve handle

C.9 Transferring from extraction vessel 2 to extraction
vessel 1
Transfers between extraction vessels conserves CO2, pressurizes the new vessel faster, and
depressurizes the old vessel faster.

Note: This procedure applies to manual mode only.

To transfer from extraction vessel 2 to extraction vessel 1:

1. Set the flow to 0 and ensure that the CO2 and co-solvent pumps are off.

Note: If the pumps are on, the rupture discs will trigger and must then be replaced.

2. Ensure that the manual outlet valve for extraction vessel 2 (MV1–V2) is open.

Figure C–10: Location of MV1 valve on module cart

Location of MV1 valve
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Figure C–11: MV1–V2 outlet valve handle

MV1V
2 V1

MV1–V2 outlet valve handle

Notice: To avoid damaging the filter frit, do not open the manual outlet valve for
the extraction vessel too quickly.

3. Slowly open the manual outlet valve for extraction vessel 1 (MV1–V1) approximately one
full turn over 1 minute.

Figure C–12: MV1–V1 outlet valve handle

MV1V
2 V1

MV1–V1 outlet valve handle

4. When the line that runs from MV1–V1 starts to feel cold, stop opening the manual outlet
valve.

5. Maintain the position of the manual outlet valve for approximately 10 minutes or until the
readings on both pressure gauges on the extraction vessels are equal.

6. Close MV1–V2 completely.

7. Close MV1–V1 completely.

8. Close the manual inlet valve for extraction vessel 1 (MV2–V1) completely.
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Figure C–13: Location of MV2 valve on module cart

Location of MV2 valve

Figure C–14: MV2–V1 inlet valve handle

MV2V
2 V1

MV2–V1 inlet valve handle

9. Close the manual inlet valve for extraction vessel 2 (MV2–V2) completely.

Figure C–15: MV2–V2 inlet valve handle

MV2V
2 V1

MV2–V2 inlet valve handle

C.10 Maintaining the system
To maintain the system, observe these guidelines:
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• Clean the system on a regular basis. For specific cleaning procedures and intervals, see
Cleaning guidelines for all configurations.

• Replace the seals when a persistent leak (greater than five minutes) is observed around the
P-200 high-pressure pump head.

• Replace the check valves when the P-200 high-pressure pump efficiency drops significantly
(increased RPM/flow rate).

• Realign the needle in the automated back-pressure regulator (ABPR) valve if the ABPR fails
to reach target pressure and there are no system leaks (see the Rebuilding the ABPR valve
instructional video). A fully packed 5-L vessel at 150 g/min takes approximately ten minutes to
reach the target pressure of 29,992 kPa (300 bar, 4350 psi).

Note: After a second needle realignment, replace the needle and seat. The recommended
routine replacement of the needle and seat is 6 months to 1 year.
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